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Introduction

Read this book if you are new to COMSOL Multiphysics®. It provides an
overview of the COMSOL® environment with examples that show you how to use
the COMSOL Desktop® user interface and the Model Builder. It also provides a
quick introduction to creating applications using the Application Builder.

If you have not yet installed the software, install it now according to the
instructions at www.comsol.com/product-download.

In addition to this book, an extensive documentation set is available after
installation. Tutorials can be found throughout the COMSOL website, including
in the Video Gallery at www.comsol.com/videos and on the COMSOL Blog at
www.comsol.com/blogs.


www.comsol.com/video/
www.comsol.com/blogs
http://www.comsol.com/product-download

COMSOL Desktop®

QUICK ACCESS TOOLBAR — Use these

buttons for access to functionality such as file
open/save, undo/redo, copy/paste, and delete.

APPLICATION BUILDER —
Click this button to switch to
the Application Builder and
start building an application
based on your model.

MODEL BUILDER
TOOLBAR

MODEL TREE — The model
tree gives an overview of

the model and all of the
functionality and operations
needed for building and solving a
model as well as processing the
results.
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RIBBON — The ribbon tabs have buttons

and drop-down lists for controlling all
steps of the modeling process.

| & el A
M iomc  Defintions  Geometry Materisls  Physics  Mesh  Study Results  Dleveloper
. 2=Variobles + [ Import oD
A ® | mr e o m o B A
f() Functions » ' Livelink = =
Application  Component  Add Parameters Build Add  HeatTransfer Add Build Mesh
Builder Component ~ - Al Material | inSolids~ Physics  Mesh 1+
Application Model Definitions Geometry Materials Physics Mesh
Maodel Bu ~ 4| Settings ~ * Graphics
- M Geometry QQ A~ RER RN IRy L]
4 4 Untitled.mph (root) 2 Build Al
4 () Global Definitions
P| Parameters 1 Label: | Geometry 1 =
=) Materials
4 @ Component 1 (comp1) - lare
? = Definitions [[] Scale values when changing units
PRANGtometr)] Length unit
55 Materials
4 | @ Heat Transfer in Solids (ht) m M
= Solid 1 Angular unit:
nitial Values 1
Degrees -
% Thermal Insulation 1
£ Mesh 1 ~ Advanced
4 o Study 1
[7= Step 1: Stationary Geometry representation:
» B Resutts CAD kemel -
[] Design Module Boolean operations
Default repair tolerance:
Automatic -
Lild new operations automatically
Build automatically when leaving geometry
MODEL BUILDER — SETTINGS WINDOW —
The Model Builder window Click any node in the model
with its model tree and the tree to see its associated
associated toolbar buttons Settings window displayed next z
gives you an overview of the to the Model Builder. Y\Lv *
model. The modeling process
can be controlled from
context-sensitive menus Messages Progress Log Table 1

accessed by right-clicking a
node.
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GRAPHICS WINDOW TOOLBAR

Untitled.mph - COMSOL Multiphysics

v|o= R \ri = =
h

Compute Study Add Add Plot Windows Reset
T+ Study Group + ~ Desktop ~
Study Results Layout

=2 @~ B e a

- o
(& »

GRAPHICS WINDOW — The Graphics window presents
interactive graphics for the Geometry, Mesh, and Results nodes.
Operations include rotating, panning, zooming, and selecting.

INFORMATION WINDOWS — The Information windows will display vital
model information during the simulation, such as the solution time, solution
progress, mesh statistics, solver logs, and, when available, results tables.

1.79GE|2.31 GB



The screenshot on the previous pages is what you will see when you first start
modeling in COMSOL Multiphysics using the Model Builder. The COMSOL
Desktop® user interface provides a complete and integrated environment for
physics modeling and simulation as well as application design, providing you with
the tools necessary to build a user-friendly interface for your models. You can
customize the desktop to your own needs. The windows can be resized, moved,
docked, and detached. Any changes you make to the layout will be saved when
you close the session and available again the next time you open COMSOL
Multiphysics. As you build your model, additional windows and widgets will be
added. (See page 28 for an example of a more developed desktop.) Among the
available windows and user interface components are the following;:

Quick Access Toolbar

The Quick Access Toolbar gives access to functionality such as Open, Save, Undo,
Redo, Copy, Paste, and Delete. You can customize its content from the Customize
Quick Access Toolbar list (the downward-facing arrow to the right of the toolbar).

Ribbon

The ribbon at the top of the desktop gives access to commands used to complete
most modeling tasks. The ribbon is only available in the Windows® version of the
COMSOL Desktop environment and is replaced by menus and toolbars in the
macOS and Linux® versions. Click the Application Builder button to switch from
the Model Builder to the Application Builder and start building an application
based on your model.

Settings Window

This is the main window for entering all of the specifications of the model,
including the dimensions of the geometry, properties of the materials, boundary
conditions and initial conditions, and any other information that the solver will
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need to carry out the simulation. The picture below shows the Settings window for
the Geometry node.

Model Builder

3

4 & 56.mph (root)
4 () Global Definitions
Fi Parameters 1
Materials
4 |§ Component1 (comp1)
[ = Definitions
W Geometry 1
2 Materials
4 |[@ Heat Transfer in Solids (ht)
= Solid 1
B Initial Values 1
%= Thermal Insulation 1
A Mesh 1
4 ~db Study 1
[= step 1: Stationary

b {8 Results

Plot Windows

These are the windows for graphical output. In addition to the Graphics window,
Plot windows are used for visualizing results. Several Plot windows can be used to
show multiple results simultaneously. A special case is the Convergence Plot
window, an automatically generated Plot window that displays a graphical
indication of the convergence of the solution process while a model is running.

Information Windows

Settings

[

Geometry

[E Build All

Label: |Geometry 1

¥ Units

[] Scale values when changing units
Length unit:

m
Angular unit:

Degrees

¥ Advanced

Geometry representation:

CAD kernel
Design Module Boolean operations
Default repair tolerance:

Automatic

Automatic rebuild

These are the windows for nongraphical information. They include:

Messages: Various information about the current COMSOL Multiphysics
session is displayed in this window.

Progress: Progress information from the solver in addition to stop buttons.

Log: Information from the solver, such as the number of degrees of freedom,
solution time, and solver iteration data.

Table: Numerical data in table format as defined in the Results node.

External Process: Provides a control panel for cluster, cloud, and batch jobs.

| 9



Other Windows

The Windows drop-down list in the Home tab of the ribbon gives you access to all
COMSOL Desktop windows. On macOS and Linux®, you will find this in the
Windows menu. In addition to the windows described earlier you can access the
following windows:

 Add Physics and Add Multiphysics: Expand the physics interfaces in a model.
* Add Study: Change the type of study.

* Add Material from Library and the Material Browser: Access the material
property libraries.

* Application Libraries: Choose among the collections of MPH-files containing
tutorial models and runnable applications with accompanying documentation.

* Part Libraries: Load one of the predefined parameterized geometry models.

¢ Selection List: Show a list of geometry objects, domains, boundaries, edges,
and points that are currently available for selection.

* Properties: View model tree node properties.
* Debug Log: Display debug information for methods.
* Table: Display results in table format.

 External Process: Control COMSOL Multiphysics processes running
separately.

* Recovery Files: View recovery files.

* Comparison Result: Compare the Model Builder and Application Builder
settings of two MPH files.

Progress Bar with Cancel Button

The Progress Bar with a button for canceling the current computation, if any, is
located in the lower right-hand corner of the COMSOL Desktop interface.

Dynamic Help

The Help window provides context-dependent help texts about windows and
model tree nodes. If you have the Help window open in your desktop (by typing
F1, for example), you will get dynamic help (in English only) when you click a
node or a window. From the Help window, you can search for other topics, such
as menu items.

10|



The Model Builder and the Application Builder

The two main components of the COMSOL Desktop environment are the Model
Builder and the Application Builder.

The Model Builder is the tool where you define the model and its components,
such as how to solve it, the analysis of results, and creating reports. You do that by
building a model tree. The model tree reflects the underlying data structure, the
model object, which stores the state of the model including settings for geometry,
mesh, physics, boundary conditions, studies, solvers, postprocessing, and
visualizations.

The Application Builder allows you to quickly create an application with a
specialized user interface that is easy to use. An application is typically based on a
model created with the Model Builder. The Application Builder provides two
important tools for creating applications: The Form editor and the Method editor.
In addition, an application can have a menu bar or a ribbon. The Form editor
includes drag-and-drop capabilities to easily access and include user interface
components, such as input fields, graphics windows, and buttons. The Method
editor is a programming environment that, for example, allows you to modify the
model represented by the model object data structure. You can also use the
Method editor to add user interface logic and auxiliary functionality to an
application. The Java® programming language is used to write code in the Method
editor, which means that all Java® syntax and Java® libraries can be used.

In the Method editor, program code is stored in methods. A method is another
name for what is known in other programming languages as a subroutine,
function, or procedure. Methods can be used to modify the model object data
structure in the Model Builder and the Application Builder. A method can be used
both for modifying the model object of the current session and for modifying the
model object in a running application.

This book, Introduction to COMSOL Multiphysics, gives a detailed introduction
to using the Model Builder and a quick introduction to the Application Builder.
For detailed information on how to use the Application Builder, including the
Form editor and Method editor, see Introduction to Application Builder.

Applications, COMSOL Server™, and COMSOL
Compiler™

The Application Builder is included in the Windows® version of COMSOL
Multiphysics. With a COMSOL Multiphysics license, applications can be run from
the COMSOL Desktop environment. Although applications cannot be built with



the macOS or Linux® versions of the software, applications can still be run with
COMSOL Multiphysics on those platforms.

With a COMSOL Server™ license, applications can be run in major web browsers
on a variety of operating systems and hardware platforms. In addition, you can run
applications by connecting to COMSOL Server with an easy-to-install COMSOL
Client for Windows®.

The COMSOL Client for Windows® allows a user to run applications that require
a LiveLink™ product for CAD (this functionality is not available when running
applications with a web browser).

Running applications in a web browser does not require any installation and no
web browser plug-ins are needed. Running an application in a web browser
supports interactive graphics in 1D, 2D, and 3D. In a web browser, graphics
rendering in 3D are based on WebGL™ technology, which comes included with
all major web browsers. In addition, there is a COMSOL Client version for
Android® available in the Google Play™ store.

To create an application based on your model, click

. . . . File Home  Definitions  Geometry
the Application Builder button, accessible from the '
Home tab in the ribbon. A ] &

. . . Application | C Add
By using COMSOL Compiler™ you can compile uger TR Component -
your application (MPH-file) to an executable file Application Model

for Windows®, Linux®, and macOS. You can freely
distribute the executable and it can be run without
any license file.

For more information on creating COMSOL applications, refer to the section
“Building an Application with the Application Builder” on page 98 and the book
Introduction to Application Builder.
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Preferences

Preferences are settings that affect the modeling environment. Most are persistent
between modeling sessions, but some are saved with the model. You access the
preferences from the File menu by selecting Preferences.

3 Preferences X
Add-in Libraries Visualization

Application Builder Rendering: OpenGL -
Application Libraries optirmize-or: | Qualiy =
Client/Server

Color Themes Antializsing: | Medium -
Email Detail: Normal =
Files Show logo on canvas

Forms .

General Logo file: rowse...
Geometry Show mouse coordinates when drawing

Default 3D view

Graphics Interaction

Vertical axis: | z-axis v

Graphics Toelbars Axis paints upward

E::junk Conmestions Display format {maximum number of digits)
Methods Graph: 5

Model Builder 2D axes: 4

Multicore and Cluster Computing ;

Parametric Sweep

Part Libraries Color legend: 3

Physics Builder Image export

Quick Access Toalbar [[] Use software rendering for image export

Remote Computing Fonts

Results Load system fonts

Security Detact fort
Show More Options auttfon
Updates Family: | Vera -
Size: | Defaultsize ¥ | pt
Factory Settings
Factory Settings for Al | [ Import.. || Export.. oK Cancel

In the Preferences window, you can change settings such as graphics rendering, the
number of displayed digits for results, the maximum number of CPU cores used
for computations, or paths to user-defined application libraries. Take a moment to
browse your current settings to familiarize yourself with the different options.

GRAPHICS AND PLOT WINDOWS

In the Graphics and Plot Windows page, there are three graphics rendering options
available: 0penGL®, DirectX®, and Software Rendering. The DirectX® option is not
available in macOS or Linux®, but is available in Windows® if you choose to install
the DirectX® runtime libraries during installation. If your computer does not have
a dedicated graphics card, you may have to switch to Software Rendering for slower
but fully functional graphics. A list of reccommended graphics cards can be found
at:

www.comsol.com/system-requirements
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COLOR THEMES
In the Color Themes page, there are three color theme preferences:

» Desktop color theme: Choose between a Default, Light, or Dark theme for the
COMSOL Desktop environment.

* Graphics color theme: Choose a color theme for the Graphics window.
 Image export color theme: Choose a color theme for Exported images.

3 Preferences

Add-in Libraries Color themes

Application Builder Desktop color theme: | Default ~ |
Application Librari i

Fp reation Hbranes Graphics color theme: Light

Client/Server | Dark |
Tl Image export color theme: Default

Email

®

When using the Dark theme in Linux™, some controls take their color from the
operating system’s theme. You will get a better user experience by picking a
dark-looking theme in Linux® together with the Dark theme in the COMSOL
Desktop environment.

Creating a New Model

You can set up a model guided by the Model Wizard or start from a Blank Model as
shown in the figure below.

e hEE&

File Home  Definitions  Geometry
New

.mph
Model
Wizard

“mph
Blank Model

CREATING A MODEL GUIDED BY THE MODEL WIZARD

The Model Wizard will guide you in setting up the space dimension, physics, and
study type in a few steps:

14 |



| Start by selecting the space dimension for your model component: 3D, 2D
Axisymmetric, 2D, 1D Axisymmetric, or 0D.

e[ 2
Home  Definitions  Geometry  Materials  Physics  Mesh  Study  Results

Select Space Dimension

m ¢ 9 -

2D 1D
SD Axisymmetric 2E Axisymmetric e e

2 Now, add one or more physics interfaces. These are organized in a number of
physics branches in order to make them easy to locate. These branches do not
directly correspond to products. When products are added to your COMSOL

| 15



Multiphysics installation, one or more branches will be populated with
additional physics interfaces.

S e EBR
File Home  Definitions  Geometry  Materials  Physics  Mesh  Study  Results  Developer
Select Physics Review Physics Interface
Search Heat Transfer in Solids (ht)
»r % AC/DC

b Acoustics Dependent Variables

I s Chemical Species Transport
b ][ Electrochemistry
I == Fluid Flow
4 (|| Heat Transfer
Heat Transfer in Selids (ht)
Heat Transfer in Fluids (ht)
m Heat Transfer in Solids and Fluids (ht)
[ = Conjugate Heat Transfer
[ 1% Radiation
[ %! Electromagnetic Heating
£ Lumped Thermal System (its)
b |[] Thin Structures
b |8 Heat and Moisture Transport
B Heat Transfer in Porous Media (ht)
B Local Thermal Nonequilibrium
I g Metal Processing
| Bicheat Transfer (ht)
Heat Transfer in Pipes (htp)
Thermeelectric Effect

Temperature: | T

b i Optics
b @ Plasma
Add
Added physics interfaces:
Heat Transfer in Solids (ht)
Remove

e Space Dimension e Study
Help e Cancel EI/DDHE
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3 Select the Study type that represents the solver or set of solvers that will be used
for the computation.

File Home  Definitions  Geometry  Materials ~ Physics  Mesh

Select Study

4 ~db General Studies
E Stationary
[V Time Dependent

4 rcn Preset Studies for Selected Physics Interfaces
[ Thermal Perturbation, Eigenfrequency
[== Thermal Perturbation, Frequency Domain

[~ More Studies

~dt Empty Study

Added study:
[= Stationary

Added physics interfaces:
B Heat Transfer in Solids (ht)

e Physics
Help Q Cancel E’/Done

Finally, click Done. The desktop is now displayed with the model tree configured
according to the choices you made in the Model Wizard.

CREATING A BLANK MODEL

The Blank Model option will open the COMSOL Desktop interface without any
Component or Study. You can right-click the model tree to add a Component of a
certain space dimension, physics interface, or Study.

| 17



The Ribbon, Quick Access Toolbar, and Graphics Menus

The ribbon tabs in the COMSOL Desktop environment reflect the modeling
workflow and give an overview of the functionality available for each modeling
step, including building simulation applications from your models.

I -~ Defnitions  Gremetry  Matedals  Physics  Mesh  Study  Besults  Developer  Temperature (he)
—_ - o Variahles « IT= Impart . .
y . g o m A = R s
\ : i I - | i sy = =
A = - i Functions = =B e LiveLink - 1 B Tk - R, + li L
Application  Component  Add Parameters Build Add  HestTansfer Add  Buld Mesh  Compute Study Add  Tempersture AddPlot  Windows Reset
i Te  Component= - T Study (h) =

Builder Al Matenial m Sohds = Physis Mesh 1= Growp = - Desktop =
The Home tab contains buttons for the most common operations for making

changes to a model, running simulations, and for building and testing

applications. Examples include changing model parameters for a parameterized
geometry, reviewing material properties and physics, building the mesh, running

a study, and visualizing the simulation results.
There are standard tabs for each of the main steps in the modeling process. These

are ordered from left to right according to the workflow: Definitions, Geometry,
Materials, Physics, Mesh, Study, Results, and Developer.

Contextual tabs are shown only if and when they are needed, such as the 3D Plot
Group tab, which is shown when the corresponding plot group is added or when
the node is selected in the model tree.

BT Home  Oeinitions  Geomety  Matensh  Physics  Mesh Sty Resulls  Developer

-  Wvelure Wi Shice Line o Arow Line 7 Annctation | %] Evaluate Along Nowmal|  ~) Cut Line Directic
OB LI armou velume () isomurface G Contour = Particle Tajectaries 5] Image | - First Paint for Cut Line , Cut Line Surface
the I|‘.-‘.m ™ Surface ¥ Arrow Surface 35 Streamfine [E] Mesh p:‘i‘;': *Second Peint for Cut Line [ First Peint for Cy

Modal tabs are used for very specific operations, when other operations in the
ribbon may become temporarily irrelevant. An example is the Work Plane modal
tab. When working with work planes, other tabs are not shown, since they do not
present relevant operations.
m Heme Sketch  Developer
ws (T mpot D Circle  [0] Square Iy = —
& TRlnsert Sequence  © , @ Elipse  1Polygen = e

Build Sketch i More i X Parts Pragramming Colers Measure Clase
All L Rectangle - Point  Primitives « A Cross Section . . .

THE RIBBON VS. THE MODEL BUILDER

The ribbon gives quick access to available commands and complements the model
tree in the Model Builder window. Most of the functionality accessed from the
ribbon is also accessible from contextual menus by right-clicking nodes in the
model tree. Certain operations are only available from the ribbon, such as selecting
which desktop window to display. In the COMSOL Desktop interface for macOS
and Linux®, this functionality is available from toolbars, which replace the ribbon
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on these platforms. There are also operations that are only available from the
model tree, such as reordering and disabling nodes.

THE QuUICK ACCESS TOOLBAR

The Quick Access Toolbar contains a set of commands that are independent of the
ribbon tab that is currently displayed. You can customize the Quick Access Toolbar
and add most commands available in the File menu, including commands for
undoing and redoing recent actions, as well as for copying, pasting, duplicating,
and deleting nodes in the model tree. You can also choose to position the Quick
Access Toolbar above or below the ribbon.

THE GRAPHICS MENUS

As an alternative to using the model tree or the ribbon, you can right-click in the
Graphics window to access context-dependent menus. The menus shown will
depend on which node is currently selected in the model tree. By using the Go To
option, when available, you can jump to a context menu for another node in the
model tree.

Graphics

Q@ BH vyl ¢~ By &~

Defeaturing and Repair 3
= Loft
Booleans and Partitions 3
o Array Transforms 3
Copy Conversions 3
Mirror = Explicit Selection
Move E Delete
:, Rigid Transform ‘B Zoom to Selection
O Rotate mm Measure
£ Scale % Hide
Go To r

MACOS AND LINUX®

In the COMSOL Desktop environment for macOS and Linux®, the ribbon is
replaced by a set of menus and toolbars.

o Options Tosh Hep

119



The instructions in this book are based on the Windows® version of the COMSOL
Desktop environment. However, running COMSOL Multiphysics and the
COMSOL Desktop environment in macOS and Linux® is very similar, keeping in
mind that the ribbon user interface components can instead be found in the
corresponding menus and toolbars.

The Model Builder and the Model Tree

Using the Model Builder, you build a model by starting with the default model
tree, adding nodes, and editing the node settings.

All of the nodes in the default model tree are top-level parent nodes. You can
right-click on them to see a list of child nodes, or subnodes, that you can add
beneath them. This is the means by which nodes are added to the tree.

When you click on a child node, you will see its node settings in the Settings
window. It is here that you can edit node settings.

It is worth noting that if you have the Help window open, which is achieved either
by selecting Help from the File menu or by pressing the function key F1, then you
will also get dynamic help (in English only) when you click on a node.

THE ROOT, GLOBAL DEFINITIONS, AND RESULTS NODES

A model tree always has a root node (initially
labeled Untitled.mph), a Global Definitions node,
and a Results node. The label on the root node is
the name of the multiphysics model file, or MPH
file, to which the model is saved. The root node
has settings for author name, default unit system,
and more.

+— = =

4 < Untitled.mph (root)

(1) Global Definitions

@ Component 1 {comp1)
~do Study 1

[
I
b {8 Results

The Global Definitions node has a Parameters and

Materials subnode by default. The Global Definitions node is where you, among
other things, define parameters, variables, functions, and couplings that can be
used throughout the model tree. They can be used, for example, to define the
values and functional dependencies of material properties, forces, geometry, and
other relevant features. The Global Definitions node itself has no settings, but its
child nodes have plenty of them. The Materials subnode stores material properties
that can be referenced in the Component nodes of a model.

20 |



The Results node is where you access the solution after performing a simulation
and where you find tools for processing the data. The Results node initially has five
subnodes:

* Datasets, which contains a list of solutions
you can work with.

o
pullder TR

Mode

- s R ELE -

* Derived \(alues, which defines values to be 4 % Untitied.mph (roof)
derived from the solution using a number of b (3 Global Definitions
postprocessing tools. \ Companent 1 (comp )

[ ~do Study 1
* Tables, which is a convenient destination for 4 (Bl Results
. % Dataset
the Derived Values or for Results generated by o Tmes
. . . ea: Derived Values
probes that monitor the solution in B Tables
real-time while the simulation is running. & Export
55 Reports

e Export, which defines numerical data,
images, and animations to be exported to
files.

* Reports, which contains automatically generated or custom reports about the
model in HTML or Microsoft® Word format.

To these five default subnodes, you may also add more Plot Group subnodes that
define graphs to be displayed in the Graphics window or in Plot windows. Some of
these may be created automatically, depending on the type of simulations you are
performing, but you may include additional figures by right-clicking on the Results
node and choosing from the list of plot types. In addition, you can add an
Evaluation Group node, which is similar to the Derived Values node but with tightly
associated Evaluation Group tables, and a Parameters node, for parameters used
exclusively in Results.

THE COMPONENT AND STUDY NODES

In addition to the three nodes just described,
there are two additional top-level node types:
Component nodes and Study nodes. These are

.
Builder s

Model Builc
T

- = =t

4 @ Untitled.mph {root)

usually created by the Model Wizard when you b (@) Global Definitions

create a new model. After using the Model . E:':p:”e”” {comp)
. . . udy

Wizard to specify what type of physics you are b [ Results

modeling and what type of Study (for example,

steady-state, time-dependent,

frequency-domain, or eigenfrequency analysis) you will carry out, the Model
Wizard automatically creates one node of each type and shows you their contents.
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It is also possible to add
more Component and Study
nodes as you develop the

Mode

4 & Untitled.mph (root)

model. A model can 4 () Global Definitions
contain multiple Pi Parameters 1
2 Materials
Component.and Study gy e e
nodes and it would be b = Definitions % Add Physics
confusing if they all had b7 Geometry 1 % Add Multiphysics
h Th f == Materials )
the same name. crerore, 4 | @ Heat Transfer in Soli = Insert Physics from Model
these types of nodes can be B Solid 1 A Add Mesh
o B Initial Values 1
renamed to be descriptive = T e i Copy as Codeto Clipboard v
of their individual A Mesh 1 B Copy
purposes. 4 e Study ! i Delete — Del
. [= step 1: Stationary _
If a model has multiple b & Results =} Rename — R
Component nodes, they can Settings
be coupled to form a more Properties
sophisticated sequence of B Hep — F
simulation steps.

Keyboard Shortcuts —
Note that each Study node cyboard shorteuts

may carry out a different
type of computation, so each one has a separate Compute button =.

To be more specific, suppose that you build a model that simulates a coil assembly
that is made up of two parts, a coil and a coil housing. You can create two
Component nodes, one that models the coil and the other the coil housing. You
can then rename each of the nodes with the name of the object. Similarly, you can
also create two Study nodes, the first simulating the stationary or steady-state
behavior of the assembly, and the second simulating the frequency response. You
can rename these two nodes to be Stationary and Frequency Domain.

When the model is complete, save it to a file named Coil Assembly.mph. At that
point, the model tree in the Model Builder looks like the figure below.

In this figure, the root node is named Coil
Assembly.mph, indicating the file in which the -
model is saved. The Global Definitions node and _ ==
. 4 & Coil_Assembly.mph (root)

the Results node each have their default name. b () Global Definitions
Additionally, there are two Component nodes b 1@ Coil (comp)

: . 8 Coil Housi 2
and two Study nodes with the names chosen in : : atiorad (comp2)

. ationary

the previous paragraph. !
I

~dt Frequency Domain

& Results

22 |



PARAMETERS, VARIABLES, AND SCOPE

Global Parameters

Global parameters are user-defined constant scalars that are usable throughout the
model. That is to say, they are “global” in nature. Important uses are:

o Parameterizing geometric dimensions.
* Specifying mesh element sizes.

* Defining parametric sweeps (simulations that are repeated for a variety of
different values of a parameter such as a frequency or load).

A global parameter expression can contain numbers, global parameters, built-in
constants, built-in and user-defined functions with global parameter expressions
as arguments, and unary and binary operators. For a list of available operators, see
“Appendix C — Language Elements and Reserved Names” on page 184. Because
these expressions are evaluated before a simulation begins, global parameters may
not depend on the time variable t. Likewise, they may not depend on spatial
variables like x, y, or z, nor on the dependent variables for which your equations
are solving.

It is important to know that the names of parameters are case sensitive.
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You define global parameters in the Parameters node in the model tree under
Global Definitions.

Maodel Builder -1 -
+~— ‘= Et o
4 & busbar.mph (root)
4 (@ Global Definitions Label: Parameters 1 =
Fi Parameters 1 . "
v
(& Default Model Inputs arameters
2 Materials 3
4 [ Component 1 (comp1) MName Expression Value Description
b = Definitions L 9[em] 0.09m Length
b YA Geometry 1 rad_1 B6[mm] 0.006 m Bolt radius
I : . Materials thb 3[mm] 0.005m Thickness
I 3 Electric Currents (c) whb 5[em] 0.05m Widt.h :
b {8 Heat Transfer in Solids (ht) mh 3[mm] 0.003 m Maximum element size
4 . . htc 5[W/m*"2/K] 5 W/ (m*K) Heat transfer coefficient
I iy Multiphysics
boA Mesh 1 ZO[m‘u'] 0.02V Applied voltage
4 ~db Study 1
[= Step 1: Stationary -
I [fre Solver Configurations + A~ 5\
[ @ Results Marme:
Vot
Expression:
20[mV]
Description:

Applied voltage

Note that you can add multiple Parameters nodes and they will be named
Parameters |, Parameters 2, ctc. In addition, Parameters can be organized into
several cases and then swept over, for more information see “Parametric Sweeps”
on page 144.

Results Parameters

For greater flexibility, it is possible to define parameters that are only used in the
Results node. Using these parameters does not require resolving the model.

Model Builder ~ ®|| Settings -
o= = ETEL =~ Parameters
4 & busbar.mph (root)

I () Global Definitions ¥ Parameters

I @ Component1 {comp1) -

[~ Study 1 MName Expression Value Description

4 (B Results iso_level | 309.5[K] 309.5K Isosurface level

Fi Parameters

Datasets

£ Study 1/Solution 1 (s0l7)
HH y =

I &2 Derived Values

Result parameters may depend on other parameters and built-in functions.
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Variables

Variables have associated Variables nodes in the model tree and can be defined
cither in the Global Definitions node or in the Definitions subnode of any Component
node.

Model Builder =i

— = Etd

i
a4

4 & busbar.mph (root)

(1 Global Definitions

b
4 |§ Component1 (comp1)
4 = Definitions
2= Variables 1
I+ g Selections
[ Boundary System 1 {sys1)

b [ View 1

Naturally, the choice of where to define the variable depends on whether you want
it to be global (that is, usable throughout the model tree) or locally defined within
a single Component node. Like a parameter expression, a variable expression may
contain numbers, parameters, built-in constants, and unary and binary operators.
However, it may also contain variables like t, x, y, or z; functions with variable
expressions as arguments; and dependent variables that you are solving for, such
as temperature T or voltage V, in addition to their space and time derivatives.

If you have a model with many Variables nodes it may be useful to group them
together by using the Node Group feature, as shown below.

‘= Show More Options...

MNode Group

Group by Type

Node groups can be used to group nodes in Global Definitions, Definitions under a
Component, Materials, physics interfaces, and results.

Variables Used in Applications

Model parameters and variables can be used in applications. For example, you can
let the user of an application change the value of a parameter. In addition, variables
to be used in applications can be defined in the Application Builder, in the
application tree under the Declarations node. Such variables can also be used in
model methods.

Scope

The “scope” of a parameter or variable is a statement about where it may be used
in an expression. All global parameters are defined in the Global Definitions node
of the model tree as a Parameters subnode. This means that they are global in
scope and can be used throughout the model tree.
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A variable may also be defined in the Global Definitions node, as a Variables
subnode, and have global scope, but they are subject to other limitations. For
example, variables may not be used in Geometry, Mesh, or Study nodes (with the
one exception that a variable may be used in an expression that determines when
the simulation should stop).

A variable that is instead defined under the Definitions subnode of a Component
node has local scope and is intended for use in that particular Component (but,
again, not in the Geometry or Mesh nodes). They may be used, for example, to
specify material properties in the Materials subnode of a Component or to specify
boundary conditions or interactions. It is sometimes valuable to limit the scope of
the variable to only a certain part of the geometry, such as certain boundaries. For
that purpose, provisions are available in the settings for a variable to select whether
to apply the definition ecither to the entire geometry of the Component or only to
a Domain, Boundary, Edge, or Point.

The figure at right shows the

definition of two variables, q_pin >eHINg: ot
and R, for which the scope is limited o _

to just two boundaries identified by el =2
numbers 15 and 19 Geometric Entity Selection

Such a group of numbers is called a :ZZ:C et ::nnu:ry :
Selection and can be named and 5 N
then referenced elsewhere in a 1 a -
model. This can be useful, for Aetwe o W
example, when defining material ‘
properties or boundary conditions

that will use the variable at certain T Variables

boundaries but not elsewhere. To " Name  Expression Unit  Description

give a name to the Selection, click Aq::;ﬁ;wzm\m 21 |dkg | Suface bt source
the Create Selection button (%) to o i

the right of the Selection list. P——

Although the variables defined in Name

the Variables node under the a.pin

Component > Definitions subnode B

are intended to have local scope, S——

they can still be accessed outside of  suface heat source

the Component node in the model

tree by being sufficiently specific

about their identity. This is done by using a “dot-notation” where the variable
name is preceded by the name of the Component node in which it is defined and
they are joined by a “dot”. In other words, if a variable named foo is defined in a
Component node named MyModel, then this variable may be accessed outside of the

A*mu/sqrt(3*(Le mun 2)[W/m 2]
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Component node by using MyModel.foo. This can be useful, for example, when
you want to use the variable to make plots in the Results node. Variables defined
under the Declarations node in the Application Builder are available globally in
form objects and methods but cannot be used in the Model Builder.

The following spread shows an example of a customized desktop with additional
windows.

| 27



QUICK ACCESS

TOOLBAR SETTINGS WINDOW RIBBON
e 10 = BEOED
Home Definitions Geometry ~Materials  Physics  Mesh [Study Results Developer  Sound Pressure Level (acpr)
2= Variables ~ = Import Ry »
> P; 2 ) o A | =
A ﬁ ! (<) Functions » "1 pNd ¥ ‘&
pplication omponent arameters ui ressure Acoustics, ui es| omp
Applicati C Add p Build Add p A Add Build Mesh  C
uilder - Component ~ - All Material |~ Frequency Domain + Physics ~ Mesh 1~
MODEL BUILDER Application Model Definitions Geometry Materials Physics Mesh
WINDOW ————\/indel Builder - # Graphics
- s Et - QaQ@-@idrykkn & @~
4 4§ automotive_muffler.mph (roct) lot M= 4= =+ =H
4 (@) Global Definitions freq(90)=990 Hz Surf;
P| Parameters 1 Label: Surface 1 2
4 Default Model Inputs
& Materials ¥ Data
4cC t1 1
B Componere (comp’) Dataset: | From parent -
b YA Geometry 1
. A Mznt:m:y ~ Expression S epr %
4 (1) Pressure Acoustics, Frequency Domain (acpr)  Expression:
&= Pressure Acoustics 1 acprip A
Sound Hard Boundary (Wall) 1 prp-
L= initial Values 1 Unit:
b (mm Plane Wave Radiation 1 dB -
MODEL TREE S Plane Wave Radiation 2 [ Description:
= Interior Sound Hard Boundary (Wall) 1 prion:
b A Mesh 1 Total sound pressure level
b oo Study 1 Tl
4 [B Results e
Datasets Range
Derived Values
b BE Tables ~ Coloring and Style
b Nl Acoustic Pressure (acpr) Coloring: Color table - 0.05
4\ Sound Pressure Level (acpr)
i) ] Colortable:  Rainbow -
b Wi Acoustic Pressure, lsosurfaces (acpr) Color legend m o
4 % Transmission Loss [] Reverse color table
g G:“” [[] symmetrize color range 005
o
= REEMS [ Wireframe
Quality
Inherit Style
z //
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x
0.35072
0.41965
0.47053
0.37952
0.25000

B85
&2

Progress

Log Evaluation 3D

Hoe @@ \IlBE

y z
-0.13371 |0.014055 |0.76800|
-0.14909 |-0.0070919/0.31828|
-0.13281 |-0.032374 |0.45728|
-0.14987 |-0.0014467|0.89038|
-0.068265|-0.0049622|0.27079|
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GRAPHICS WINDOW

DYNAMIC HELP — Continuously updated with online access to the
Knowledge Base and Application Gallery. The Help window enables
easy browsing with extended search functionality.

automotive_muffler.mph - COMSOL Multiphysics

& O

Sound Pressure AddPlot  Windows  Reset

~de "% [
te Study  Add

1-  Study  Level (acpr) - Group - - Desktop
Study Results Layout
= Os-ad
ce: Total sound pressure level (dB)
m

— [m) x
- | Help CLE
— = g o
2 = Q

2GB|2.68GB

INFORMATIONWINDOWS

COMSOL Multiphysics > COMSOL Multiphysics Reference Manual >
The Pressure Acoustics Interface > Fundamentals of Acoustics >
Different Acoustic Interfaces

90
Different Acoustic Interfaces ~
Depending on the basic dependent variable used to medel the
20 acoustic field, the acoustical interfaces can be divided inta the
fallowing main categories.
+ Pressure acoustics—The dependent variable is the acoustic
70 pressure p.
+ Acoustic-solid interaction—The dependent variables are the
pressure p and the displacement field u in the solid. This type of
60 problem requires the addition of the Acoustics Module.
Poroelastic waves—The dependent variables are the pressure p
inside the saturating fluid and the total displacement u of the
porous matrix. This fype of problem requires the addition of the
50 Acoustics Module.
v
+ Aeroacoustics—The dependent variables are the acoustic
< Previous Section Next Section »
40
Plot 1 TEX
aaq@-HIUNED a S-aa
30 _ o PLOT WINDOW —
Global: Transmission loss . )
The Plot window is
60 F T T R
-
551 Transmission loss e
2 Results quantities,
50 E
probes, and
ast E
=5 convergence plots.
o E 20l ] g P.
9 Several Plot windows
g 354 i
= 10 can be used to show
5 L i
] multiple results
TrE 5 1
2 simultaneously.
& 20+ E
£
15+ E
10+ E
s ]
O 1 1 1 1 1]
200 400 600 200 1000
Frequency (Hz)
[ | =
PROGRESS BAR WITH CANCEL BUTTON

| 29



Built-In Constants, Variables, and Functions

COMSOL Multiphysics comes with many built-in constants, variables, and
functions. They have reserved names that cannot be redefined by the user. If you
use a reserved name for a user-defined variable, parameter, or function, the text
you enter will turn orange (a warning) or red (an error) and you will get a tooltip
message if you select the text string.

Some important examples are:
» Mathematical constants such as pi (3.14...) or the imaginary unit i or j

 Physical constants such as g_const (acceleration of gravity), c_const (speed
of light), or R_const (universal gas constant)

e The time variable, t

« First- and second-order derivatives of the dependent variables (the solution)
whose names are derived from the spatial coordinate names and dependent
variable names (which are user-defined variables)

e Mathematical functions such as cos, sin, exp, log, log10, and sqrt

See “Appendix C — Language Elements and Reserved Names” on page 184 for
more information.

The Application Libraries

The Application Libraries are collections of MPH files containing tutorial models
and runnable applications with accompanying documentation. Tutorial models
show how to use the Model Builder and have documentation that includes
theoretical background and step-by-step instructions. Runnable applications have
instructions on how to use the application. You can readily inspect and edit all
tutorial models and applications to make them your own. Each physics-based
add-on module comes with its own application library with examples specific to its
applications and physics area. You can use the step-by-step instructions and the
MPH files as a template for your own modeling.
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To open the Application Libraries window, select Application Libraries [ from the
Windows menu on the Home toolbar or from the File menu [. Then, search by
application name or browse under a module folder name.

Application Libraries

4 Refresh [T Update COMSOL Application Libraries ([} Apph

Search

3 COMSOL Multiphyscs

¥ % ALDC Module

P} Acoustics Module

a3 Battery Design Muodule

» [ CAD Imporl Module

4 o CFD Module

Applications
Fluid-Structure Intersction
ligh Mech Murnber Flow
Multiphase Flaw
Henisothermmel Flow

Thet example salves the mcampred e

Paticle Tracing e saze of the recirculebion region

Shellow Weter Equations
Single-Phase Flaw
® beckstsp Harne backstep
yfinder flaw viscoslastic Used products + COMSOI
O hydrocyclens « CF0 Mo
© non_newtonian flow Physics intesfaces  Lamnina Fl
O retating disk
© turbulent_miding
® water_purificstion resctar Computstiontime & seconds
Thin-Film Flew
fication Examples

Created in COMSOL

Author COM0L

{53 Chemicel Resction Engineering Module Last modificd Qet 14, 207
651 Composite Materials Module

-y Comosion Module

B Design Medule Z 2
ECAD Import Module Application Library path: cFD_Medule (fiagie Prace_Tuterials maskstep

Created et 14, 202

%% Hlectrical Circuits Module
1 | Fiertrnchesistrs Mndule

m =
=l al
Fun Agplication | ®| Open
. W

=] Open POF Decurnent 1 11 e e i, ek Pt Wk
WeBEL wizanp
1 10 dhe Madel Witard

> [T chm 2 nthe Sobest phyis
3 Chuk asa

§ Cluk oty

Click Open [s] , Run Application » , or Open PDF Document i=| . Alternatively,
select Help > Documentation from the File menu to search by application name or
browse by module. Note that the Run Application option is only available for MPH
files that are runnable applications.

The MPH files in the Application Libraries can have three formats — Solved MPH
files, Compact MPH files, or Preview MPH files:

* Solved MPH files, including all meshes and solutions. In the Application
Libraries window, these appear with the @ icon. If the MPH file size
exceeds 25 MB, a tip with the text “Large file” and the file size appears when

you position the cursor at the model’s node in the Application Libraries tree.

» Compact MPH files, with all settings for the model but without built meshes
and solution data to save space in the installation. Some MPH files have no
solutions for other reasons such that the computation time is short and the
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results are easily regenerated. You can open these to study the settings and
to mesh and re-solve. It is also possible to download the full versions — with
meshes and solutions — of most of these when you update your Application
Libraries. These appear in the Application Libraries window with the ¢
icon. If you position the cursor at a compact file in the Application Libraries
window, a No solutions stored message appears. A solved version is available
for download via the Application Library Update (except in a few cases
where the file is a template related to another, regular, model).

Preview MPH files, with only a model description and thumbnail image
available. These appear in the Application Libraries window with the
icon. The file is a preview of an application or a model file, including the
model description and information about used products and physics
interfaces and the computation time. Solved and compact versions are
available for download. Model documentation will be available if you have
specified the use of online help (see the Reference Manual for details on how
to do this).

The Application Libraries are updated on a regular basis by COMSOL. To check
all available updates, click Update COMSOL Application Libraries [] at the top of the

Application Libraries window. You can also find this option from the File > Help

menu (Windows® users) or from the Help menu (macOS and Linux® users). This

connects you to the COMSOL website, where you can access new applications
and the latest updates.

Application Libraries

C* Refresh |} Update COMSOL Application Libraries| () Application Gallery
| Search

b [@ COMSOL Multiphysics
b % AC/DC Module
[ 1)) Acoustics Module

If your computer has an internet connection, then you can click the Application
Gallery button to access a wide range of additional examples from the COMSOL

website.
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Workflow and Sequence of Operations

In the Model Builder window, every step of the modeling process, from defining

global variables to the final report of results, is displayed in the model tree.

- s EEL -

4 4 backstep.mph (root)
4 () Global Definitions
Fi Parameters 1
45 Default Model Inputs
2 Materials
4 |§ Component1 (comp1)
[ = Definitions
b Geometry 1
[ Materials
aminar Flow (spf)

= Fluid Properties 1
B Initial Values 1
G Wall 1
= Inlet
= Symmetry 1
= Outlet 1
A Mesh 1
4 o Study 1
[= Step 1: Stationary
I [fre Solver Configurations
4 ([ Results
I #: Datasets
£ Derived Values
B Tables
I N Velocity (spf)
I N Pressure (spf)
4 @ Velocity, Streamlines
4 3= Streamline 1
5 Color Expression 1
1 Export
Reports

-1

From top to bottom, the model tree defines an orderly sequence of operations.

In the following branches of the model tree, the node order makes a difference
and you can change the sequence of operations by moving the subnodes up or
down the model tree:

Geometry
Materials
Physics
Mesh

Study

Plot Groups
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Nodes may be reordered by these methods:

* Drag-and-drop

* Right-clicking the node and selecting Move Up or Move Down
¢+ Pressing Ctrl + Up arrow or Ctrl + Down arrow

In other branches, the ordering of nodes is not significant with respect to the
sequence of operations, but some nodes can be reordered for readability. Child
nodes to Global Definitions is one such example.

You can view the sequence of operations presented as program code statements by
saving the model as a Model File for MATLAB® or as a Model File for Java® after having
selected Compact History in the File menu. Note that the model history keeps a
complete record of the changes you make to a model as you build it. As such, it
includes all of your corrections, including changes to parameters and boundary
conditions and modifications of solver methods. Compacting this history removes
all of the overridden changes and leaves a clean copy of the most recent form of
the model steps. In the Application Builder, you can use the Record Method option
to view and edit program code statements in the Method editor.

As you work with the COMSOL Desktop interface and the Model Builder, you
will grow to appreciate the organized and streamlined approach. However, any
description of a user interface is inadequate until you try it for yourself. In the next
chapters, you are invited to work through two examples to familiarize yourself
with the software.
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Example |: Structural Analysis of a Wrench

This simple example requires none of the add-on products to COMSOL
Multiphysics®. For more fully-featured structural mechanics models, see the
Structural Mechanics Module application library.

At some point in your life, it is likely that you have tightened a bolt using a wrench.
This exercise takes you through a structural mechanics model that analyzes this
basic task from the perspective of the structural integrity of the wrench subjected
to a worst-case loading.

The wrench is, of course, made from steel, a ductile material. If the applied torque
is too high, the tool will be permanently deformed due to the steel’s elastoplastic
behavior when pushed beyond its yield stress level. To analyze whether the wrench
handle is appropriately dimensioned, you will check if the mechanical stress level
is within the yield stress limit.

This tutorial gives a quick introduction to the Model Builder workflow. It starts
with opening the Model Wizard and adding a physics option for solid mechanics.
Then a geometry is imported and steel is selected as the material. You then explore
the other key steps in creating a model by defining a parameter and boundary
condition for the load; selecting geometric entities in the Graphics window;
defining the Mesh and Study; and finally, examining the results numerically and
through visualization.

If you prefer to practice with a more advanced model, read this section to
familiarize yourself with some of the key features, and then go to the tutorial
“Example 2: The Busbar — A Multiphysics Model” on page 62.
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Model Wizard

I To start the software, double-click the COMSOL

Multiphysics icon on the desktop, which will take you to E
the New window with two options for creating a new vl
model: Model Wizard or Blank Model. o

3.0

If you select Blank Model, you can right-click the root node

in the model tree to manually add a Component and a Study.
For this tutorial, click the Model Wizard button. 0 e
If the COMSOL Desktop user interface is already open, Wizard

you can start the Model Wizard by selecting New from the

File menu. Choose the Model Wizard. et
Elank Model

The Model Wizard will guide you through the first steps of
setting up a model. The next window lets you select the
dimension of the modeling space.

2 In the Select Space Dimension window, sclect 3D.
A i
@ ] &ra Q = -
30 2D 1D

Axisymmetric 4z Axisymmetric gE LE
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3 In Select Physics, sclect
Structural Mechanics > Solid Select Phygicg
Mechanics (solid) = . Click Add.

. . Search
Without add-on modules, Solid
. . ) [ Heat Transfer
Mechanics is the only physics b i Optics
1 ~ 4 a L N & &) Plasma
interface available in the b 1 Racio Frequency
Structural Mechanics folder. In » & Semicondustor
. . 4 B2 Structural Mechanics
the picture to the right, part of %= Solid Mechanics (solid) 6
. [T Shell (shell)
Fhe Structurel Mechanics folder © Layercd Shel (shelh
is shown as it appears when all L] Membrane (mbrn)
. &t Beam (beam)
add-on modules are available. Truss (truss)
[ Multibody Dynamics (mbd)
ﬁ} Lumped Mechanical System (Ims)
. . I ¥ Rotordynamics
Click Study © to continue. 3 Pipe Mechanics (pipern)
<% Fatigue (ftg)
[ S PO C R USROS
Add
Added physics interfaces:
== Solid Mechanics (solid)
Remove

GSpace Dimension ee Study
Help e Cancel El/Done

4 Click Stationary - under Preset
Studies. Click Done = once you Select Study

have finished.
. 4~ General Studies
Preset studies have solver and
equation settings adapted to the e o
selected physics, which is, in this K Time Dependent

Added study:

example, Solid Mechanics. A
[~ Stationary

Stationary study is used in this

Added physics interfaces:
case — there are no S Solid Mechanics (said)
time-varying loads or material
properties.

Any selection from the Custom Studies branch - requires manual settings.
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Geometry

This tutorial uses a geometry that was previously created and stored in the
COMSOL native CAD format, .mphbin. To learn how to build your own
geometry, see “Appendix A — Building a Geometry” on page 162.

The location of the application library that contains the file used in this exercise
varies based on the software installation and operating system. In Windows®, the
file path will be similar to:

C:\Program Files\COMSOL\COMSOL56\Multiphysics\applications.
Now, import the ready-made geometry file as follows.

I In the Model Builder window, under Component I, right-click Geometry |
and select Import =.

®ETELE -

4 & Untitled.mph (root)
4 () Global Definitions
Fi Parameters 1
2 Materials
4 |§ Component1 (comp1)
[ = Definitions
G I» \)\ Geometry 1
25 Materials B Build Al F&
4 £27 Solid Mechani
i Linear Elas
B Freel Livelink Interfaces r

+ |mport

B Initial Valu
A5 Mesh 1
4 ~on Study 1 [T) Block

Defeaturing and Repair

As an alternative, you can use the ribbon and click Import = from the Geometry
tab.
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2 In the Settings window for Import, from the Source list, if not already selected,
select COMSOL Multiphysics file.

Settings =i
mpEort

[ Build Selected = [E8 Build All Objects 2
Label: Import1 =
¥ Import

Source:

COMSOL Multiphysics file G -

Filename:
e C:\Program Files\COMSOL\COMSOL56hMultiphysics\applications\ COMSOL_Multiphysics\Structural_Mechanics\wrench.mphbin
Browse... Import

Include result from virtual operations

3 Click Browse and locate the file wrench.mphbin in the application library folder
of the COMSOL installation folder. Its default location in Windows® is

C:\Program Files\COMSOL\COMSOL56\Multiphysics\
applications\COMSOL_Multiphysics\ Structural_Mechanics\wrench.mphbin

Double-click to add or click Open.
4 Click Import. The geometry is now displayed in the Graphics window.
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5 Click the wrench geometry in the Graphics window and then experiment with
moving it around. As you point to or click the geometry, it changes color. Click
the Zoom In @, Zoom Out © , Go to Default 3D View ..., Zoom Extents [, and
Transparency & buttons on the Graphics window toolbar to see what happens to
the geometry:

- To rotate, click and drag anywhere in the Graphics window.

- To move, right-click and drag.

- To zoom in and out, click the mouse scroll wheel, continue holding it, and
drag.

- To get back to the original position, click the Go to Default 3D View .- button
on the toolbar.

raphics -

a@@r oM Lriikkh ¢r G S @B 20 @ ENOREET O O
=
Rotate: Click and drag 107 m

Pan: Right-click and drag

%107

Also see “Appendix B — Keyboard and Mouse Shortcuts” on page 179 for
additional information.

The imported model has two parts, or domains, corresponding to the bolt and the
wrench. In this exercise, the focus will be on analyzing the stress in the wrench.
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Materials

The Materials node

: stores the material properties for all physics and all domains

in a Component node. Use the same generic steel material for both the bolt and
tool. Here is how to choose it in the Model Builder.

I Open the Add Materials window.

You can open the Add Materials

window in either of these two

ways:
- Right-click Component | >
Materials

Library i

. in the Model Builder
and select Add Material from

[ )

i Materials
£ Solid Mec
i Linear D

G Freel

= Initial |
A Mesh 1

1 Add Material from Library

Browse Materials
Blank Material

Layers r

- From the ribbon, select the Home tab and then click Add Material.

2 In the Add Material window, click to

expand the Built-In folder. Scroll down
to find Structural steel, right-click, and

select Add to Component |.

3 Examine the Material Contents section
in the Settings window for Material to
see the properties that are available.

Properties with green check marks are

used by the physics in the simulation.

4 Close the Add Material window.

¥ Material Contents
"
Property
[ | Density
G [ |Young's modulus
[¥ |Poisson's ratio
Relative permeahility
Heat capacity at constant pressure
Thermal conductivity
Electrical conductivity
Relative permittivity
Coefficient of thermal expansion
Murnaghan third-order elastic moduli
Murnaghan third-order elastic moduli

Variable
rtho

E

nu

mur_iso ;...
Cp

k_iso; kil...
sigma_is...
epsilonr_i.
alpha_iso...
|

m

Value

7850[kg/m ™.

200€3[Pa]
030

z

4750/ (kg*K)]

445[W/(m"...

4.032e6[5/m]
1
12.3e-6[1/K]
-3.0¢11[Pa]
-6.2¢11[Pa]

Add Materia

(1) Add to Global Materials * —| Add to Compenent ~

o

Search

Mimanic alloy 90
Nylan

=i Polysilicon
22 Lead Zirconate Titanate (PZT-5H)
=i Silica glass

Silicen

2= Solder, 605n-40Pb

Steel AISI 4340
Structural steel

2 | £ Addto Global Materials

IE Addto Component 1 (comp1)

== Water, liquid

¥ AC/DC

Unit
kg/m*
Pa

1

1
WikgK)
W/ (K
S/m

1

WK
N/m®
N/m*

Property group

Basic

Young's modulus and Poisson's ratio
Young's modulus and Poissen's ratio
Basic

Basic

Basic

Basic

Basic

Basic

Murnaghan

Murnaghan
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Also see the busbar tutorial sections “Materials” on page 75 and
“Customizing Materials” on page 118 to learn more about working with
materials.

Global Definitions

You will now define a global parameter specifying the load applied to the wrench.

Parameters
I In the Model Builder, under Global Definitions ¢, choosc Parameters |

4 4@ Untitled.mph (root)
4 () Global Definitions
Fi Parameters 1
== Materials
T Component 1 {compT)

2 Go to the Settings window for Parameters |. In the Parameters table, enter these
settings:
- In the Name column or field, enter F.
- In the Expression column or field, enter 150[N]. The square-bracket notation
is used to associate a physical unit to a numerical value; in this case, the unit

of force in Newtons. The Value column is automatically updated based on the
expression entered once you leave the field or press Return.

- In the Description column or field,
enter Applied force.

¥ Parameters

" Name Expression Value Description
F 150[N] 150 N Applied force

If you have a Parameters table with more than one entry, you can sort the
table with respect to a particular column by clicking on the corresponding
header.

The sections “Global Definitions” on page 67 and “Parameters, Functions,
Variables, and Couplings” on page 113 show you more about working with
parameters.
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So far, you have added the physics and study,
imported a geometry, added the material, and
defined one parameter. The Model Builder
node sequence should now match the figure
to the right. The default feature nodes under
Solid Mechanics are indicated by a D in the
upper-left corner of the node icon #=.

The default nodes for Solid Mechanics are:
Linear Elastic Material, Free, and Initial Values.

The node Linear Elastic Material is the default
material model for the Solid Mechanics
interface. The node Free is a boundary
condition that allows all boundaries to move
freely without a constraint or load. The node
Initial Values is used for specifying initial
displacement and velocity values for a
nonlinear or transient analysis (not applicable
in this case).

4 @ Untitled.mph {root)

4 () Global Definitions
Fi Parameters 1
Materials
4 |§ Component1 (comp1)
[ = Definitions
4 0 Geometry 1
= Import1 {imp1)
Form Union (fin)

4 EE Materials

[» Eg= Structural steel (matd)
4 @ Solid Mechanics (solid)
T Linear Elastic Material 1

G Freel
B Initial Values 1
A Mesh 1
4 o Study 1
[= step 1: Stationary

b {8 Results

The default physics nodes cannot be removed. Instead, you specify physics settings
that deviate from that of the default nodes by adding additional nodes. These
additional nodes can override or contribute to the settings of the default nodes as
well as other nodes. For more information, see “Override and Contribution:

Exclusive and Contributing Nodes” on page 129.

At any time, you can save your model and then open it later in exactly the state in

which it was saved.

3 From the File Menu, sclect File > Save As. Browse to a folder where you have
write permissions, and save the file as wrench.mph.

| 43



Physics and Boundary Conditions

With the geometry and materials defined, you are now ready to set the boundary
conditions.

| In the Model Builder, 4 1 Component 1 (comp )

right-click Solid Mechanics b = Definifions
(solid) = and select Fixed 4 )5\ Geometry 1 :

. = Import 1 (imp1) Material Models
Constraint = . Form Union (fin) Volume Forces
This boundary condition 4 258 Materials Mass, Spring, and Damper

. he displ £ I» £g& Structural steel (mat] . .
constrains the 1Sp acement o 4 =5 Solid Mechanics (solid) Domain Constraints
each point on a boundary BS Linear Elastic Material More

. o
surface to be zero in all = Freel = Boundary Load
. . i Initial Values 1
derCthnS. A Mesh 1 m  Fixed Constraint
. 4 o Study 1 mw  Prescribed Displacement
You can also use the ribbon [ Step 1: Stationary S Roller
. b {8 Results

and select, from the Physics B Port

tab, Boundaries > Fixed
Constraint.

2 In the Graphics window, rotate the
geometry by clicking anywhere in the
window and then dragging the wrench
into the position shown. Click on the
exposed front surface of the partially
modeled bolt. The boundary turns blue
indicating that it has been selected. The
Boundary number in the Selection list
should be 35.

3 Click the Go to Default View button ... on the Graphics toolbar to restore the
geometry to the default view.

Graphics ©

Qa®- @@ B

Go to Default View
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4 In the Model Builder, right-click Solid Mechanics (solid) = and select Boundary
Load. A Boundary Load node = is added to the Model Builder sequence.

4 5= Solid Mechanics (solid)
T Linear Elastic Material 1
S Freel
= Initial Values 1
= Fixed Constraint 1

e s Boundary Load 1
A Mesh 1

The “warning” attribute displayed on the Boundary Load node indicates that
its boundary selection is empty. The next step will be to select a boundary.

5 In the Graphics window, click the Zoom -
Box button @ on the toolbar and drag i ]
the mouse to select the square region
shown in the figure to the right.
Release the mouse button to zoom in
on the selected region.

6 Select the top socket face (boundary
111) by clicking the boundary to
highlight it in blue and add it to the
Selection list.

7 In the Settings window for Boundary

Load, under Force, sclect Total force as T o

the Load type and enter -F in the text lLoidt:iE: -
field for the z component. The negative - Uorce 5
sign indicates the negative z direction Feor 0 v | N
(downward). With these settings, the e - z

load of 150 N will be distributed
uniformly across the selected surface.



Note that to simplify the modeling process, the mechanical contact between the
bolt and the wrench is approximated with a material interface boundary condition.
Such an internal boundary condition is automatically defined and guarantees
continuity in normal stress and displacement across a material interface. A more
detailed analysis including mechanical contact can be done with the Structural
Mechanics Module.

SELECTING BOUNDARIES AND OTHER GEOMETRIC ENTITIES

When a boundary is unselected, its color is typically gray. The exception is when
you use the material Appearance setting available in Materials; see page 78. To
select a boundary, first hover over it. This highlights the boundary in red,
assuming the boundary was previously unselected. Now, click to select the
boundary by using the left mouse button. The boundary now turns blue. Its
boundary number will appear in the Selection list in the Settings window of the
corresponding boundary condition. Once a boundary is selected and you hover
over it again, the boundary turns green. If you click a boundary highlighted in
green, the boundary is deselected and now turns gray again. The same technique
for selecting and deselecting is applicable to geometry objects, domains,
boundaries, edges, and points.

The figure below shows the different selection states for a boundary.

Highlighted for selection Selected Highlighted for deselection

To select internal surfaces that are hidden behind the one closest to you, use one
of the following methods to cycle through the boundaries at the mouse pointer:
roll the mouse scroll wheel, use the keyboard + and - buttons, use the keyboard
arrow-up and arrow-down buttons, or use two-finger drag on a touchpad.

SELECTING USING THE GRAPHICS WINDOW CONTEXT MENUS

As an alternative selection method, you can right-click in the Graphics window and
select one of the options for domain, boundary, edge, or point selection.
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For example, to assign a Boundary Load boundary condition, first right-click and
select New Boundary Selection, as shown in the figure below.

Zoom to Selection

Measure
Select Box
Zoom Box

Zoom Extents

New Domain Selection
New Boundary Selection

New Edge Selection

IhteeE»GEI &

New Point Selection

GoTe

Click to select the boundaries to which you would like to apply the boundary
condition. (In this case, the top socket face; boundary 111.) Then, right-click
again and sclect Boundary Load, as shown in the figure below.

Boundary Load
Fixed Constraint
Prescribed Displacement

Roller

oo

Port

Connections r
Mass, Spring, and Damper r
Thin Structures r

Meore Constraints r

Zoom to Selection

Measure

v 0@

Hide

Geometric Entity Level r

Show Selection for Solid Mechanics (solid)

Go To

You can also use this method to add additional boundaries to the selections of an
already created boundary condition. In the example above, you could, for
example, while having the Fixed Constraint node selected, select the menu option
Add to Boundary Selection for Fixed Constraint | (although it wouldn’t be applicable
in this example).
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SELECTING USING CLIP PLANES

For selecting geometric entities inside complicated CAD models, you can use clip
planes, clip boxes, clip spheres, or clip cylinders. You select these from the graphics
toolbar by clicking the Clipping toolbar button.

G- BN 2=~ @~
Add Clip Plane
Add Clip Box
Add Clip Sphere
Add Clip Cylinder

HHH B

By selecting a Clip Plane, for example, you can quickly hide all parts of a model that
is on one side of the plane. The figure blow shows a clip plane used to select one
of the interior boundaries of the wrench model.

Mesh

The mesh settings determine the resolution of the finite element mesh used to
discretize the model. The finite element method divides the model into small
elements of geometrically simple shapes, in this case tetrahedra. In each
tetrahedron, a set of polynomial functions is used to approximate the structural
displacement field — how much the object deforms in each of the three
coordinate directions. The stress is then computed by differentiating the
displacement field.
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In this example, because the geometry contains small edges and faces, you will
define a slightly finer mesh than the default setting suggests. This will better
resolve the variations of the stress field and give a more accurate result. Refining
the mesh size to improve computational accuracy always involves some sacrifice in
speed and typically requires increased memory usage.

I In the Model Builder, under Component I, click Mesh 1 4 . In the Settings window
for Mesh, under Mesh Settings, sclect Finer from the Element size list.

Settings M
|58 Build All
Label: Mesh1 =

¥ Mesh Settings

Sequence type:

Physics-controlled mesh -

¥ Physics-Controlled Mesh

Element size:
o | Finer -
Extremely fine
Extra fine
Finer

Fine

MNormal

Coarse

Coarser

Extra coarse
Extremely coarse

2 Click the Build All button = in the Settings window or on the Mesh toolbar.

The resulting mesh will require about 5GB to solve. If you have a computer
with less than 5GB of RAM you can select Fine from the Element size list (instead

of Finer.)
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3 After a few seconds, the mesh is displayed in the Graphics window. Rotate the
wrench to take a look at the element size distribution (this may vary a bit
depending on the version you are running).
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Study

In the beginning of setting up the model, you selected a Stationary study, which
implies that a stationary solver will be used. For this to be applicable, the

assumption is that the load, deformation, and stress do not vary in time. To start
the solver:

I Right-click Study I - and select

4 ~db Study 1
Compute = (or press F8). G @If:- Step 1 = Compute Fa
3 Results
After a few seconds of Parametric Sweep
computation time, the default plot ft9 Function Sweep
is displayed in the Graphics if Material Sweep

window. During computation, a

Progress window shows progress information from the solvers. After the
computation you can find other useful information about the computation in the
Messages and Log windows; Click the Messages and Log tabs under the Graphics
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window to see the kind of information available to you. The Messages window can
also be opened from the Windows drop-down list in the Home tab of the ribbon.

Messages Progress  Log
aLvE
<---— Stationary Solver 1 in Study 1/Sclution 1 ({scll)

Started at Sep 2, 2020 4:23:15 FM.

Linear sclver

Humber of degrees of freedom solwved for: 412212.
Symmetric matrices found.

Scales for dependent variables:

Displacement field (compl.u): 1

Orthonormal null-space function used.

Iter SolEst Damping Stepsize #Res #Jac #5cl LinErr LinRes
1 0.88 1.0000000 0.88 1 1 1 5.68e-10 4.3e-09

Solution time: 17 3.

Physical memory: 4.98 GB
Virtual memory: 7.18 GB

Ended at Sep 2, 2020 4:23:31 FM.

————— Stationary Solver 1 in Study 1/Sclution 1 ({scll)

Results

The von Mises stress is displayed in the Graphics window in a default Surface plot

with the displacement visualized using a Deformation subnode. Change the

default unit (N/m?) to the more suitable MPa as shown in the following steps.

I In the Model Builder, expand the Results > Stress
(solid) m node, then click Surface | ™.

2 In the Settings window under
Expression, from the Unit list, select
MPa (or type MPa in the field). Expression:

solid.mises

 Expression

Unit:
MPa
[] Description:

4 ([ Results
[

o

: Datasets

£ Derived Values

B Tables

4 @ Stress (solid)
I ™ Surface 1

Applied Loads (solid)
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3 Click the Plot button & on the toolbar of the Settings window for the Surface
plot and then click the Go to Default 3D View button ... on the Graphics window
toolbar.

The von Mises stress distribution is shown in the bolt and wrench under an
applied vertical load.

‘Surface: von Maes stress (MPal o

For a typical steel used for tools like a wrench, the yield stress is about 600 MPa,
which means that we are getting close to plastic deformation for our 150 N load
(which corresponds to about 34 pounds force). You may also be interested in a
safety margin of, say, a factor of three. To quickly assess which parts of the wrench
are at risk of plastic deformation, you can plot an inequality expression such as
solid.mises>200[MPa].
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I Right-click the Results node @ and add a 3D Plot Group w .

4 ([ Results
| B

= Data] @ 3D Plot Group

"

#32 Deriy M 20 Plot Group

B Table
4 @ Stres

Fi  Parameters

Plot All

“ 1D Plot Group
Polar Plot Group
Smith Plot Group

Evaluation Group

= Show More Options...

Mode Group

Copy as Code to Clipboard 3

ﬂ Help

Fi

2 Right-click the 3D Plot Group 3node w and select Surface ™.

4 ([ Results
[ Datasets

ea: Derived Values
B Tables
I N Stress (solid)

Vi 3D Plot Group 3
Export
[# Reports

3 In the Settings window for Surface,
click the Replace Expression button %

Plot
Plot In

Volume

Arrow Volume

Surface 6

 Expression Epv %~

and select Model > Component| > Solid Eplession

Mechanics > Stress > solid.mises-von
Mises stress - N/m> by double-clicking.
When you know the variable name
beforehand, you can also directly enter
solid.mises in the Expression ficld.

solid.mises=> 200[MPa]
Unit:

[] Description:
[MPa]

solid.mises

Now edit this expression to:
solid.mises>200[MPa].

This is a boolean expression that evaluates to either 1 for true or 0 for false. In
areas where the expression evaluates to 1, the safety margin is exceeded.

4 Click the Plot button s .
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5 In the Model Builder, click 3D Plot Group 3. Press F2 and, in the Rename 3D Plot
Group dialog box, enter Safety Margin. Click OK. Alternatively, edit the label
at the top of the Settings window.

The resulting plot shows that the stress in the bolt is high, but the focus of this
exercise is on the wrench. If you wish to comfortably certify the wrench for a
150 N load with a factor-of-three safety margin, you would need to change the
handle design somewhat, such as by making it wider.

You may have noticed that the manufacturer, for various reasons, has chosen an
asymmetric design for the wrench. Because of that, the stress field may be different
if the wrench is flipped around. Try now, on your own, to apply the same force in
the other direction and visualize the maximum von Mises stress to see if there is
any difference.

Convergence Analysis

The results from a simulation software such as COMSOL Multiphysics can
shorten design times dramatically by, for example, reducing the number of
experiments or product tests. However, simulation software is not a substitute for
real-world testing. This is especially important if there are risks for physical or
environmental damage. One way to reduce (but not eliminate) the risk of drawing
the wrong conclusions from simulation results is to perform a convergence
analysis.

To check the accuracy of the computed maximum von Mises stress in the wrench,
you can now continue with a mesh convergence analysis. Do that by using a finer
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mesh and therefore a higher number of degrees of freedom (DOFs).

This section illustrates some more in-depth functionality and the steps
below could be skipped at a first reading. In order to run the convergence
analysis below, a computer with at least 4GB of memory (RAM) is
recommended.

EVALUATING THE MAXIMUM VON MISES STRESS

To study the maximum von Mises stress in the wrench, in the Results section of
the model tree, right-click the Derived Values :: node and select Maximum >
Volume Maximum .

In the Settings window for Volume Maximum, under Selection, choose Manual and
select the wrench, domain 1, by clicking on the wrench in the Graphics window.
We will only consider values in the wrench domain and neglect those in the bolt.

In the first row of the Expressions table, in the Expression column, type
solid.mises. To find the expression for the von Mises stress, you can also click
the Replace Expression button % and browse to this variable.

4 In the Expressions table, type MPa as the Unit.

Settings
Volume Maximum
= Evaluate =

Label: Velume Maximum 1 =

¥ Data

Dataset: | Study 1/Solution 1 (sol1) | |E
Selection

Selection: | Manual -

|

Active -g:']

B (Pl &

v Expressions +- S~

"
Expression Unit Description

solid.mises MPa von Mises stress c
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5 In the Settings window for Yolume Maximum,

click Evaluate to evaluate the maximum stress. Messages  Progress Log  Table |
. . . BES B85 B850 i A\ m
The result will be displayed in a Table BRSSP oes [EHED | N DB
window and will be approximately 375 MPa. von Mises stress (MPa)
. . . 374.93 O
6 To sce where the maximum value is attained,

you can, for example, use a Max/Min Volume
plot. Right-click the Results node & and add a 3D Plot Group @ . Next,
right-click the 3D Plot Group 4 node w and select More Plots > Max/Min Volume

7 To plot values in the wrench and not in the bolt, right-click the Max/Min Volume
% node and select Selection and select the wrench domain number 1.

8 In the Settings window for Max/Min Volume, in the Expression text field, type
solid.mises.

9 In the Settings window under Expression, from the Unit list, select MPa (or enter
MPa in the field).

10 Click the Plot button @ . This type of plot simultaneously shows the location of
the maximum and minimum values and also their coordinate location in the
table below (the exact values may differ depending on the version you are
running).

coEEp - B Ee@DOs-as

Max/Min Velume: von Mises stress (MPa)

%100 m
10

*107% m

s
Messages Progress Log s -n
BOSES e @S

X ¥ Z won Mises stress (MPa)

008743 LO0TORE JA4ESE-4  003TIOS

0036471 40213F-4 | O006444T 37493
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PARAMETERIZING THE MESH

We will now define a parametric sweep for successively refining the mesh size while
solving and then finally plot the maximum von Mises stress vs. mesh size. First, we
define the parameters that will be used for controlling the mesh density.

I In the Model Builder, click Parameters |

under Global Definitions .

2 Go to the Settings window for Parameters. In the Parameters table (or under the

table in the fields), enter these settings:

- In the Name column or field, enter hd. This parameter will be used in the

parametric sweep to control the element size.

- In the Expression column or field, enter 1.

- In the Description column or field, enter Element size divider.

3 Now, enter another parameter with
Name ho, Expression 0.01, and
Description Starting element size.
This parameter will be used to define
the element size at the start of the
parametric sweep. F

hd

4 In the Model Builder, under Component o

I, click Mesh I 4 . In the Settings
window for Mesh, sclect User-controlled
mesh from the Sequence type list.

5 Under Mesh 1, click the Size node .

6 In the Settings window for Size, under
Element Size, click the Custom button.

Under Element Size Parameters, enter:
6]

- h0/hd in the Maximum element size ficld.

- h0/(4*hd) in the Minimum element size

field.

- 1.3 in the Maximum element growth rate
field.

- 0.1 in the Curvature factor field.

- 0.2 in the Resolution of narrow regions
field.

w -
Mame Expression Value

©

¥ Parameters

Description

150[N] 150 N Applied force
1 Element size divider
0.01 0.01 Starting element size

¥ Element Size Parameters

Maximum element size:

h0/hd m
Minimum element size:

h0/(4*hd) m
Maximum element growth rate:

1.3

Curvature factor:

0.1

Resolution of narrow regions:

0.2

See page 88 for more information on the element size parameters.

PARAMETRIC SWEEP AND SOLVER SETTINGS

As a next step, add a parametric sweep for the parameter hd.

| 57



I In the Model Builder, right-click Study I - and 4 St
select Parametric Sweep iii. A Parametric Sweep o 42 Parametric Sweep

node is added to the Model Builder sequence. [= Step L: Stationary
4 [Tr. Solver Configurations

2 In the Settings window for Parametric Sweep,
under the table in the Study Settings section, click the Add button +. From the
Parameter name list in the table, select hd.

3 Enter a range of Parameter values to

sweep for. Click the Range || button ;\fi:tgimxp

and enter the values in the Range = Compute

dialog box. In the Start field, enter 1. ... pmeticsween =
In the Step ficld, enter 1, and in the
Stop field, enter 6. Click Replace. The
Parameter value list will now display
range(1,1,6).

¥ Study Settings
Sweep type: | Specified combinations -

"
Parameter name Parameter value list ~ Parameter unit

hd (Element size divider] = | range(1,1,6)
The settings above make sure that as o
the sweep progresses, the value of the

parameter hd increases and the

maximum and minimum element sizes decrease.

See page 144 for more information on defining parametric sweeps.

For the highest value of hd, the number of DOFs will exceed one million.
Therefore, we will switch to a more memory-efficient iterative solver.

4 Under Study | > Solver Configurations > Solution I, expand the Stationary Solver
I node [z, and right-click Suggested Iterative Solver[x] and select Enable.
Selecting an iterative solver option typically reduces memory usage but may
require physics-specific tailoring of the solver settings for efficient
computations.

5 Under General in the Settings window for Suggested Iterative Solver, change the
Preconditioning to Right. (This is a low-level solver option, which in this case will
suppress a warning message that would otherwise appear. However, this setting
does not affect the resulting solution. Preconditioning is a mathematical
transformation used to prepare the finite element equation system for using the
iterative solver.)

6 Click the Study | node and select Compute =, cither in the Settings window or
by right-clicking the node. You can also click Compute in the ribbon Home or
Study tab. The computation time will be a few minutes (depending on the
computer hardware) and memory usage will be about 4GB.

RESULTS ANALYSIS

As a final step, analyze the results from the parametric sweep by displaying the
maximum von Mises stress in a table.
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I In the Model Builder under Results > Derived Values, sclect the Volume Maximum
I node .

The solutions from the parametric sweep are stored in a new Dataset named
Study |/Parametric Solutions 1. Now, change the Volume Maximum settings
accordingly:

2 In the Settings window for Volume Maximum, change the Dataset to Study
I/Parametric Solutions I.

3 Click the arrow next to the Evaluate button at the top of the Settings window
for Volume Maximum and select to evaluate in a New Table. This evaluation may
take 20 seconds or so.

4 To plot the results in the Table, click the Table Graph = button at the top of the
Table window (the first few values will vary due to slight mesh variations

between versions for coarser meshes before a converged value has been
reached).

S s @@ o -

hd von Mises stress (MPa)
1.0000 |437.98
2.0000 (391.88
3.0000 |334.92
4,0000 (382,76 425
5.0000 |376.45 420
6.0000 |375.79 - as

Vo Mses stress (WP
g 3

It is more interesting to plot the maximum value vs. the number of DOFs. This
is possible by using the built-in variable numberofdofs.

5 Right-click the Derived Values node :: and select Global Evaluation ).

6 In the Settings window for Global Evaluation, change the Dataset to Study
I/Parametric Solutions I.

7 In the Expressions ficld, enter numberofdofs.

You can type the first few characters of the variable name and then use
the keyboard shortcut Ctrl+Space to get a variable suggestion from the
list of available variables.
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8 In the Settings window for Global Evaluation, click the arrow next to the Evaluate
button and select the option to evaluate in Table 2. This displays the DOF values
for each parameter next to the previously evaluated data.

This convergence analysis shows that the computed value of the maximum von
Mises stress in the wrench handle will decrease from the high original value, for a
mesh with about 40,000 DOFs, to 375 MPa for a mesh with about 1,000,000
DOFs. It also shows that above 700,000 DOFs the results have essentially the
same accuracy as for 1,000,000 DOFs.

The figure below shows the associated Table Graph and Table Graph Settings
window.

| Label: Table Graph1 =
1 ¥ Data

Source: Table -
Table: Table 2 MEE]

| x-axis data: Number of degrees of freedom (1) =

400 . Plot columns: Manual v
. Columns:
300 | hd

won Mises stress (MPa)
Number of degrees of freedom (1)

s |

380

Note that depending on the version of COMSOL Multiphysics that you are
running, the above values may vary slightly due to variations in the number of
clements generated by the meshing algorithm.

As an alternative to Derived Values, you can use Evaluation Groups. An Evaluation
Group shares some of the properties of Plot Groups as well as Derived Values. An
Evaluation Group comes with an integrated table whereas Derived Values outputs to
a table of your choice. In addition, Evaluation Groups allows you to automatically
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re-evaluate after solving. To enable this, select the corresponding check box in the
Settings window of the Results node as shown in the figure below.

¥ Update of Results

[] Only plot when requested

Recompute all plot data after solving

Reevaluate all evaluation groups after solving

¥ Save Data in the Model

Save plot data:

-1

In this Settings window you can also request to regenerate all plots after solving.

You add an Evaluation Group in the same way as a Plot Group by right-clicking the
Results node. The figure below shows an Evaluation Group that performs the same
task as the Derived Values described earlier.

4 G Evaluation Group 1

ma Yolurme Maxirmum 1

.@ Global Evaluation 1

The figure below shows the corresponding Evaluation Group table.

Messages

&

hd
1.0000
2.0000
3.0000
4.0000
5.0000
6.0000

This concludes the wrench tutorial.

Log

[ 23

\

Evaluation Group 1

ElEGE -

von Mises stress (MPa) | Number of degrees of freedom (1)

437.98
391.88
384.92
382.76
376.45
375.79

42603

1.1564E5
2.5011E5
4.4698E5
6.9909E5
9.5113E5
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Example 2: The Busbar — A Multiphysics Model

Electrical Heating in a Busbar

This tutorial demonstrates the concept of multiphysics modeling in COMSOL
Multiphysics using the Model Builder. You will learn how to use one of the many
preconfigured multiphysics combinations as well as subsequently add the effects
of physics phenomena not initially included in the analysis. At the end, you will
have built a truly multiphysics model.

The model that you are about to create analyzes a busbar designed to conduct a
high amount of direct current in an industrial setting (see picture below). The
current conducted in the busbar, from bolt 1 to bolts 2a and 2b, produces heat
due to the resistive losses, a phenomenon referred to as Joule heating. The busbar
is made of copper, while the bolts are made of a titanium alloy. Busbar bolts are
usually made of steel, but in this example, we will assume a highly corrosive
environment. Therefore, a titanium alloy was chosen.

Under normal operational conditions, the currents are predominantly conducted
through the copper. This example, however, illustrates the effects of an unwanted
clectrical loading of the busbar through the bolts. The fact that there are different
materials is important because titanium has a lower electrical conductivity than
copper and will be subjected to a higher current density.

Titanium Bolt 2a

Titanium Bolt 2b  Titanium Bolt |

The goal of your simulation is to precisely calculate how much the busbar heats
up. Once you have captured the basic multiphysics phenomena, you will have the
chance to investigate thermal expansion that generates structural stresses and
strains in the busbar and the effects of cooling by an air stream.
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The Joule heating effect is described by conservation laws for electric current and
energy. Once solved for, the two conservation laws give the temperature and
electric field, respectively. All surfaces, except the bolt contact surfaces, are cooled
by natural convection in the air surrounding the busbar. You can assume that the
exposed parts of the bolt do not contribute to the cooling or heating of the device.
The electric potential at the upper-right vertical bolt surface is 20 mV and the
potential at the two horizontal surfaces of the lower bolts is 0 V. This corresponds
to a relatively high and potentially unsafe loading of this type of busbar. More
advanced boundary conditions for electromagnetics analysis are available with the
AC/DC Module, such as the capability to give the total current on a boundary. A
more advanced model that includes multiple busbars in an assembly, as shown in
the figure below, can be found in some of the add-on products, including the
AC/DC Module and a few of the LiveLink™ products for CAD.

B o i Sy i s e B A oy u
B . B sty i I | g o) — A

Busbar Model Overview

More in-depth and advanced topics included in this tutorial are used to show you
some of the many options available in COMSOL Multiphysics. The following
topics are covered:

+ “Parameters, Functions, Variables, and Couplings” on page 113, where you
learn how to define functions and nonlocal couplings.

e “Material Properties and Material Libraries” on page 117 shows you how to
customize a material and add it to your own material library.
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» “Adding Meshes” on page 119 gives you the opportunity to add and define
two different meshes and compare them in the Graphics window.

+ “Adding Physics” on page 122 explores the multiphysics capabilities by
adding solid mechanics and laminar flow to the busbar model.

o “Parametric Sweeps” on page 144 shows you how to vary the width of the
busbar using a parameter and then solve for a range of parameter values. The
result is a plot of the average temperature as a function of the width.

+ “Parallel Computing” on page 155, gives you an overview of how to solve
on clusters.

+ “COMSOL Multiphysics Client-Server” on page 159, gives you an
introduction to using the COMSOL Multiphysics client-server mode of
operation.

Model Wizard

I To open the software, double-click the COMSOL
Multiphysics icon on the desktop.

When the software opens, click the Model Wizard button.

You can also start the Model Wizard at any time by

selecting New from the File menu. Then, choose Model 0 Model

Wizard. Hizard
2 In the Select Space Dimension window, click 3D. Blank Model

|
e m T |9 T -
| |
2D 1D
EE Axisymmetric 4z Axisymmetric
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3 In the Select Physics window, expand
Heat Transfer > Electromagnetic
Heating. Then, right-click Joule
Heating |~ and choosc Add Physics.
Click the Study & button.

You can also double-click or click the
Add button to add physics.

(Another way to add physics is to
open the Add Physics window by
right-clicking the Component node in
the Model Builder and selecting Add
Physics =;.)

Note that you may have fewer items
in your physics list depending on the
add-on modules installed. The figure
on the right is shown for the case
where all add-on modules are
installed.

In the Select Study window, click to
select the Stationary ' study type.

Click the Done button.

Choosing a stationary study means
that we are solving for the
steady-state temperature of the
busbar when it has reached

Select Physics

Search
b (5 Recently Used
b % AC/DC
[> ) Acoustics
I =¥ Chemical Species Transport
I 1] Electrochemistry
b == Fluid Flow
4 (|| Heat Transfer
1@ Heat Transfer in Solids (ht)
Heat Transfer in Fluids (ht)
i@ Heat Transfer in Solids and Fluids (ht)
b |= Conjugate Heat Transfer
I Radiation
4 3| Electromagnetic Heating
X Joule Heating
i Induction Heating
B Microwave Heating
Sl acnr Hoatine
Add
Addled physics interfaces:
. Electric Currents (ec) 6
@ Heat Transfer in Selids (ht)
4, Multiphysics
x| Electromagnetic Heating (emh1)
Remove

6 e Study

e Space Dimension
Help € Concel [ Done

Select Study

4 ~co General Studies
[= Stationary
[/ Time Dependent
4 ~cb Preset Studlies for Selected Physics Interfaces
b g Heat Transfer in Solids
b ~cs Electric Currents
4 ~ob Preset Studlies for Selected Multiphysics
[== Frequency-Stationary
[== Frequency-Stationary, One-Way Coupled, Electromagnetic Heating
[% Frequency-Transient
[:% Frequency-Transient, One-Way Coupled, Electromagnetic Heating
b~ More Studies

o

Added study:
[= stationary

Added physics interfaces:
®_ Electric Currents (ec)
1B Hesat Transfer in Solids (ht)
4 i, Multiphysics
| Electromagnetic Heating (emh1)

@Physi:s
(2 B8 eiancel [ pone o
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thermal equilibrium with its surroundings.

A preconfigured Study has solver and equation settings adapted to the selected
combination of physics interface; in this example, Joule Heating.

Note that you may have fewer study types in your study list depending on the
installed add-on modules.

A physics interface is a user interface for a specific physics area that
defines the equations together with settings for mesh generation,
solvers, visualization, and results. A multiphysics interface is a
combination of physics interfaces together with multiphysics couplings.
The Joule Heating multiphysics interface consists of two physics
interfaces, Electric Currents and Heat Transfer in Solids, together with the
multiphysics coupling Electromagnetic Heating that appear in the
Multiphysics branch. This method of mixing physics is very flexible and
makes it possible to use all the capabilities of the participating
single-physics interfaces for multiphysics purposes.

Model Builder =0
- = StELE -

4 & Untitled.mph (root)
4 () Global Definitions
Pi Parameters 1
22 Materials
4 im Component 1 {comp 1)
[ = Definitions
b YA Geometry 1
22 Materials
4 +\_ Electric Currents (ec)
i Current Conservation 1
S Electric Insulation 1
i Initial Values 1
4 |[B Heat Transfer in Solids (ht)
i Solid 1
i Initial Values 1
S Thermal Insulation 1
- .{;3. Multiphysics
x| Electromagnetic Heating 1 (emh1)
A5 Mesh 1
4 ~db Study 1
E Step 1: Stationary

b {8 Results
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Global Definitions

To save time, it is recommended that you A 2xrad_|
load the geometry from a file. In that case, w
you can skip to “Geometry” on page 70.

If, on the other hand, you want to draw the
geometry yourself, the Global Definitions
node is where you define the parameters.
First, complete steps 1 through 3 below to
define the parameter list for the model.
Then, follow step 4 and skip to the section
“Appendix A — Building a Geometry” on
page 162.

The Global Definitions node @ in the Model
Builder stores Parameters, Variables, and
Functions with a global scope. The model
tree can hold several model components
simultaneously, and the definitions with a
global scope are made available for all
components. In this particular example,
there is only one Component node in which the parameters are used. If you wish
to limit the scope to this single component, you could define, for example,
Variables and Functions in the Definitions subnode, available directly under the
corresponding Component node. However, no Parameters can be defined here
because Parameters that are defined under Global Definitions are always global.

Since you will run a parametric study of the geometry later in this example, define
the geometry using parameters from the start. In this step, enter parameters for
the length of the lower part of the busbar, L; the radius of the titanium bolts,
rad_1; the thickness of the busbar, tbb; and the width of the device, wbb.

You will also add the parameters that control the mesh, mh; a heat transfer
coefticient for cooling by natural convection, htc; and a value for the voltage
across the busbar, Vtot.

I Under Global Definitions ), choose Parameters » . In the Parameters table, click
the first row under Name and enter L.

2 Click the first row under Expression and enter the value of L, 9[cm]. You can
enter the unit inside the square brackets.

3 Continue adding the other parameters: rad_1, tbb, wbb, mh, htc, and Vtot
according to the Parameters list below. It is a good idea to enter descriptions for
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variables in case you want to share the model with others and for your own
future reference.

¥ Parameters

" MName Expression Value Description
G L G[cm] G 0,09 m Length

rad_1 6[mm] 0.006 m Bolt radius

thb 5[mm] 0.005 m Thickness

whb 5lem] 0.05m Width

mh 3[mm] 0.003 m Maximum element size

htc 5[W/m*"2/K] 5 W/ (m*K) Heat transfer coefficient
e Vot 20[mV] 0.02V Applied voltage

Click the Save button 7 on the Quick Access Toolbar and name the model
busbar.mph or use the corresponding File menu option. Then, go to “Appendix
A — Building a Geometry” on page 162.

Auto Completion and Find for Parameters and Variables

The model tree contains a large number of parameters and variables. To make it
casier to find them, you can use auto completion and find tools as described
below.

AUTO COMPLETION

You can use Ctrl+Space for auto completion of parameter and variable names. For
example, in the Parameters table, click an empty Expression ficld and then press
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Ctrl+Space, you will get a list of parameters and variables, as shown in the figure

below.
mn apmimy wada m laximuim elerment siZe
htc 5[W/m*"2/K] 5 W/ (m*K) Heat transfer coefficient
Vot 20[mV] 0.02V Applied voltage
my_par
4 Parameters
L - Length - m
Vtot - Applied voltage - V
htc - Heat transfer coefficient - W/(m®K)
mh - Maximum element size - m
rad_1 - Bolt radius - m
thb - Thickness - m
whb - Width - m
4 Builtin
4 Mathematical constants
1 " Inf - Infinity
MNaM - Mot a number
MName: . .
eps - Machine epsilon
my_par i - Imaginary unit
Expression: Jj - Imaginary unit

pi-Pi,m

This functionality is also available for other edit fields in the Model Builder.

FIND

To find parameters and variables in the model tree, you can click the Find button
in the Quick Access Toolbar or use the keyboard shortcut Ctrl+F. This opens the

Find window.

[Z, Find X

All | Methods | Advanced
Find: current
Options
[] Exact match
[] Regular expression
[] Case sensitive

Find

Close
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The results of the search are displayed in the Find Results window, as shown in the
figure below, coming from the completed busbar model.

Messages Progress Log | Find Results X

C =1 “current": 10 matches

MNode Type Text

Electric Currents (ec) Mode Electric Currents
Electric Currents (ec) Mode Electric Currents
Current Conservation 1 MNode Current Conservation 1
Current Conservation 1 MNode Current Conservation
Electromagnetic Heating 1 (emh1) Setting Electric Currents (ec)
Stationary Table cell Electric Currents (ec)
Stationary Solver 1 Setting Electric Currents
Electric Currents MNode Electric Currents
Current Density MNode Current Density
Surface 1 Setting Current density norm

You can double-click any of the rows in this window to open the corresponding
Settings window.

Geometry

This section describes how the geometry can be opened from the Application
Libraries. The physics, study, parameters, and geometry are included with the
model file you are about to open.
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I Select Application Libraries [ from the
Windows drop down menu in the Home tab. @1 [
C e Add AddPlot | |Wind
You can also access the Application Libraries Study Groupr | e
from the File menu. %5 Add Physics
i Add Multiphysics
"% Add Study

o1 Add Material from Library

Material Browser

0 [l Application Libraries

Part Libraries

W B

Add-in Libraries
Selection List
Properties
Messages
Debug Log
Table

1 8 [ K E g

External Process

[‘._IJ‘F

Recovery Files

. Comparison Result

2 In the Application Libraries tree
under COMSOL Multiphysics > App“ca‘[ion Libraries
Multiphysics, sclect busbar geom.

(¥ Refresh [§] Update COMSOL Application Libraries %) Application Gallery

To open the file, you can: Search
. 4 @ COMSOL Multiphysics
- Double-click the name b [ Appications
b [l Acoustics
- Right-click and select an option b [} Chemical Engineering
b [l Cluster and Batch Tutorials
from the menu b [ Oiffusion

b [l Electromagnetics
b [l Equation Based

- Click one Ofthe buttons under b [fifi Fluid Dynarmics
the tree o [ Geophysics

b [flff Heat Transfer
b [flfi Meshing Tutorials

You can select No if prompted to 4 [} Muttiphysics
i O busbar_box
save Untitled.mph. 6 ® iz e
® busbar
1 1 1 free_convection
The geometry in this file is [ o
parameterized. In the next few ® thermal actustor o
) . K @ thermal_actuator_simplified
steps, we will experiment with  thermal_controlerrom
. . b [l Structural Mechanics
different values for the width bR Cme e
t bb il
parameter, whb. Run Application Open

@ Open POF Document

Help (€9 Close
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3 Under Global Definitions @, click the

Parameters node

¥ Parameters

In the Settings window for Parameters, Name | Brpression s
. . . L 9em] 0.09 m
click in the Expression column for the rad 1 §{mm] 0.006 m
wbb parameter and enter 10[cm] to tbb 3[mm] 0.005 m
change the value of the busbar width. 6 whb [l Joam
mh B[mm] 0,006 m
4 In the Model Builder, under Component | htc SIWmA2/K] |5 W/(m K
Vtat 20[mV] 0,02V

> Geometry |, click the Form Union node

and then the Build All button in the
Settings window @ to rerun the geometry sequence. You can also use the ribbon
and click Build All from the Geometry group in the Home tab.

Model Builder

—

= =t

4

4 & bushar_geom.mph (root)
4 () Global Definitions

72|

< m
[
4

Fi Parameters 1

2 Materials
Component 1 {comp 1)
= Definitions

WA Geometry 1

b+ & WorkPlane 1 fwp1)
L_,.!, Extrude 1 {ext?)

I & Work Plane 2 {wp2)
L_,.!, Extrude 2 {ext3)

I & WorkPlane 3 (wp3)
L_,.!, Extrude 3 {ext3)
Form Union (fin)

2 Materials

-1

Label: Form Union =

¥ Form Union/assembly
Action:
Form a union -

Repair tolerance:

Automatic -



5 In the Graphics toolbar, click the Zoom Extents button [ to see the wider busbar
in the Graphics window.

Graphics 0

aa @~ 2@ L el

Zoom Extents

wbb = 5cm wbb = 10cm
6 Experiment with the geometry in the Graphics window:

- To rotate the busbar, click and drag the pointer anywhere in the Graphics
window.

- To move it, right-click and drag.
- To zoom in and out, click the scroll wheel, continue holding it, and drag.

- To get back to the original position, click the Go to Default 3D View button .|.
on the toolbar.

Graphics
Qa@- @@ [Bxksls

Go to Default View

7 Return to the Parameters table and
change the value of wbb back to 5[cm].

¥ Parameters

8 In the Model Builder, click the Form Union . Name gE["p'T‘i”” ;;'g“e
. . cm 09 m
node i and then click the Build All button rad 1 §[mm] 0.006 m
e to rerun the geometry sequence. G thb 5[mm] 0005 m
9 On the Graphics toolbar, click the Zoom " o "
mh B[mm] 0,006 m
Extents button [. htc SIW/mA2/K] |5 Wi (mEK)

Vtot 20[mV] 002V
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101f you built the geometry yourself, you are already using the busbar.mph file,
but if you opened the file from the Application Libraries, select Save As from the
File menu and rename the model busbar.mph.

After creating or importing the geometry, it is time to define the materials.
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Materials

The Materials node  stores the material properties for all physics and geometrical
domains in a Component node. The busbar is made of copper and the bolts are
made of a titanium alloy. Both of these materials are available from the Built-In
material database.

| In the Model Builder, right-click Component | > Materials = and select Add
Material from Library . By default, the window will open at the right-hand side
of the desktop. You can move the window by clicking on the window title and
then dragging it to a new location. While dragging the window, you will be
presented with several options for docking.
4 |§ Component1 (comp1)

I = Definitions

b Geometry 1
c i Materials

b X Electric Cul “% Add Material from Library

I {8 Heat Trans| [i] Browse Materials

b iy Multiphysi

A Mesh 1 2= Blank Material

The Materials node will show a red x in the lower-left corner if you try to
solve without first defining a material, which we will go over in the next
few steps.

2 In the Add Material window,
expand the Built-In materials
folder and locate Copper.
Right-click Copper == and select
Add to Component I.

Add Materia TEX
() Add to Global Materials ¥ - Add to Component ~
Search

22 Aluminum
24 Arnerican red oak

Alternatively, you can i# Beryllium copper UNS C17200
double-click. E:;k von
A Copper node is added to the is Concrete
Model Builder. Er?fre;r’ Add to Global Materials
3 In the Add Material window, G g';; {8 Addto Companent 1 (comp)

scroll to Titanium beta-21S in the
Built-In material folder list.
Right-click and select Add to
Component |.

2 High-strength alloy steel
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4 In the Model Builder, collapse the Geometry | node

model.

4 4% busbar.mph (roct)
4 (i) Global Definitions
P Parameters 1
= Materials
4 @ Component1 {compl)
[ = Definitions
‘D YA Geometry 1
4 oo Materials
[ 222 Copper (matl)
[+ 2z8 Titanium beta-215 [mat2)
[ }_ Electric Currents {ecg)
[* | I8 Heat Transfer in Solids (hi)
b e Multiphysics
£ Mesh 1
[+t Study 1

b {E Results

to get an overview of the

At this stage the Materials node may display one or more red x symbols
depending on the active selection. These will disappear in the next few steps.

5 Under the Materials node, click Copper

4 [ Component1 fcomp1)
= Definitions
Y Geornetry 1
4 o= Materials

e I tzs Copper (matl)

I %28 Titanium beta-215 (mat2)

6 In the Settings window for Material, examine the Material Contents section.

T

Property Variable Value
[+ | Electrical conductivity sigma_iso... | 5998e7[5/m]
[# |Heat capacity at constant pressure Cp 3850/ (kg*K)]
[+ | Relative permittivity epsilonr_i... |1
[ | Density rho 8960[kg/m*3]
[ | Thermal conductivity k_iso ; ki, | 400[W/(m*K]]
Relative permeability mur_iso;. |1
Coefficient of thermal expansion alpha_iso... |17e-6[1/K]
Young's modulus E 110e9[Pa]
Poisson's ratio nu 035
Reference resistivity rhoQ 172e-8[chm...
Resistivity temperature coefficient alpha 0.0039[1/K]
Reference temperature Tref 298[K]

Unit
S/m

1 (kgK)
1

kg/m*
W (m-K)
1

17K

Pa

1

Qm
17K

K

Property group

Basic
Basic
Basic
Basic
Basic
Basic
Basic

Young's modulus and Poisson's ratio
Young's modulus and Poisson's ratio
Linearized resistivity
Linearized resistivity

Linearized resistivity

The Material Contents section has useful information about the material
property usage of a model. Properties that are both required by the physics and
available from the material are marked with a green check mark . Properties
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required by the physics but missing in the material are marked with a warning
sign 4. A property that is available but not used in the model is unmarked.

The Coefficient of thermal expansion, Young’s modulus, and Poisson’s ratio
in the table above are not used, but will be needed later when
heat-induced stresses and strains are added to the model.

Because the copper material is added first, by default, all parts have copper
material assigned. In the next step, you will assign titanium properties to the
bolts, which override the copper material assignment for those parts.

7In the Model Builder, click Titanium

4 |§ Component1 (comp1) beta-21$
[ = Definitions
b YA Geometry 1 8Select All Domains from the Selection
4 == Materials list and then click domain 1 in the list.
I 222 Copper (mat1) )
o b sis Titanium beta-21S (mat2) Now remove domain 1 from the
I 3 Electric Currents (c) selection list.
settings " * To remove a domain from the selection
nibl] list (or any geometric entity, such as
Label:  Titanium beta-215 [E| boundaries, edges, or points), you can use

R ) cither of these two methods:
Geometric Entity Selection

-Click domain 1 in the selection list found

Geometric entity level: | Domain - . . : .
_ : in the Settings window for Material. Then,
Selection: | All domains - | . .
; 6 click the Remove from Selection button —
L
2 By = or press Delete on your keyboard.
. 3 = . . . .
Active |4 o ¥ _Alternatively, in the Graphics window,
5 [ . . .
P click domain 1 to remove it from the
7 selection list.

6 The domains 2, 3, 4, 5, 6, and 7 are highlighted in blue.
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You can enable and disable material color and texture from the Color
toolbar button in the Graphics window. To render the copper components
using a realistic color, select Show Material Color and Texture. This will also
enable material-true rendering of other materials. Here, you can also
enable coloring of selections by selecting Show Selection Colors.

-8 FEeclE T 8-
v Show Selection Colors

Show Material Color and Texture

The figures below show the Settings and Graphics windows corresponding
to a selection where a color (pink) other than the default has been used.
There is also a second selection (not shown) with another color (green).

Seﬁ'r‘gs : . Hote W Se@eKlE =A@ @ EH OE ¥y o- &
Explicit

Label: Tibolts =
¥ Input Entities

Geometric entity level: | Domain -

; LS|
on O] FD _

Active

e B oW R
il
=Y

[] All domains

¥ Output Entities

Selected domains =
¥ Color

Color: | - |

Note that to see the color while creating a selection, you need to click the
Suppress Selection Highlight button in the Graphics toolbar. For more
information on Selections, see page 125.

To further increase the level of realism in material rendering you can
enable Environment Reflections from the Scene Light menu button in the
Graphics toolbar. From this menu you can choose an Indoor Environment
or Outdoor Environment.



The corresponding image, known as a skybox image, will be reflected in
the material thereby increasing the level of realism. This is particularly
visible when the material is a metal, as shown in the figure below.

By selecting the Show Skybox option you can display the corresponding
skybox image used for the environment reflection.

For best results you will need a graphics card that supports OpenGL, see also
“Graphics and Plot Windows” on page 13.
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9 In the Settings window

for Material, be sure to Settings M
inspect the Material :
Contents section for the Label: | Titanium beta-215 5

titanium material. All of
the properties used by

Geometric Entity Selection

: Geometric entity level: Domain -
the physics should have a Y
Selection: Manual -
green check mark =.
2 ]
Active 5 ':|':|
G ..
7
Cverride

Material Properties

¥ Material Contents

T

Property Variable Value Unit
5 [ Electrical conductivity sigma_iso ; 5. [7407e5[.. | S/m
G [¥ | Heat capacity at constant pres... Cp TI00/ (ke | (kgeK)
[# | Relative permittivity epsilonr_iso.. |1 1
[ Density rho 4940[kg... |kg/m®
[ Thermal conductivity k_iso ; kil = k.. | T5[W/ L. | W/ (me..
Relative permeability mur_iso; m... |1 1
Coefficient of thermal expansion | alpha_iso ; al...| 7.06e-6[... |1/K
Young's modulus E 105e3[Pa] |Pa
Poisson's ratio nu 0.33 1
10 Close the Add Material window ]
either by clicking the icon in the Add Materia @ B
. . 1. Add to Global Materials Add to Component
upper-right corner or by clicking -
earc

the Add Material toggle button _
. . [+ 225 Recent Materials
i+ in the Materials group of the b [ Material Library
ribbon Home tab. b 3 Built-in

Physics and Boundary Conditions

Next, you will inspect the physics domain settings and set the boundary conditions
for the heat transfer problem and the conduction of the electric current.

In the Model Builder window, examine the default physics nodes of the multiphysics
interface for Joule Heating. First, collapse the Materials node. Then, click the arrows
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next to the Electric Currents x , Heat Transfer in Solids =, and Multiphysics =, nodes
to expand them.

Model Builder ~ ®|| Settings -

=

4

Electromagnetic Heating
4 & busbar.mph (root) . .
4 (@ Global Definitions Label:  Electromagnetic Heating 1 =
Fi Parameters 1 Name:  emhl
2 Materials
4 |§ Component1 (comp1) ¥ Domain Selection
[ = Definitions -
b YA Geometry 1 Selection:  All domains -
I 5z& Materials
4 +\_ Electric Currents {ec) lil
i Current Conservation 1

S Electric Insulation 1

I+

H e

B Initial Values 1
Bl Heat Transfer in Solids (ht)
= Solid 1

B Initial Values 1

[ 8
oo s W o —

G Thermal Insulation 1 - By S

[ 8

iy Multiphysics

Selection:  All boundaries -
% Electromagnetic Heating 1 (emh1)
£ Mesh 1 1 i
[~ Study 1 0= 2 E —
b {8 Results 3 '=|':| A
4 e
5
6
¥ Equation

Show equation assuming:

Study 1, Stationary -

Q.=]-E
The D in the upper-left corner of a node’s icon (#&) means it is a default node.
The equations that are being solved are displayed in the Equation section of the
Settings windows of the respective physics nodes.

The default equation form is inherited from the study added in the Model Wizard.
For the Joule Heating multiphysics interface, the equations are for the temperature
and electric potential.

To always display the equations in the Settings windows, click the Show

More Options button (=) on the Model Builder toolbar and sclect Equation
Sections so that a check mark appears next to it.
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The Heat Transfer in Solids and Electric
Currents nodes have the settings for heat
conduction and current conduction,
respectively.

Under the Electric Currents node, the
Current Conservation node represents the
conservation of electric current at the
domain level and the Electric Insulation
node contains the default boundary
condition for Electric Currents.

Under the Heat Transfer in Solids node,
the domain level Solid node represents the
conservation of heat and the Thermal
Insulation node contains the default
boundary condition for Heat Transfer in
Solids. The heat source for the Joule

4 & busbar.mph (root)
4 () Global Definitions
Fi Parameters 1
2 Materials
4 |§ Component1 (comp1)
[ = Definitions
b Geometry 1
I 5z& Materials
rl +\_ Electric Currents (ec)
i Current Conservation 1
S Electric Insulation 1
B Initial Values 1
4 | I8 Heat Transfer in Solids (ht)
= Solid 1
B Initial Values 1
%= Thermal Insulation 1
- .{;3. Multiphysics
x| Electromagnetic Heating 1 (emh1)
A Mesh 1
[~ Study 1

b {8 Results

heating effect is set in the Electromagnetic Heating node under the Multiphysics
node. The Initial Values node, found in both the Electric Currents and Heat Transfer
in Solids interfaces, contains initial guesses for the nonlinear solver for stationary
problems and initial conditions for time-dependent problems.

Now, define the boundary conditions.

I Right-click the Heat Transfer in Solids node

. In the second section of the

context menu — the boundary = section — select Heat Flux.

I 5z& Materials
4 +\_ Electric Currents {ec)
= Current Conservation 1

S Electric Insulation 1

i Initial Values 1
c 4 |[E Heat Transfer in Solids (ht)
= Solid1 1= Solid
= Initial Values 1 = Fluid
= Th I Insulation 1
s Thermal Insulation B Heat Source

4 5 Multiphysics

x| Electromagnetic Heating 1 I= Initial Values

Domain section

~L—Section divider

Boundary section

£ Mesh 1 Specific Media
[~ Study 1
b [B Results m  Temperature
= Thermal Insulation
m»  Heat Flux
= Symmetry
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2 In the Settings window for Heat Flux,
select All boundaries from the Selection
list.

Assume that the circular bolt
boundaries are neither heated nor
cooled by the surroundings.

In the next step, you will remove the
selection of these boundaries from the
heat flux selection list, which leaves

¥ Boundary Selection

Selection:

o=

Manual

Manual

All boundaries

them with the default Thermal Insulation boundary condition for the Heat

Transfer in Solids interface.

3 Rotate the busbar to view the back. Move the mouse pointer over one of the
circular titanium bolt surfaces to highlight it in green. Click the bolt surface to
remove this boundary selection from the Selection list. Repeat this step to
remove the other two circular bolt surfaces from the selection list. Boundaries

8, 15, and 43 are removed.

Cross-check: Boundaries 8, |15, and 43 are removed from the
Selection list.
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4 In the Settings window for Heat Flux
under Heat Flux, click the Convective
heat flux button. Enter htc in the Heat
transfer coefficient ficld, /.

This parameter was either entered in
the Parameter table in “Global
Definitions” on page 67 or imported
with the geometry.

¥ Heat Flux

! General inward heat flux

o ®  Convective heat flux

qo =h- (Text - T)
Heat transfer coefficient:
User defined -

Heat transfer coefficient:

h hte W/ (m*K)
External temperature:
T et User defined -
293.15[K] K
) Heat rate
P
Go = TU

More advanced boundary conditions for heat transfer analysis are
available with the Heat Transfer Module. Examples include the
capability to give the total deposited power or to set boundary
conditions for common natural convection scenarios such as for a

horizontal or vertical wall.

Continue by setting the boundary conditions for the electric current according

to the following steps:

5 In the Model Builder, right-click the Electric Currents node x . In the second
section of the context menu — the boundary section — select Electric Potential.
An Electric Potential = node is added to the model tree.

T
-
R
lif
i
a4

4 & busbar.mph (root)

(il Global Definitions

F'L Parameters 1 = Current Conservation
£ Default Model Inputs X
‘.- Materials P I&= External Current Density
4 @ Component 1 [comp 1) 1= Force Calculation
b = Definitions =  Piezoresistive Material
b Geometry 1
- = 1= Current Source
I 5z& Materials
4 *_ Electric Currents (ec) = Terminal

i Current Conservation 1 =

S Electric Insulation 1

B Initial Values 1 m  Ground
4 |[E Heat Transfer in Solids (ht) |
= Solid 1

B Initial Values 1
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6 Move the mouse pointer over the circular face of the single titanium bolt to
highlight it and then click to add it (boundary 43) to the Selection list.

Q

7 In the Settings window for Electric
Potential, cnter Vtot in the Electric v Electric Potential
potential field. Electric potential:

. Vo Viot
The last step is to set the surfaces of the o = Y

two remaining bolts to ground.

8 In the Model Builder, right-click the Electric Currents node = . In the boundary
section of the context menu, select Ground. A Ground node = is added to the
model tree. The model tree node sequence should now match this figure.

4 }_ Electric Currents {ec)

= Current Conservation 1

G Electric Insulation 1

= Initial Values 1

mw Electric Potential 1

¥y Ground 1 6
4 |[E Heat Transfer in Solids (ht)

= Solid 1

= Initial Values 1

S Thermal Insulation 1

o Heat Flux 1
4 .;"g‘j, Multiphysics

“‘c_ Electromagnetic Heating 1 {femh 1)

The “warning” attribute displayed on the Ground node indicates that its
boundary selection is empty. The next step will be to select boundaries.
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9 In the Graphics window, click one of the remaining bolts to add it to the
Selection list.

Q Cross-check: Boundaries 8 and 5.

0.05

I5

Repeat this step to add the last bolt. Boundaries 8 and 15 are added to the
selection list for the Ground boundary condition.

10 On the Graphics toolbar, click the Go to Default View button ...

Graphics
Qa@- @@ B

Go to Default View

More advanced boundary conditions for electromagnetics analysis are
available with the AC/DC Module, such as the capability to give the total

current on a boundary.

COMBINING PHYSICS INTERFACES MANUALLY

As an alternative to using the preconfigured Joule Heating multiphysics interface,
you can manually combine the Electric Currents and Heat Transfer in Solids
interfaces. For example, you can start by setting up and solving the model for

86 |



Electric Currents and then subsequently add Heat Transfer in Solids. In that case,
you right-click the Multiphysics node to add the required multiphysics couplings.

4 +\_ Electric Currents {ec)
i Current Conservation 1
S Electric Insulation 1
B Initial Values 1
mw Electric Potential 1
= Ground 1
4 | I8 Heat Transfer in Solids (ht)
= Solid 1
B Initial Values 1
%= Thermal Insulation 1
mw Heat Flux 1
-ﬁ} Multinherics
A5 Meg i Equilibrium Discharge Heat Source
b g Study 1| T

b {8 Results

Thermoelectric Effect

Electromagnetic Heating

Equilibrium Discharge Boundary Heat Source

- =

Help

As an alternative, you can click the Add Multiphysics button in the Physics tab in the

ribbon and select a suggested multiphysics coupling in the Add Multiphysics
window.

) : Add Multiphysics R
R 2 s ’
Heat Transferin  Add Add + Add to Component
Solids (ht) = Physics Multiphysics
Physics

4 (0 Recently Used
X Joule Heating
4 % AC/DC
4 %)\ Electrornagnetic Heating
X Joule Heating
el Heat Transfer
4 %)\ Electrornagnetic Heating
_ X Joule Heating
Thermoelectric Effect

I &) Plasma

Select the physics interfaces you want to couple

Physics Couple
x_|Electric Currents (ec) [
[El| Heat Transfer in Solids (ht) [

Multiphysics couplings in study

Studies Solve
Study 1 =
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Mesh

The simplest way to mesh is to create an unstructured tetrahedral mesh, which is
perfect for the busbar model. Alternatively, you can create several meshing
sequences, as shown in “Adding Meshes” on page 119.
A physics-controlled mesh is created by default. In most cases, it is possible
to skip to the Study node and just solve the model. For this exercise, the
settings are investigated in order to parameterize the mesh settings.

I In the Model Builder, click the Mesh 1
node 4 . In the Settings window for
Mesh, sclect User-controlled mesh from i

. 1 Physics-controlled mesh -
the Sequence type list. c

User-controlled mesh
2 Under Mesh 1, click the Size node ]

¥ Mesh Settings

Sequence type:

Physics-controlled mesh

4 /A Meshl

6 2% Size

Free Tetrahedral 1

3 In the Settings window for Size, in
the Element Size section, click the

S
Custom button. 2

e

[

Settings

Build Selected [§ Build All
Under Element Size Parameters,
enter:

Label: Size E

. . . Element Size
- mh in the Maximum element size

field. Note that mh is 3 mm — the Calibrate for:
value entered earlier as a global Evael pipEe -
parameter. By using the parameter e

O Predefined Maormal

mh, element sizes are limited by ¥ Custom
this value. ¥ Element Size Parameters
- mh-mh/3 in the Minimum element Maximum element size:
size field. The Minimum element mh m

Minimum element size:

mh-mhy/3 m

size is slightly smaller than the

maximum size.
. Maximum element growth rate:
- 0.2 in the Curvature factor ficld. 13
The Curvature factor determines T e
0.2
Resolution of narrow regions:

0.5
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the number of elements on curved boundaries; A lower value gives a finer
mesh.

The other two parameters are left unchanged.

The Maximum element growth rate dctermines how fast the elements should
grow from small to large over a domain. The larger this value is, the larger the
growth rate. A value of 1 does not give any growth.

For Resolution of narrow regions, a higher value will generally result in a finer
mesh.

The asterisk (*) that displays in the upper-right corner of the Size node
indicates that the node is being edited.

Click the Build All button = in the Settings window for Size to create the mesh,
as in this figure:

You can also click Build Mesh in the Home tab of the ribbon.
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Study

I To run a simulation, in the Model
Builder, right-click Study I -~ and
choose Compute = . You can also
press E8 or click Compute in the
ribbon Home tab.

The Study node - automatically
defines a solution sequence for the
simulation based on the selected
physics and study type. In this case,
the simulation only takes a few

c [+~ Study 1

I {8 Results

Free Tetrahedral 1

F8
F5

Compute

Update Solution
Parametric Sweep
Function Sweep
Material Sweep
Study Reference

Combine Solutions

seconds to solve. During the solution process, two Convergence plots are generated
and are available from tabs next to the Graphics window. These plots show the
convergence progress of the different solver algorithms engaged by the Study.

Results

By default, in the Results node, three plot groups are
generated: a Multislice plot of the Electric Potential, a
Surface plot of the Temperature, and a plot named
Isothermal Contours containing an Isosurface plot of
the temperature.

Click Results > Temperature @ to view the
Temperature plot in the Graphics window. The
temperature difference in the device is less than 10 K
due to the high thermal conductivity of copper and
titanium. The temperature variations are largest in
the top bolt, which conducts double the amount of
current compared to the two lower bolts. The
temperature is substantially higher than the ambient
temperature of 293 K.
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B Tables
4 | Electric Potential {ec)
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4 |l Temperature (ht)
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I Click and drag the image in the Graphics window to rotate and view the back of
the busbar.

2 In the Graphics toolbar, click the Go to Default 3D View button .|..

You can now manually set the color table range to visualize the temperature
difference in the copper part.

3 In the model tree, expand the Results > Temperature node @ and click the
Surface node ™.

4 In the Settings window for Surface, click Range to expand the section. Select the
Manual color range check box and enter 324 in the Maximum field (keep the
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default for Minimum and replace the default for Maximum). Click the Plot button

a in the Settings window for Surface.

Settings -
Surface
G [ Plot
Label: Surface =
Data
Expression =i~ %~
Title
~ Range

Manual color range
Minimum:  322.39376

Maximum: 324
5 On the Graphics toolbar, click the Zoom Extents button & to view the updated

plot.
6 Click and drag in the Graphics window to rotate the busbar and view the back.

L Surtace: Temparatute (0 a
324

The temperature distribution is laterally symmetric with a vertical mirror plane
running between the two lower titanium bolts and cutting through the center of
the upper bolt. In this case, the model does not require much computing power
and you can model the entire geometry. For more complex models, you can
consider using symmetries to reduce the computational requirements.

Select Go to Default View on the toolbar in the Graphics window -L-.

Then, generate a Surface plot that shows the current density in the device.
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I In the Model Builder, right-click Results
@ and add a 3D Plot Group w. In the

VB Electric Potential (ec)
VB Temperature (ht)

. #
Label field enter Current Density to », " W lsothermal Contaurs (t)
. .. \l 3D Plot Group 4
give the plot group a descriptive name. Export Plot
Right-click 3D Plot Group 4 w and add a [ Reports Plot In
Surface node ™. B volume
= Arrow Volume
™ Surface
W slice
2 In the Settings window for Surface under _
. i . 4 Electric Currents
Expression, click the Replace Expression 4 Currents and charge
button . GO to Model > COmponent 1 > G ec.n) - Mormal current density - A/m® )
. .norml - Current densi - A
Electric Currents > Currents and charge > e —rE———
A 3 ec.rhog - Space charge density - C/m
ec.norm) - Current density norm - A/m” and ec.rthogs - Surface charge density - C/m®

double-click or press Enter to select.

ec.normd is the variable for the

magnitude, or absolute value, of the v Expression = %~
current density vector. You can also Expression:

type ec.normd in the Expression ficld G ec.norm)

when you know the variable name or, Unit

alternatively, use the auto completion Alm*2 v
functionality by typing norm and then [ Description:

pressing Ctrl+Space to get a variable Current density norm

name suggestion.

3 Click the Plot button @ .

The plot that displays in the Graphics window is almost uniform in color due to
the high current density at the contact edges with the bolts. The next step is to
manually change the color table range to visualize the current density
distribution.

4 In the Settings window for Surface under Range, sclect the Manual color range
check box. Enter 1e6 in the Maximum ficld and replace the default.

¥ Range

o Manual color range

Minimum: 019079

Maximum:  Te6

|93



5 Click the Plot button = .

The resulting plot shows that the current takes the shortest path in the
90-degree bend in the busbar. Notice that the edges of the busbar outside of
the bolts are hardly carrying any current.

Surface: Curment dansity norm LA’}

6 Click and drag the busbar in the Graphics window to view the back. Continue
rotating the image to sce the high current density around the contact surfaces
of each of the bolts.

a1

z

'

Lex
=y

When you are done, click the Go to Default View button ... on the Graphics toolbar.
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GETTING THE MAXIMUM AND MINIMUM TEMPERATURE

You can easily obtain the maximum and minimum temperature values in the
busbar, including their locations.

I Right-click Results > Temperature @ and select More Plots > Max/Min Volume.

4 |§ Component1 (comp1)

b = Definitions G
WA Geometry 1

== Materials Sz Scatter Volume
+\_ Electric Currents {ec)

| Principal Stress Volume
Bl Heat Transfer in Solids (ht)

iy Multiphysics %) Coordinate System Volume

A5 Mesh 1 Max,/Min Volume
Study 1 Poincaré Map

|
|
|
|
|
|
[~
4 ([ Results
! Datasets Radiation Pattern
£ Derived Values
B Tables
I\l Electric Potential (ec)

4 | Temperature (ht)

Principal Stress Surface
Coordinate System Surface

Mazx/Min Surface

ﬁé"@%%a% ﬂ-@'ﬁ%mae P

™ Surface Plot F8 Multislice
: :_E léztr:;;”;;:;t:tm Plot In D Streamline Surface
Export Volume Surface 5lit
[# Reports =] Arrow Volume Layered Material Slice
™ surface Principal Stress Line
W Slice Coordinate System Line
¥ lsosurface Max/Min Line
—+| Arrow Surface Whirl
‘4 Image i Point
T Line :I: Arrow Point
S Contour -5!;.\ Mazx/Min Point
3F  Streamline 7 Point Trajectories
:j Arrow Line HE Ray Trajectories
2. Particle Trajectories s, Particle Tracing
[E  Mesh ,°n°2 Particle Tracing with Mass
] Annotation ﬁl Waterfall
More Plats v | 7 Table Annotation

2 In the Settings window for Max/Min Volume under Expression, click the Replace
Expression button % . Go to Model > Component | > Heat Transfer in Solids >
Temperature > T - Temperature - K and double-click or press Enter to select. You
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can also search for Temperature in the search field above the tree of
postprocessing variables or manually enter T. Click Plot.

Settings -
olume
Plot
Label:  Max/Min Volume 1 _@
~ Data
Dataset: | From parent ~] [&]

~ Expression

=H- %~

Type filter text

Expression:
v b Materials
Unit b Mesh
4 Compenent 1

v I Definitions
[[]  Description: I Geometry
Electric potential b Electric Currents

: 4 Heat Transfer in Solids

Title
I» Advanced
~ Coloring and Style
Color: | Black

Background color: | None

[] Show frame

I Ambient data
Domain fluxes
Energy
Global
Heat sources
Material properties
Temperature
T - Temperature - K
ht.Trho - Temperature for density evaluation - K
b Temperature gradient - K/m

(S

©

ht.gradTmag - Temperature gradient magnitude - K/m
I Velocity and pressure

Double-click or press Enter to add selected expression.

The maximum and minimum values are plotted in the Graphics window and
their locations and values are displayed in the Maximum and minimum values
table. The values may vary a bit depending on the version you are running. For
a finer mesh the results will be the same regardless of version.

- R EEeEEdo-a

Wertscn: Tamperaturs (K} Mia/Min Vekomen Tamperstues (K}

Progust Loy s




As an alternative to the method of plotting the maximum and minimum values
described above, you can use the Derived Values node or an Evaluation Group for a
pure numerical output. The following steps show how to use Derived Values.

3 In the Results section of the model tree, right-click the Derived Values :: node
and select Maximum > Volume Maximum ns.

4 In the Settings window for Yolume Maximum, under Selection, choose All
domains.

5 In the first row of the Expression table, enter T (unless it is automatically filled
out) for the temperature and click Evaluate at the top of the Settings window.

Model Builder v Se
— s =t EL

4 & busbar_93.mph (root)
I () Global Definitions

=
=
]
(%3]
L
-

4

4 @ Component 1 [comp 1) Label:  Volume Maximum 1 =
[ = Definitions
WA Geometry 1 v Data
i Materials Dataset:  Study 1/Selution 1 (sol1) - Z

Bl Heat Transfer in Solids (ht)

iy Multiphysics

|
|
[ +\_ Electric Currents {ec)
: ¥ Selection

b A Mesh 1 Selection: Al domains -
[~ Study 1

4 ([ Results
[ Datasets

4 £ Derived Values

E=lim
|

max Volume Maximum 1
B Tables
VB Electric Potential (ec)
4 B Temperature (ht)
™ Surface ~ Expressions =
25 Max/Min Velume 1

oo s W o —
i

* "

I Nig lsothermal C?ntours (ht) Expression Unit Description

I §@ Current Density ‘- ; T K Temperature
Export

[# Reports

The resulting maximum temperature is shown in Table 1.

Messages Progress Log Table1

el e R T N =

Temperature (K} '
33042 G

As a next step, you can create a model thumbnail image.
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CREATING MODEL IMAGES FROM PLOTS

With any solution, you can create an image to display when browsing for model
files. After generating a plot, click the corresponding plot node in the Model
Builder under Results. Then, click the root node (the first node in the model tree).
In the Settings window for the root node, under Thumbnail, click Set from Graphics
Window.

There are two other ways to create images from a plot. One is to click the

Image Snapshot button @ in the Graphics window toolbar to directly create an
image. You can also add an Image node & to the Export node to create an image
file. Right-click the plot group of interest and then select Add Image to Export.

You can use the Image Snapshot button to export Results visualizations to
glTE™ (file extension .glb). These files can then be opened in 3D
visualization software such as Paint 3D from Microsoft®, as shown in the
figure below. (If you are running Windows® 10, then this may be
available in your system.) You can also find gl TEF™ viewers online that run
in web browsers.

Make sure to save the model at this stage. This version of the model,
busbar.mph, is reused and renamed during the next set of tutorials.

Building an Application with the Application Builder

This section gives a brief introduction to creating an application based on the
busbar model by using the Application Builder. The application will have a
specialized user interface dedicated to interact with the busbar model and include
input fields for the length, width, and applied voltage. The outputs will be the
maximum temperature and a temperature plot.
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You will learn how to use the Form wizard to quickly create an application. The
Form wizard is used to create a form with user interface components called form
objects. The wizard gives quick access to a subset of all of the form objects
available for creating applications with the Application Builder. In this example,
you will learn how to add input fields, numerical output, graphics, and buttons.
For detailed information on building applications, see the book Introduction to
Application Builder.

CREATING A NEW FORM

I To switch from the Model Builder to the Application Builder, click the
Application Builder button in the leftmost part of the Home tab in the ribbon.

File Home  Definitions  Geometry

Application Component Add
Builder 1~ Component =
Application Model

'
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2 To create a new form, click the New Form button in the ribbon. This will create
a new global form.

> —
]
Model = MNew MNew
Builder Form - Method ~

©

In the Select Template page of the wizard, select Basic.

Select Template

Blank form

Bl Ribbon. sections, and graphics

I Ribbon, koga, sectians, and graphics
B Mibbon. tabs. and graphics

Tl Toolbar, sections and graphics
W Buttons sections. and graphics

Bl Compact layout for tablets

Ml Advanced compact layout for tablets
B Compact layout for smartphones

Tl Advanced compact Layout for smartphanes

OCmu
|7 B0 Q Concel Done

Click Content to continue.
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The Select Content page appears.

a - q e

[ I
Select Content Preview

Formtale  Fom 1 Labels 2 top

Feam ram e fomil

INuAs/outpUts  Graphics  Bubieen
Avplable selectes
4 @ Model (root)
Glokal Definitions
Earameters |
Lengih (L)
Eon radiug (1T}
Thickness {tbb}
* Width iwbb)
M "
Heal bansles e
Apphed voRage (ot
4 {8 Results
4 i Derived Values
shurere Maimearm |
4 M Tbles
8] Maximum and Mesenum Values
[ Tablet

3 wempate
Help e Cancel [ Dore

It consists of three tabs for Inputs/outputs, Graphics, and Buttons. In the
Inputs/outputs tab, you can double-click the nodes in the tree to make these
available in the user interface of the application. For this application, we will
select a few of the parameters as input fields and the maximum temperature as
output.
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3 Double-click each of the parameters: Length (L), Width (wbb), and Applied
voltage (Vtot). Also, double-click the Volume Maximum under Derived Values.

° I NERRA

T e
Select Content

Form it Form 1 ] Labets on top
Form name:  form!

Inputsieutpats  Graphucs | Buttans

Zvailable

4 @& Modd froct)
+ () Ghebal Definitions

Mauemum element size {mih]
Heet transfer coefficient (hac)
4 oM Results
o BB Tbbes
B Masenum and Minimsm Vilues
W Tk

D) Termeiae
|7 B Q[lnlrl [+ pone

Selected:
4 @ Model {root)

4 ([ Global Definitions

4 7 Pararnetes |

“ B Results
4 B Derived Vahots
was Wilurme Mazirsum |

Preview

Lersgthe g em
Wadthe 5 m
Apphed voltage: 30 e

Tempersture  DOMZISK

The Preview section to the right displays the user interface layout.
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4 Click the Graphics tab in the wizard and double-click the Temperature plot. A
graphics object placeholder appears in the Preview area.

° Ne@a-r
| e
Select Content

Fomttle  Form 1 [ Lakels on tep

Feam rame form1
Inputs/mtputs  Graphics  Bubteen
Avwlable
4 & Model root)
+ @ Component 1 (campl)
4, Geomwtey |
A Mesh 1
4 [ Fesults
W@ Electric Potential fec)
Nl Iscehermal Contours ()
W Curent Denciny

Q) remplste
B Help e Cancdl E‘/n.:m

Selectes

4 & Mode (roct)
4 B Resuhts
W Temperature (ht)

Preview
Length: 9
Width: 5

Apphed vollage: 20
Tempersture 0001235 K

aaq
ea

buibaenph - COMSOL Mulliphyiies

5 Click the Buttons tab in the wizard and double-click Compute Study 1. A button
now appears in the Preview areca beneath the graphics object.

° NERR -
T ime
Select Content

Formititie  Form 1 (] Labels on top

Form name:  form]
bputsoulpuls | Graphacs  Buttons
Evailakie:

O 5U8 Commands
< 0 Madd (roct)

# [ Component | (compl)
4, Pt Georsetey 1
A Plot Mesh 1

4@

s
Nl Plot Elestric Potensial (E¢)
Wl Plot Termgerature (H)

W Plot lsothermal Conteurs (Hi)
i Plot Current Densy

Q) Temple
Help e Corcel E’ Done

Selected:
“ G Model {root)
“= Compute Study 1

Preview
Length: 9
Width: 5

Apphed vollage: 20
Ternpersture: [leFELY
aaqa-

Lol

bunbarsnph - COMSOL Mulliphyiies

Campute

| 103



6 Finally, click Done to accept the settings and close the wizard.

After closing the Form wizard, the Form editor is opened. The Form editor allows
you to drag-and-drop form objects and add new ones.

@ " 2w RE-
N o o
o [ Diata Aecest Settinge - Grid -— Wl
L E S B
= Record Methed | D iditor Tacks LT Shetch
Model New  New M Inzert Show Ord Amange
Duilder Faem - Methed - [ Compiler Object - Lines -

vy [Efrese x
x
Length: % o
= Themnes Wigth: 3 om
Main Window Applied voitage: 20 m
a B Forms
- Te g ADNA5K
R empersture DO12IS K
¥ Feente
= Oeclest
T Methods 8,8 8« Lo lx 3
T Libraries e-BEED @

Lomgue

7 You can, for example, rearrange the user interface by dragging the graphics
object to the right of the input fields and the button directly under the input
fields, as shown in the figure below. Blue guidelines will aid you in aligning the

objects.

Prevaew »®
L
Length: L om aa@-F L=l N t-BEED @
Width: 5 m
Applied veltage: 20 m

Temperature Q001235 K

You can make the graphics object larger by dragging the blue handles.
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8 You can test the application by clicking Test Application in the ribbon.

o

> E '\_’_/‘
Test Preview Testin Web
Application Form  Browser -

Test

Alternatively, you can click the corresponding button in the Quick Access
Toolbar.

This creates a run-time copy of the application and lets you quickly try different
designs during the process of developing an application.

a Untitled enph - P

Busibar Geametry a x

Lengeh: 4 em @0 ML bl
Wickh: 5 cm

e - @EE@E0D s

Surface; Temperature (K} MaMin Volume: Temperature (K]
Applied voltage: 20 my o

Temperature 304K 0.02 324

0.1

Compute

330,408
0.05

"fx

9 Now, try a different Length value and click Compute.

ADDING A BUTTON

You may wish to preview the geometry before starting the computation. This can
easily be done by adding a button. There are two ways to add button. Either use
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the Insert Object menu in the ribbon, as shown in the figure below, or use the
Editor Tools window. In this example, you will use the latter.

’. D . " Data Access E’
E.Record Method EditorTooIs
Insert
Object ~

Model  Mew

Builder Form - Method (&3 Compiler
Input is
1 Input Field [2¥] Button [El Toggle Button
[ Check Box Combo Box
Labels
[T] Text Label [ Unit [24] Equation
— Line
Display
Data Display [5] Graphics [5=] Web Page
[#] Image O Video == Progress Bar
[ Log [ Message Log Results Table
Subforms
E‘Form [ Form Collection Card Stack
Compaosite
= File Import Information Card Stack El}\rray Input
8 Radic Button i Selection Input
Miscellaneous
[T] Text 5 List Box EEE Table
=¥ Slider @ Knob T Hyperlink
i Toolbar Spacer

I First, make sure the Editor Tools window is visible by selecting the
corresponding button in the ribbon.

’. D . " Data Access
E.Record Method Edi‘torTooIs 0

Model  Mew MNew

Builder Form » Method + [ Compiler

Main
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2 In the Editor Tools tree, right-click the Geometry node and select Button.

Settings Editor Tools X At
=g Edit Node =

% Themes

D Main Window
b B Forms
I @ GUI Commands
b [ Libraries
4 & Model (root)

I () Global Definitions

4 |§ Component 1 (comp1)

[ = Definitions
\\ Geometry 1

= Materials Graphics

b

b

[+ ®=_ Electric C = Brisn G
3 Heat Tran —_—

b

b

+

Multiphys ¢ Edit Node
Mesh 1

Pis @

3 Drag the Geometry button to the left of the Compute button.

Behind each button is a command sequence that controls the action taken when
it is pressed. The command sequence is defined in the Settings window of the
button and you can open the Settings window (if not already opened) by
double-clicking the button.
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4 Double-click the Geometry button to sce its Settings window. Command
sequences appear below the tree in the section Choose Commands to Run.

Settings X Editor Toals -n

Name: button2 5]
Text: Geometry

lcon: geometry 32png v+ B
Size: Large =
Style: Flat =
Tooltip:

Keyboard shortcut:
~ Choose Commands to Run &

b [ Forms
» @ GUI Commands
b [l Libraries
4 & Model (root)
([l Global Definitions
4 @ Component 1 {comp1)
= Definitions
4 YA Geometry 1
» & Work Plane 1 {wp1)
[EL Extrude 1 (ext1)
b & Work Plane 2 (wp2)

Edit Node Run Plot Set Value Show

Show as Dialog 1 Import File () Enable (1 Disable
"
Command Icon Arguments

Plot Geometry 1 graphics! o

&

In this case, the command sequence for the Geometry has one command for
plotting the geometry. The input argument contains information on which
graphics window to send the geometry plot, in this case, the graphics object

graphicsi.
To automatically adjust the axis settings, you can add a Zoom Extents command.

5 In the Choose Commands to Run section, locate the Zoom Extents command

under GUI Commands > Graphics Commands. Double click to add it to the
command sequence.

6 Now, create the input argument to the Zoom Extents command. Click the white
field next to Zoom extents and click the Edit Argument button.

"
Command lcon  Arguments
Plot Geometry 1 graphicsl
Zoom etents —l 6

tiEaE-@ (6]



7 This opens a dialog box with possible input arguments. Select graphics| under
forml.

3 Edit Argument X

4 |l Forms

- D form1
graphics1 e

E‘ Use as Argument

Selected argument:

[ graphicsl
oK Cancel

8 The command sequence is now complete.

"
Command lcon  Arguments

Plot Geometry 1 graphics1

Zoom extents form1/graphics1 G

9 To make sure the new Geometry button works, you can test the application again
by clicking Test Application in the ribbon.

USING FORMS IN THE MODEL BUILDER

Forms without graphics form objects can be used in the Model Builder. You can
use this functionality to create customized Settings windows for common or
repetitive tasks, for example. If you would like to reuse your customized Settings
window between sessions or even with other users, you can create an add-in, as
explained in the Introduction to Application Builder.
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To use a form, created with the Application Builder, right-click Global Definitions
and select the form under Settings Forms.

4 & busbar.mph (root)
4 S. Global Definitinns

P Parar Pi Parameters

>
& Defay oo Variables
= Mate| .
b @ Compon Functions r
bnd Study 1 Geometry Parts 3
4 @' Results Mesh Parts r
[» i Datas
4 3 Derivi v Default Model Inputs
M V) Materials r
I B Table
b g Elects Load and Constraint Groups 3
b Wi Temp Thermedynamics 3
b N lsoth
TE *° 5': Cosimulation for Simulink
I i@ Curre
Expo Settings Forms 3 D form1
Ri =
i Show More Options...
& P

METHODS

To perform a more advanced operation than what is possible with a command
sequence, you can use the Method editor to write code that defines the actions to
be taken when the user clicks a button, selects a menu item, etc. In addition to
calling methods from applications or Settings Forms, you can call methods from
the Developer tab in the ribbon or from Method Calls in the model tree. For more
information, see Introduction to Application Builder.

An easy way to get started with the Method editor is to convert an existing
command sequence into a method.

I Locate or open the Settings window for the Geometry button again. Click the
Convert to Method button below the command sequence (the other two options
are for creating two types of local methods).

Convert to Method

Convert to Form Method
45| Convert to Local Method
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2 To open the method in the Method editor, click the Go to Method button below
the command sequence.

"
Command lcon  Arguments
method1 B

@51
X | Go to Method
Dialog Actic

The Method editor now opens with the code for methodl, corresponding to the
Plot Geometry and the Zoom Extents commands in the previous command
sequence.

App ication Bui d»’:-[’ * 1 @Preview Dform‘l method] X

o 1=y useGerr’:ic:(model.compon?nt('-:c1'p'_' }.geom("geoml"), “"graphics1");
= zoomExtents("forml/graphics1");

4 [&] busbar.mph [root) |
E Inputs
% Themes

D Main Window
4 B Forms
D form1

Events
= Declarations

4 [ Methods G
method1

b [ Libraries

The Application Builder has several tools for automatically generating code. In
addition to converting a command sequence to a method, you can, for example,
click Record Code in the ribbon.

= [ 5

Goto Record Use
Node Code Shortcut

Code

This will generate code for each operation performed in the COMSOL Desktop
windows. Click Stop Recording in the ribbon to stop recording and go back to the
Method editor.

To learn more about using the Form editor and the Method editor, see the book
Introduction to Application Builder, which provides more information on
writing methods. For more in-depth information on methods, see the
Application Programming Guide.



This completes the busbar example. To switch back to the Model Builder, click
the Model Builder button in the ribbon.

File Home

o

Model  Mew
Builder Form -

The next sections are designed to deepen your understanding of the steps
implemented so far and to extend your simulation to include additional effects like
thermal expansion and fluid flow. These additional topics begin on the following

pages:
+ “Parameters, Functions, Variables, and Couplings” on page 113
e “Material Properties and Material Libraries” on page 117

+ “Adding Meshes” on page 119

* “Adding Physics” on page 122

e “Parametric Sweeps” on page 144

« “Parallel Computing” on page 155

+ “COMSOL Multiphysics Client-Server” on page 159

o “Appendix A — Building a Geometry” on page 162
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Advanced Topics

Parameters, Functions, Variables, and Couplings

This section explores working with parameters, functions, variables, and nonlocal
couplings.

The Global Definitions and Component > Definitions nodes contain functionality
that helps you to prepare model inputs and nonlocal couplings and organize
simulations. You have already used the functionality for adding parameters to
organize model inputs in “Global Definitions” on page 67.

Functions, available as both Global Definitions and Component > Definitions,
contain a set of predefined function templates that can be useful when setting up
multiphysics simulations. For example, the Step function template can create a
smooth step function for defining different types of spatial or temporal transitions.

To illustrate using functions, assume that you want to add a time-dependent study
to the busbar model, where an electric potential is applied across the busbar that
goes from 0 V to 20 mV in 0.5 seconds. For this purpose, you could use a step
function to be multiplied with the parameter Vtot. In this section, you will add a
step function to the model that goes smoothly from 0 to 1 in 0.5 seconds to find
out how functions can be defined and verified.

DEFINING FUNCTIONS

For this section, you can continue working with the same model file created in the
previous section. Locate and open the file busbar.mph if it is not already open on
the desktop.
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I Right-click the Global Definitions node @ and select Functions > Step I .

4 % busbar.mph (root)
4 (7 Global Definitions

Fi Parameters 1 Pi  Parameters
45 Default Model Inputs . .
Material 2= Variables
I @ Componen| % Analytic Functions »
=] =0 .
l: & :::I)l‘;: 2= Interpolation Geometry Parts v
Dataset * Piecewise Mesh Parts v
- A -
3 - Derived /. Gaussian Pulse v Default Model Inputs
[ Tables | —
b Wi Electric : Ramp Materials r
Il Rectangl
b Nl Temper SaEgs Load and Constraint Groups 3
5 I st
b TE Isother ED Thermodynamics r
b N Current M Triangle X X X X
Export _ f': Cosimulation for Simulink
[# Reports M Waveform — -
P . = Show More Options...
.'W\' Random
= MNode G
External E" odebroup
= G by T
G MATLAB e YA Y e
& . ?
%) Elevation (DEM) e A

4 Image

ﬂ?‘l Function Switch

2 In the Settings window for Step, enter 0.25 in the Location field to set the
location of the middle of the step, where it has the value of 0.5.

Plot| E& Create Plot

Label: Ral(s) Step 1 E

Function name:  stepl

~ Parameters

Location: 0.25
From: 0
To: 1
* Smoothing

Size of transition zone: 0.5

Number of continuous derivatives: | 2 -

3 Click Smoothing to expand the section and enter 0.5 in the Size of transition zone
field to set the width of the smoothing interval. Keep the default Number of
continuous derivatives at 2.

4 Click the Plot button @ in the Settings window for Step.
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If your plot matches the one below, this confirms that you have defined the

function correctly.

O -

LR

04F

0.3

Lo

0.1

You can also add comments to the function to make it more descriptive.

0.3 0.4

0.5

0

o7

0.8

5 Right-click the Step | node I in the Model Builder and sclect Properties [5.

4 & busbar.mph (root)
4 () Global Definitions
Fi Parameters 1

_[” Step 1 (step1)
45 Default Model
i Materials
I @ Compenent 1 (con
[~ Study 1
4 ([ Results
I E Datasets
I &5 Derived Values
I E Tables
I N Electric Potenti
I Nl Temperature (H
I N lsothermal Cor
I N Current Density
Export

Copy as Code to Clipboard

Copy

Duplicate Ctrl+Shift+D
Group Ctrl+G
Delete Del

Disable F3

Rename F2

Settings

Properties

Help F1

[# Reports
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6 In the Properties window,

enter any information you Settings  Properties X .
want. Right-click the Step
Properties tab and sclect Label: Step 1
Close when you are Name: stepl
Tag: stepl

finished. Special characters
and markup tags that you G' Node Properties

use here will be displayed Created:  Sep 14, 2020 3:38:21 PM
in reports generated from Author.  COMSOL
the Reports node. Version: Version 1.0 of this model

Comments | § E C € C X X X @ X X2 rromw
Created for the Introduction to COMSOL Multiphysics.

o B el Mo Ltk LpveE
omTpPCTCTUOLO O LY OT A
OAEZEONEZYPYPYO - — - ¢

¥ Used Products

COMSOL Multiphysics

For the purpose of this exercise, assume that you want to introduce a second
component to represent an electric device connected to the busbar through the
titanium bolts.

First, rename Component | to specify that it represents the busbar.
I Right-click the Component | node m and sclect Rename =} (or press F2).

2 In the Rename Component window, enter Busbar. Click OK and save the model.

4 G busbar.mph (root)
b () Global Definitions

6 [ [§ Busbar {compi)
[+t Study 1

b {E Results
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DEFINING NONLOCAL COUPLINGS AND PROBES

Bl Heat Transfer in Solids (ht)
iy Multiphysics

Right-click the Definitions node = under Busbar 4 % busbar.mph (root
(compl) to introduce a nonlocal coupling that 4 (@) Global Definitions
: Fi Parameters 1
computes the integral of any BusI.Jar (compl) . o orblee
variable at the bolt boundaries facing the electric I Step 1 (step1)
device. You can use such a coupling, for @ Default Model Inputs
l d f . bl . v . bl Cl Materials
example, to define a variable in a Variables node 4 [ Busbar (comp )
under the Global Definitions node that calculates 4 = Definitions
the total current. This variable is then globally b Selections
. Jdu Integration 1 {intop 1)
accessible and could, for example, form a 1] Boundary System 1 (sys)
boundary condition for the current that is fed to b [L] View1
. . A Geometry 1
an electric device modeled as a second b s Materials
Component. — I +\_ Electric Currents [ec)
[
[

The Nonlocal Couplings in Definitions have a wide

range of uses. The Average -, Maximum w« and b A Mesh1
Minimum «~ couplings have applications in P Sy
b {8 Results

generating results as well as in boundary

conditions, sources, sinks, properties, or any

other contribution to the model equations. The Probes # are for monitoring the
solution progress. For instance, you can follow the solution at a critical point
during a time-dependent simulation or for each parameter value in a parametric
study.

You can find an example of using the average operator in “Parametric Sweeps” on
page 144. Also see “Functions” on page 190 for a list of available functions.

To learn more about working with definitions, in the Model Builder, click the
Definitions = or Global Definitions @ node and press F1 to open the Help
window @ . This window displays helpful information about the selected
item in the desktop and provides links to the documentation. It could take
up to a minute for the window to load the first time it is activated, but will

load quickly the next time it is opened.

Material Properties and Material Libraries

You have already used the functionality in the Materials node to access the
properties of copper and titanium in the busbar model. In the Materials node, you
are also able to define your own materials and save them in your material library.
In addition, you can add material properties to existing materials. In cases where
you define properties that are functions of other variables, typically temperature,
the plot functionality helps you to verify the property functions in the range of
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interest. You can also load Excel® spreadsheets and define interpolation functions
for material properties using LiveLink™ for Excel®.

The Material Library add-on contains over 3800 materials with tens of thousands
of temperature-dependent property functions. In addition, many of the add-on
products include material libraries relevant to their application areas.

First, investigate how to add properties to an existing material. Assume that you
want to add bulk modulus and shear modulus to the copper properties.

CUSTOMIZING MATERIALS
Let us keep working on the busbar.

I In the Model Builder, under Materials, click b YA\ Geometry 1

Copper o 4 iE Materials

I» 2z Copper (matl)
b %22 Titanium beta-215 (mat2)
2 In the Settings window for
Material, click to expand the

Material Properties section, b [l Geornechanics Material
. . . ~ | H lastic Material
which contains a list of all of . fii} Hyperelastic Materia
N [fffi Linear Elastic Material
the definable properties. !
[
[
[
[
[
[
[

¥ Material Properties

24 Anisotropic
=i Anisotropic, Voigt notation

Expand the Solid Mechanics

24 Bulk modulus and shear modulus

> Linear Elastic Material 2 Cubic -+ Add to Material
section. Right-dick Bulk = Eﬁ:ect!\.feﬂ?xlbth_-,I raTeEs

o= Effective stiffness matrices e
Modulus and Shear Modulus %5 Lamé parameters

24 Orthotropic

and select + Add to
Material. +

This lets you define the
bulk modulus and shear modulus for the copper in your model.

3 In the Copper node, locate the Material Contents section. Bulk modulus and Shear
modulus rows are now available in the table. The warning sign g, indicates that
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the values are not yet defined. To define the values, click the Value column. In
the Bulk modulus row, enter 140e9 and in the Shear modulus row, enter 46e9.

¥ Material Contents

»

Property Variable Value Unit Property group
Bulk modulus K 140e8 N/m®  |Bulk modulus and shear...
e A\ | Shear modulus G N.-"mz Bulk modulus and shear...
[ Electrical conductivity sigrma... |5.998e7[... | 5/m Basic
[¥ | Heat capacity at constant pres... Cp 3850/ (k... |J/(kg-K) Basic
[# | Relative permittivity epsilo.. |1 1 Basic
[ Density rho 8960[kg... kg/m® |Basic
[ Thermal conductivity k_iso ;.. [400[W/(... |W/(m.... |Basic
Relative permeability mur_is... |1 1 Basic
Coefficient of thermal expansi... |alpha_.. 17e-8[1/... | 1/K Basic
Young's modulus E 110e3[Pa] Pa Young's modulus and Poi...
Poisson's ratio nu 0.35 1 Young's modulus and Poi...
Reference resistivitv rhol 1.72e-8l.. |Q-m Linearized resistivitv
#5~

By adding these material properties, you have changed the Copper material. You
can save this information in your own material library, but not in the read-only
Solid Mechanics materials library.

4 In the Model Builder, right-click Copper and select Add to User-Defined Library [[.

b Geometry 1
4 EE Materials
I» 2zi Copper (matl)
I %22 Titanium beta-2| "= User-Defined Property Group

I 3% Electric Currents (eq Merge With

[+ | I8 Heat Transfer in Solil

b Multiphysics [l Add to User-Defined Library c
b A Mesh 1

Copy as Code to Clipboard
~do Study 1

To see this library, click the Browse Materials in the Materials tab in the ribbon.

Adding Meshes

A model component can contain different mesh sequences for generating meshes
with different settings. A mesh sequence is an ordered set of instructions for
generating a mesh. Mesh sequences can be accessed by the study steps. In a study,
you can select which mesh you would like to use in a particular simulation.

In the busbar model, a second mesh node is now added to create a mesh that is
refined in the areas around the bolts and the bend.
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ADDING A MESH

I Open the model busbar.mph that 4 % busbar_Lmph (root)
was created earlier. 4 () Global Definitions
Fi Parameters 1
2 In order to keep this model in a 4 Default Model Inputs

separate file for later use, select File 6 e Mate”a': —
4 g Component 1 (comp
> Save As and rename the model

b= Definitions| 2:  Add Physics
busbar_I.mph. : ,\ :;:I:? . Add Multiphysics
3 To add a second mesh node, | +\'_ Electric Cul [=  Insert Physics from Madel
right-click the Component | node m b |@ Heat Transt A Add Mesh
and select Add Mesh 4. . (If you : "_” m:ls:ﬁhys“ Copy as Code to Clipboard
followed the instructions in
“Parameters, Functions, Variables, and Couplings” on page 113, the name of

Component | is Busbar instead.)
By adding another Mesh node, a Meshes parent node is created that contains
both Mesh | and Mesh 2.

4 Click the Mesh 2 node. In the Settings

. . ~ Mesh Setti
window for Mesh under Mesh Settings, sclect e netings

User-controlled mesh as the Sequence type. Sequence type:

. Physics-controlled mesh -
A Size and Free Tetrahedral node are now o e o e
available U.IldCI' Mesh 2. Physics-controlled mesh
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5 In the Model Builder, under Mesh 2, click Size

Model Builder - -
-— = =t t - Size
4 % busbar_l.mph (root) " Build Selected [E Build All G
4 () Global Definitions
Fi Parameters 1 Label: Size 5|
45 Default Model Inputs .
2 Materials Element Size
4 |§ Component1 (comp1) Calibrate for:
[+ = Definitions -
b YA Geometry 1 General physics -
[» 5g= Materials () Predefined Mormal
[ +\_ Electric Currents {ec) G @® Custom
I» |[E Heat Transfer in Solids (ht)
I .y Multiphysics ¥ Element Size Parameters
4 /5 Meshes . .
b A Mesh 1 e Maximum element size:
4/ Mesh2 2*mh m
Y £ Size Minimum element size:
Free Tetrahedral 1 2*(mh-mh/3) m
[~ Study 1
4 B Results Maximum elerment growth rate:
[ Datasets 15

I &2 Derived Values Curvature factor

I E Tables 0z

I N Electric Potential (ec) :

I il Temperature (ht) Resolution of narrow regions:
I N lsothermal Contours (ht) 0.5

|

W& Current Density
The asterisk in the upper-right corner of a node icon indicates that the node is
being edited.
6 In the Settings window for Size, under Element Size, click the Custom button.
7 Under Element Size Parameters, cnter:

- 2*mh in the Maximum element size ficld, where mh is 3 mm — the mesh control
parameter defined previously.

- 2*(mh-mh/3) in the Minimum element size ficld.
- 0.2 1in the Curvature factor ficld.
8 Click Build All = . Save the file as busbar_I.mph.

Compare Mesh | and Mesh 2 by clicking the Mesh nodes. The mesh is updated in
the Graphics window. An alternative to creating multiple meshes in this way is to
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run a parametric sweep of the parameter for the maximum mesh size, mh, that was
defined in the section “Global Definitions” on page 67.
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Mesh | Mesh 2

Adding Physics

The distinguishing characteristics of COMSOL Multiphysics, particularly
adaptability and compatibility, are prominently displayed when you add physics to
an existing model.

In this section, you will experience the ease with which this seemingly difficult task
is performed. By following these directions, you can add structural mechanics and
fluid flow to the busbar model.

STRUCTURAL MECHANICS
After completing the busbar Joule heating simulation, we know that there is a
temperature rise in the busbar. What kind of mechanical stress is induced by
thermal expansion? To answer this question, let us expand the model to include
the physics associated with structural mechanics.
To complete these steps, either the Structural Mechanics Module or the
MEMS Module (which enhances the core Solid Mechanics interface) is
required.
If you want to add cooling by fluid flow, or do not have the Structural
Mechanics Module or MEMS Module, read this section and then go to
“Cooling by Adding Fluid Flow” on page 131.

122 |



I Open the model busbar.mph that was created earlier. From the main menu,
select File > Save As and rename the model busbar_II.mph. Alternatively, you
could load the busbar.mph model from the Application Libraries as shown

carlier.

2 In the Model Builder, right-click
the Component | node m and
select Add Physics ;.

3 In the Add Physics window, under
Structural Mechanics, sclect Solid
Mechanics

To add this interface, you can
right-click and select Add to
Component lor click the + Add to
Component |button at the top of
the window.

4 Close the Add Physics window and
save the file.

4 & busbar_l.mph (root)
I () Global Definitions

|

[

B Component 1 fcomo ]

~ Study 1 1 Add Physics 6
b @ Results %, Add Multiphysics
& Insert Physics from Model
£y Add Mesh
Copy as Code to Clipboard
Add Physics TAX

+ Addte Component 1 + Add to Selection

Search

1)) Acoustics
<»% Chemical Species Transport
[ Electrachemistry
“= Fluid Flow
Heat Transfer
i} Optics
&) Plasma
£ Radio Frequency
% Semiconductor
=

Structural Mechanics

=
G 3 Solid Mechanics (solid)

e el 15 to Component
[ Shell (sh| + Addte Comp 1

E\'é Layered ~+  Add to Selection
L] Membra___ ,
@ Beam (beam)

When adding additional physics, you need to make sure that materials
included in the Materials node have all of the required properties for the
selected physics. In this example, all properties are already available for

copper and titanium.

You can start by adding the effect of thermal expansion to the structural

analysis.
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5 In the Model Builder, right-click
the Multiphysics node », and select
Thermal Expansion = .

A Thermal Expansion node is added

4 =7 Solid Mechanics (solid)

B Linear Elastic Material 1

S Freel

B Initial Values 1

4 .f‘_';:‘, Multiphysics

2L Electror \'a Piezoresistive Effect, Domain Currents

o £ Mesh 1
to the model tree. | h;bgud\j & Equilibrium Discharge Heat Source
y

You can also use the ribbon and b B Resuits 6 Eﬂ Thermal Expansion

. Th lectric Effect
select, from the Physics tab, Frmosiee He

. . . X' Electromagnetic Heating

MUItIPhYSIcs coupllngs> Thermal E\a Equilibrium Discharge Boundary Heat Source
Expansion. 8 vep
In the Settings window for Thermal
Expansion, from the Selection list, select >ettings
All domains. This will enable thermal hermal Expansion
expansion in the copper as well as in the Label:  Thermal Expansion 1 =
titanium bolts. Name tel

The Thermal Expansion Properties
section of this window shows
information about the Coefficient of
thermal expansion and the Strain
reference temperature (there are also
some more advanced settings.) The
Coefficient of thermal expansion takes its
value from the Materials node. In the
Model Input section, the Volume
reference temperature (strain reference
temperature) has a default value of
293.15 K (room temperature) taken
from the Default model inputs node,
available in Global Definitions, and
defines the temperature for which there
is no thermal expansion. The Coupled
Interfaces scection shows which two
physics interfaces define the physics for
heat transfer and solid mechanics. This is
uscful in the case where there is more
than one physics interface for heat
transfer or solid mechanics in the model
component. Keep all default settings in
this window.

Next, constrain the busbar at the
position of the titanium bolts.
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* Domain Selection

Selection: | All domains -

Active

[= T T S TE R W
[

Equation
¥ Coupled Interfaces
Heat transfer:

Heat Transfer in Solids (ht) | |

Structure:

Solid Mechanics (solid) | [
~ Model Input +
Volume reference temperature:

T ref Common model input x| |E H
¥ Thermal Expansion Properties

Input type:
Secant coefficient of thermal expansion -
Coefficient of thermal expansion:

a From material -

¥ Heat Sources

Thermoelastic damping
[] Mechanical losses



7 In the model tree, right-click Solid Mechanics = and from the boundary level,
select Fixed Constraint = . A node with the same name is added to the tree.

8 Click the Fixed Constraint node = . In the Graphics _ o
4 @ Solid Mechanics (solid)

window, rotate the busbar to view the back. Click the BE Lincar Elastic Material 1

circular surface of one of the bolts to add it to the T Freel

S | t- n 11 t i Initial Values1
electio St. A Fixed Constraint 1

9 Repeat this procedure for the remaining bolts to add
boundaries 8, 15, and 43.

¥ Boundary Selection

Selection: | Manual - |
a L]

on ]

. 15 g -

Active 43 [:'E‘l ,E:I_;E

[

For easier management of multiple boundary selections, you can group
boundaries into a user-defined selection. Once you have selected
boundaries 8, 15, and 43, click the Create Selection button . and give it
a name such as Bolt top surfaces.

This selection is then added as a node under Component | > Definitions and
is accessible from the Selection list in the Settings window for all types of
boundary conditions. You can use this technique to group domains,
boundaries, edges, and points.

Model Builder Settings v

- 1 = STEL S - Explicit

4 & busbar_ll.mph (root] —
psberlmeh (rof) Label: Bolttop surfaces |,'§|

4 (7)) Global Definitions
Fi Parameters 1
4 Default Model Inputs

2= Materials Geometric entity level: |m|
4w Component 1 (comp 1) e

4 = Definitions 8 eS|
4 U Selections 13 E:‘El -—
& Tibolts 43 @ ‘E}
i Bolt top surfaces

T Input Entities

=/ Boundary System 1 (sys{)
b (L] view 1
A Geometry 1

Materials [_] All boundaries
i

3 Flectric Currents (ec) [] Group by continuous tangent

B Heat Transfer in Solids (ht)
f;l Solid Mechanics (solid)
7= Linear Elastic Material 1 ‘ Selected boundaries = |

Next, we update the Study node to take the added physics into account.

(R

= Output Entities
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SOLVING FOR JOULE HEATING AND THERMAL EXPANSION

The Joule heating effect is independent of the stresses and strains in the busbar,
assuming temperature invariant materials, small deformations, and ignoring the
effects of electric contact pressure. This means that you can run the simulation
using the temperature as merely an input to the structural analysis. In other words,
the extended multiphysics problem is weakly coupled. As such, you can solve it in
two separate study steps to save computation time — one for Joule heating and a
second one for structural analysis. In a more advanced analysis, you can include all
of the aforementioned eftects.

For this example, you can skip these steps and just click Compute.
However, the following technique can be useful for saving computational
time and memory resources, especially for larger simulations.

I In the Model Builder, right-click Study I - and

> X 4 ~db Study 1
select Study Steps > Stationary > Stationary - to [= Step 1: Stationary
add a second stationary study step. G 7 Step2: Stationary 2

[*r. Solver Configurations

When adding study steps, you need to manually connect the respective
physics with the correct study step. We start by disabling the structural
analysis from the first step.

2 Under Study 1, click the Step I: Stationary node 4~ Study1

.~ Step 1: Stationary
’ . — Step 2: Stationary 2
3 In the Settings window for Stationary, locate the e Solver Configurations

Physics and Variables Selection.

4 In the Solid Mechanics (solid) ~ Physics and Variables Selection
row under Solve for’ click to [] Modify model configuration for study step
change the check mark = to » - N
. Physics interface Solve for Discretization
an [J to remove Solid _ —
. . Electric Currents (ec) &4 Physics settings =
Mechanics from Study Step 1. o —
Heat Transfer in Solids (ht) ™ Physics settings =
In the Multiphysics couplings G Solid Mechanics (solid) O Physics settings

section, keep all of the

default settings.

Now, repeat these steps to remove Electric Currents (ec) and Heat Transfer in
Solids (ht) from the second study step.

5 Under Study 1, click Step 2: Stationary 2 ' . 4~ Study1
E Step 1: Stationary

6 E Step 2: Stationary 2

[*r. Solver Configurations

K
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6 Under Physics and Variables
Selection, in the Electric
Currents (ec) and Heat

¥ Physics and Variables Selection

[] Modify model configuration for study step

L33

Transfer in Solids (ht) rows, Physics interface Solve for Discretization
. . Phveics setti -
click to Change the check o Electric Currents (ec) O ysics settings
mark & to an [] to remove ' Heat Transfer in Solids (ht) O Physics settings =
Solid Mechanics (solid) ™ Physics settings =

Joule heating from Step 2:
Stationary 2.

7 Right-click the Study I node -~ and select Compute = (or press F8 or click
Compute in the ribbon) to solve.

6 4~ Study ]
E Stg = Compute F8
[= ste ' Update Solution F5

e So

{E Result! 22 Parametric Sweep

Save the file as busbar_II.mph, which now includes the Solid Mechanics interface
and the additional study step.

RESULTING DEFORMATION

Now that a physics interface has been added, additional plots for Solid Mechanics
need to be added manually. First, a displacement plot.

I In the Model Builder, right-click Results & and add a 3D Plot Group w . In the
Label ficld enter Displacement to give the plot group a descriptive name.
Right-click Displacement @ and add a Surface | node ™.Click the Surface I node

Datasets

£ Derived Values

B Tables

VB Electric Potential (ec)
i Ternperature (ht)

i Isothermal Contours (ht)
VB Current Density

ik Displacement

c T* Surface 1

4 ([ Results
I
I
I
I
I
I
I
4
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2 In the Settings window for Surface in
the Expression section, click the Replace
Expression button % .

From the context menu, sclect Model >
Component | > Solid Mechanics >
Displacement > solid.disp - Displacement
magnitude - m.

You can also enter solid.disp in the
Expression ficld.

Now, change to a more suitable unit.
In the Settings window under
Expression, from the Unit list, select mm
(or type mm in the field).

The local displacement due to thermal
expansion is displayed as a surface plot.
Next, we will add information about
the busbar deformation.

+ Expression

Expression:
solid.disp

Unit:

mm

[] Description:
Total disp

acement

4 Model

©

Geometry

Global definitions
Materials

Mesh

Component 1 (compl)

[» Definitions

[» Frames

[* Geometry

[» Electric Currents

[* Heat Transfer in Solids
4 Solid Mechanics

[» Acceleration and velocity
[» Activation

4 Displacement

[» Curl of displacement
[» Displacement field - m

solid.disp - Displacement magnitude - m

In the Model Builder, under Results > Displacement, right-click the Surface | node
™ and add a Deformation node =s. The plot automatically updates in the
Graphics window. Click the Go to Default View button ... so your view appears

similar to the plot shown below.
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The deformations shown in the figure are highly amplified to make the
very small distortions that actually take place more visible.

Surface: Displacement magnitude (mm)

L P
0

4 Save the busbar_II.mph file, which now includes a Surface plot with a
Deformation.

You can also plot the von Mises and principal stresses to assess the
structural integrity of the busbar and the bolts.

OVERRIDE AND CONTRIBUTION: EXCLUSIVE AND CONTRIBUTING NODES

The model tree nodes for a physics interface are traversed in a downward sequence
starting from the top. Depending on the selection, a node can totally or partially
override, or shadow, a node that comes earlier in the sequence. There are two
types of physics interface nodes: exclusive and contributing. How the nodes are
treated depends on the type.

A constraint boundary condition is a typical example of an exclusive node.
Examples of constraint boundary conditions include Electric Potential or Fixed
Constraint. In the case of Electric Currents, for example, if there are two or more
Electric Potential nodes for the same boundary, then the last Electric Potential node
in the sequence will override the settings of the other nodes. The Ground node is
also an exclusive node and will similarly override the boundary conditions specified
by any previous node.
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The figure below shows the Override and Contribution section in the Settings
window for Electric Potential. The Overrides list indicates that this boundary
condition takes precedence over the default Electric Insulation boundary condition.

-+ Settings
89 Electric Potential

4 & busbar_ll.mph (root)
4 (F) Global Definitions
Fi  Parameters 1
£ Default Model Inputs

Label:  Electric Potential 1 =

~ Boundary Selection

o Materials Selection: | Manual -
4 |m Component 1 fcompT)

P = Definitions 43

b Geometry 1 g -

b izi Materials LQ'D

4 }_ Electric Currents fec) ..

@ Current Conservation 1
f- Electric Insulation 1
T Initial Values 1

) i i | ~ Override and Contribution
mw Ground 1
b | Heat Transfer in Solids (ht) Qverridden by:

[ ? Solid Mechanics (solid)
b i Multiphysics

b A Meshes
[~ Study 1 Overrides:
b B Results Electric Insulation 1

A flux boundary condition, such as one specifying a heat flux, is a typical example
of a contributing node. You can stack several heat flux boundary conditions and
they will all contribute to the total heat flux. The figure below shows an example
where a Heat Flux 2 boundary condition overrides the default Thermal Insulation

boundary condition and contributes to the heat flux together with Heat Flux 1.

[ Bxtrude 3 (ext3) v Override and Contribution
Form Union (fin)
I 528 Materials Overridden by:

[ }f Electric Currents {ec)
4 |E Heat Transfer in Solids (ht)
i Solid 1
i Initial Values 1
f- Thermal Insulation 1
o Heat Flux 1 Overrides:
mw Heat Flux 2 Thermal Insulation 1
[ f;i Solid Mechanics (solid)
I iy Multiphysics
b2 Mesh 1
[ ~do Study 1
4 [B| Results Contributes with:
[

: Datasets Heat Flux 1

I &2 Derived Values
I E Tables
I N Electric Potential (ec)

In the model tree, the override and contribution relationships are indicated by a
red arrow and an orange circle, respectively.
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COOLING BY ADDING FLUID FLOW

After analyzing the heat generated in the busbar and possibly the induced thermal
expansion, you might want to investigate ways of cooling the busbar by letting air
flow over its surfaces. These steps do not require any additional modules, as the
model only includes Joule heating without the previous thermal expansion
analysis.

If you use either the Non-Isothermal Flow or Conjugate Heat Transfer
multiphysics interface, the coupling between heat transfer in solids and fluids
is automatic, whereas in this example, this is done manually and with limited
functionality. This is to illustrate adding a multiphysics coupling to an already
existing analysis.
Adding fluid flow to the Joule heating model creates a new multiphysics coupling.
To simulate the flow domain, you need to create an air box around the busbar for
the external flow. You can do this manually by altering the geometry from your
first model or by opening an Application Library file. To save time, open a file with
the box already created.

After loading the geometry, you will learn how to simulate air flow according to
this figure:

Air outlet

a1

Air inlet

DEFINING INLET VELOCITY

Start by loading the geometry and adding a new parameter for the inlet flow
velocity.
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I If you have just reopened the software, close the New window that opens
automatically by clicking the Cancel button .

2 Click the Home tab, and from the Windows menu select Application Libraries [f .
Navigate to COMSOL Multiphysics > Multiphysics > busbar box. (You can also
open the Application Libraries directly from the File menu.)

Double-click to open the file,
which contains the geometry Application Libraries
in addition to the physics
modeling steps completed
through the end of the 4 I3 COMSOL Multiphysics

;

:

b

b

b

:

:

;

:

b

b

iy

(' Refresh Update COMSOL Application Libraries () Application Gallery

Search

section “Customizing fi} Appications

. [lfi Acoustics
Materials” on page 118. flll Chemical Enginesring
[l Cluster and Batch Tuterials
[ilii Diffusion
[ilii Electromagnetics
[flfi Equation Based
[ilfi Fluid Dynamics

[lfi Geophysics
[ilfi Heat Transfer
[l Meshing Tutorials

[illf Multiphysics
G ©  bushar_box
O bushar_geom
@ busbar

Run Application Open

Open PDF Document

Help a Close

3 Under Global Definitions, click the Parameters node

4 In the Settings window for Parameters, click the empty row just below the Vtot
row. In the Name column, enter Vin. Enter 0.1[m/s] in the Expression column
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and a description of your choice in the Description column, such as Inlet

velocity.

Model Builder

4 & busbar_box.mph (root)
4 () Global Definitions
e Py Parameters 1
4 Default Model Inputs
= Materials
4 [ Component 1 {comp?)
b = Definitions
4 A Geometry 1
{2 Work Plane 1 fuwp1)
[E) Extrude (ext!)
= Work Plane 2 (wp2)
o Extrude 2 f{ext2)
=| Work Plane 3 (wp3)
o Extrude 3 fext3)
[T] Block 1 {bik7)

Pl

2l

<

Label:

Parameters 1

~ Parameters

’ MName
L
rad_1
thb
whb
mh
htc
Vtot
Vin

Expression
S[em]
&[rmm)]
3[mm]
3[em]
3[mm]
S[W/m*2/K]
20[mV]
0.1[m/s]

Value Description

0.09 m Length

0,006 m Bolt radius

0,005 m Thickness

005 m Width

0.003 m Maximum element size
5W/ (™K} Heat transfer coefficient
0.02v Applied voltage

01 mss

5 Seclect File > Save As and save the model with a new name, busbar_box_I.mph.

ADDING AIR

The next step is to add the material properties of air.

I From the Home tab, sclect Add Material

select Add Material from Library.)

2 In the Add Material window, expand the

Built-In node. Right-click Air and select
Add to Component |. Close the Add

Material window.

Add Materia

iy, (or right-click the Materials node and

X

(7)) Add to Global Materials 4 Add to Component v

425 Recent Materials
[ Material Library

4 [@ Built-In

oa Air

Add to Global Materials

.. B Addto Component 1 (comp1)

Search

Aluminum £063-T23

3 In the Model Builder under Materials, click the Air node .

4 g2 Materials

[ Eg8 Copper (mati)

[ 225 Titanium beta-215 (mat2)

b i Air (mat3)

4 On the Graphics window toolbar, click Zoom Extents .
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5 In the Graphics window, click the air box (domain 1) to add it to the Selection
list, which changes the color to blue. This step assigns the air material properties
to the air box.

A
Label:  Air 5
|
Geometric Entity Selection
= . Geormnetric entity level: Domain =
|
{ Selection: Manual =

I~ o.os
| 1
|

Al

Bl (50 [u}
|

ADDING FLUID FLOowW
Now, add the physics of fluid flow.
I In the model tree, right-click Component 1 @ and sclect Add Physics ;.

2 In the Add Physics window under
Fluid Flow > Single-Phase Flow, Add Physics
right-click Laminar Flow - and select - Addto Component 1 +- Add to Selection
+ Add to Component. Laminar Flow
will appear under Component | in the
model tree. Close the Add Physics
window.

(O Recently Used

¥ AC/DC

1)) Acoustics

<»% Chemical Species Transport

3 In the Graphics toolbar, click the U E:Eic:;c:l:mim

Transparency button . In addition, e
click the Wireframe Rendering button G : !
. . . = Laminar Flow (spf)

=3 Th'csc.two settings make it easier b % Tubulent Il | Add to Component 1
to see inside the box. Toggle these : . ;artg:_Edddf ©  Addto Selection
on and off as needed during the S poeti o

. =& Pipe Flow (pfl)
modeling process to control the type
of rendering used.

[

Single-Phase Flow

Creeping Flow (spf)

Now that you have added fluid flow to the model, you need to remove the air
domain (domain 1) from the Electric Currents (ec) interface (assuming that the
air has no electric conductivity and hence no currents) and then couple the heat
transfer part of the Joule Heating multiphysics interface to the fluid flow.
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4 In the model tree, select the
Electric Currents (ec) node
* . In the Graphics window,
move the mouse pointer
over the air domain and
click to remove it from the
selection list. At this point, o
only the busbar should be
selected and highlighted in
blue.

y\I/x

5 In the Model Builder, right-click Heat Transfer in Solids = . In the first section of
the context menu, the domain level &, select Fluid.

,'é: Materials
*_ Electric Currents (ec)
h

-

4 |[@ Heat Transfer in Solids (ht!
&= Solid 1 IS Sclid
i Initial Values 1 = Fluid o
5= Thermal Insulation 1
(9 Heat Flux 1 I= Heat Source

4 == Laminar Flow (spf] 1= Initial Values
&= Fluid Properties 1 Specific Media
i Initial Values 1 = 1
oo Wall 1 = Termnperature

4§ Multiphysics (= Thermal Insulation
| Electromagnetic Heat

6 In the Graphics window, click the
air domain (domain 1) to add it to
the Selection list.

Now, couple the fluid flow and
heat transfer phenomena.
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7 In the Settings window for Fluid, under

Heat Transfer in Solids, in the section v Model Input

Model Inputs, sclect Absolute pressure Temperature:

(spf) from the Absolute pressure list. In T | Temperature (ht)

the section Heat Convection, select Absolute pressure:

Velocity field (spf) from the Velocity field G Pa | Absolutepressure(spf) v | |51
list. Coordinate System Selection

This identifies the pressure and flow - [ et

field from the Laminar Flow interface Velocity field:

and couples it to heat transfer. G u [ Velocity field (spf) -

Now, define the boundary conditions
by specifying the inlet and outlet for the
heat transfer in the fluid domain.

8 In the Model Builder, right-click Heat *_ Electric Currents (ec)
Transfer in Solids = . In the second section 4 |18 Heat Transfer in Solids (ht)
of the context menu, the boundary i Solid 1

: o
section =, sclect Temperature. t Initial Values 1

T Thermal Insulation 1

A Temperature node is added to the = Heat Flux1
model tree. = Fluidl
G ry Temperature 1
4 == Laminar Flow (5pf)

i Fluid Properties 1
B Initial Values1
= Walll

9 In the Graphics window, click the

inlet boundary, boundary number AT
2, to add it to the Selection list. g

This sets the inlet temperature to | i
293.15 K, the default setting. aos{

The graphics should look like the

image to the right. (It may look G
slightly different depending on g
whether you have Transparency and

Wireframe Rendering on or oft.)

Continue by defining the outlet.
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10In the Model Builder, right-click Heat Transfer in Solids = . At the boundary level,
select Flow Conditions>Outflow. An Outflow node = is added to the model tree.

4 |[E Heat Transfer in Solids (ht)

= Solid 1 I= Solid
= Initial Values 1 = Fluid
o -
mw Thermal Insulation 1
s Heat Flux 1 = Heat Source
IE Fluid 1 = Initial Values
i Temperature 1 Specific Media
3 aminar Flow (spf) -
I iy Multiphysics i Temperature
b Mesh 1 = Thermal Insulation
b Study 1 m  Heat Flux
b {8 Results -
= Symmetry
= Periodic Condition
= Lumped System Connector
= Phase Change Interface
= Inflow Flow Conditions
@ = Outflow Heat Sources
= Open Boundary Thin Structures

Il In the Graphics window, click the
outlet boundary, boundary
number 5, to add it to the
Selection list. Use the mouse scroll
wheel to scroll in and highlight
the boundary before selecting it,
or use the up and down arrow
keyboard buttons.
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The settings for the busbar, the bolts, and the Electric Potential | and
Ground | boundaries have retained the correct selection, even though you
added the box geometry for the air domain. To confirm this, in the model
tree under Electric Currents, click the Electric Potential 1 and the Ground |
nodes to verify that they have the correct boundary selection.

Settings

Electric Potential

Label: Electric Potential 1
¥ Boundary Selection
Selection: Manual

Active

Cverride and Contribution
Equation
¥ Electric Potential

Electric potential:

Vg Viot

=
g -
[m

S

Label: Ground1 =

¥ Boundary Selection

Selection: | Manual -
13 &
on ]
- 20 g -
Active N &

S

Cverride and Contribution

Equation

Next, continue with the flow settings. You need to indicate that fluid flow only
takes place in the fluid domain and then set the inlet, outlet, and symmetry
conditions. Do this by first removing all domains from the selection and then

adding the air domain.

I In the model tree, click the Laminar Flow node - . In the Settings window for
Laminar Flow, click the Clear Selection button fi.

Settings

Laminar Flow

Label:  Laminar Flow
Mame:  spf

¥ Domain Selection
Selection: | All domains

Active

oo s W o —
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2 In the Graphics window, click the air box (domain 1) to add it to the Selection.

It is good practice to verify that the Air 4 3E2 Materials

material under the Materials node has all of b i Copper (matl)

the properties that this multiphysics b i2i Tanium beta-215 (mat2)
. . . [ gra Air (mat3)

combination requires. In the model tree i

under Materials, click Air. In the Settings

window for Material under Material Contents, verify that there are no

missing properties, which are marked with a warning sign 4. The section

“Materials” on page 75 has more information.

Now, we continue with the boundaries.

3 In the Model Builder, right-click Laminar Flow - and at 4 == Laminar Flow (spf)

the boundary level, select Inlet. An Inlet node = is T Fluid Properties 1
i Initial Values 1

O Walll

e o Inletl

added to the model tree.

4 In the Graphics window, click the
inlet (boundary 2) to add it to the
Selection list.

01|

5 In the Settings window for Inlet
under Velocity in the U, field, : _ _
enter Vin to set the Normal inflow e E;;:::::We'mt’r
velocity. 0 U Vin s

* Velocity
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6 Right-click Laminar Flow - and at
the boundary level, select Outlet w .
In the Graphics window, click the
outlet (boundary 5) to add it to the
Selection list. Use the mouse scroll
wheel or keyboard arrows to scroll
in and highlight the boundary
before selecting it.

The last step is to add symmetry
boundaries. For simplicity, assume
that the flow just outside of the
faces of the channel is similar to the
flow just inside these faces. This
assumption can be correctly
expressed by the symmetry
condition.

7 Right-click Laminar Flow - and select Symmetry. A Symmetry node = is added
to the sequence.

8 In the Graphics window, click each of the blue faces in the figure below
(boundaries 1, 3, 4, and 48) to add all of them to the Selection list. You may need
to use the mouse scroll wheel or rotate the geometry to select all of them.

Save the busbar_box_I.mph file, which
now includes the Air material and
Laminar Flow interface settings.

When you know the boundary

numbers, you can click the 1@ Paste Selection X
Paste Selection button 7 and
enter the information. In this
example, enter 1,3,4,48 in the
Paste Selection window. Click
OK and the boundaries are automatically added to the Selection list.

Selection:  1,3,448

OK | Cancel
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COARSENING THE MESH

To get a quick solution, we will change the mesh slightly and make it coarser. The
current mesh settings would take a relatively long time to solve, and you can
always refine it later.

| In the Model Builder, expand the Mesh | node 4 and
. . 4 S Meshl
click the Size node Aj. - R

......... L e

Free Tetrahedral 1

2 In the Settings window for Size
under Element Size, click the
Predefined button and ensure that
Normal is selected.

ettings

W LA

Build Selected [§ Build All
Label: Size E

Element Size

Calibrate for:

General physics -

e ®  Predefined MNormal v

O Custom

3 Click the Build All button = . The
geometry displays with a mesh in
the Graphics window (you may
need to turn Transparency off to see
the picture below.)

You can assume that the flow velocity
is large enough to neglect the e
influence of the temperature increase

in the flow field.

It follows that you can solve for the
flow field first and then solve for the
temperature using the results from
the flow field as input. This is
implemented with a study sequence.

SOLVING FOR FLUID FLOW AND JOULE HEATING

When the flow field is solved before the temperature field, it yields a weakly
coupled multiphysics problem. The study sequence described in this section
automatically solves such a weak, or one-directional, coupling.
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I In the model tree, right-click Study | - and select Study Steps > Stationary >
Stationary - to add a second stationary study step to the Model Builder.

4 o Study 1
[= Step 1: Stationary

b B Results

Compute Fa

Parametric Sweep

4 ~db Study 1
E Step 1: Stationary
E Step 2: Stationary 2

69 Function Sweep
Material Sweep
Study Reference

Combine Solutions

Optimization v
Stationary Stationary » Study Steps » c

B4 b %

[N

[ Stationary Plug Flow Time Dependent » | It Show Default Solver
I2 Bidirectionally Coupled Particle Tracing Eigenfrequency » | Y% Get Initial Value
2% Bidirectionally Coupled Ray Tracing Frequency Domain > —
"y Time Period Oth » =
[ Time Periodic il T Show More Options..
[ Stationary Source Sweep
Copy as Codle to Cliphoard »
[= Frozen Rotor -
- Delets Del
©  Stationary Free Surface O Delete ©
= Rename F2
= Frequency-Stationary 5
= Stationary, Fluid Settings
.
[~ Stationary, Solid [£) Properties
B Hep Fl

Next, the correct physics needs to be connected with the correct study step.
Start by disabling the Electric Currents (ec) and Heat Transfer in Solids (ht)
interfaces associated with Joule heating from the first step.

2 Under Study I, click Step I: Stationary | .

& ©

4 ~db Studyl ~  Physics and Variables Selection
E Step 1: Stationary

]E. Step 2: Stationary 2 [] Modify model configuration for stuy step

"

Physics interface Solve for Discretization

Electric Currents (ec) O Physics settings =
Heat Transfer in Solids (ht) EI Physics settings =
Laminar Flow (spf) ™ Physics settings =

3 In the Settings window for Stationary, locate the Physics and Variables Selection
section. In both the Electric Currents (ec) and the Heat Transfer in Solids (ht)
rows, click to change the check mark # to an [J in the Solve for column,
removing the Joule heating effect from Step 1.
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4 Repeat the step. Under Study I, click Step 2: Stationary 2 . Under Physics and
Variables Selection, in the Laminar Flow (spf) row, click in the Solve for column to
change the check mark = to an 7.

¥ Physics and Variables Selection

Medify model configuration for study step

Physics interface Solve for Discretization
Electric Currents (ec) ™ Physics settings =
Heat Transfer in Solids (ht) ™ Physics settings =

G Laminar Flow (spf) EI Physics settings =

5 Right-click the Study | node = and select Compute = (or press F8 or click
Compute in the ribbon). This will now automatically create a new solver
sequence that solves for laminar flow and then Joule heating.

4 o Study 1
E Step | = Compute F& 6
[~ Step| 1 Parametric Sweep

- |'|'|-|. Solve

I Ij g T Function Sweep

6 After the solution is complete, select the Temperature (ht) plot under the Results
node in the Model Builder. If you do not already have transparency on, click the
Transparency button & on the Graphics toolbar to visualize the temperature field
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inside the box. To zoom, middle-click and hold down the mouse button (or
scroll wheel) while dragging the mouse.

Surface: Temperature (K}

Y._I!x

The Temperature Surface plot that displays in the Graphics window shows the
temperature in the busbar and in the surrounding box. You can also see that the
temperature field is not smooth due to the relatively coarse mesh. A good
strategy to get a smoother solution would be to refine the mesh to estimate the
accuracy.

7 At this point, save the busbar_box_I.mph file so you can return to it at any time.
The next steps use the original busbar.mph file.

Parametric Sweeps

SWEEPING A GEOMETRIC PARAMETER

It is often useful to generate multiple instances of a design with the objective of
meeting specific constraints. In the previous busbar example, a design goal might
be to lower the operating temperature or decrease the current density. We will
demonstrate the former. Since the current density depends on the geometry of the
busbar, varying the width, wob, should change the current density and, in turn,
have some impact on the operating temperature. Let us run a parametric sweep on
wbb to study this change.
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ADDING A PARAMETRIC SWEEP

I From the File menu, open the
model file busbar.mph. If you
did not save the model, you can
also open it from the Application
Libraries: File > Application
Libraries > COMSOL Multiphysics >
Multiphysics > busbar.

In the Model Builder, right-click Study |
Parametric Sweep node is added to the Model Builder sequence.

4 & busbar.mph (root)
I () Global Definitions
[T Component 1 {comp 1)
[+ ~cf Study 1

I {8 Results

Compute

' Update Solution

G : Parametric Sweep

and select Parametric Sweep ii. A

F8
F5

2 In the Settings window for Parametric Sweep, under the empty parameter table,
click the Add button +. From the Parameter names list in the table, select wbb.

Model Builder

+— =

4 4 busbar.mph (root)
b () Global Definitions
I @ Component1 fcomp1)

4~ Stucy 1
G Parametric Sweep
=

Step 1: Stationary

b [fre Selver Configurations

4 [B Results

A Tables
b Electric Potential {ec)
V@ Temperature (ht)

il Current Density
Export
[ Reports

Datasets
4 Derived Values

il Isothermal Contours (ht)

- 1| Settings

= Cor;;:u;a t U‘pdate Solution

Label: Parametric Sweep

= Study Settings

Specified combinations

Sweep type:

"
Parameter name Parameter value list

T "

L iLength)

rad_1 (Bolt radius)

tbb (Thickness) L..I
whb (Width) obs

mh (Maximum element size)
htc (Heat transfer coefficient)
Vtot (Applied voltage)

Parameter unit

The Sweep type is used to control parametric sweeps with multiple
parameters. You select between sweeping for All combinations of the
given parameters, a subset of Specified combinations, or Parameter
switch. The option Parameter switch makes it possible to sweep over
Cases for Parameters as defined in Global Definitions, as shown below.

b froc =

Deliniticers

Case 1

" bame

1 Cemponent 1 comp ) d)

4 i Study 1 e
Parametric Sweep whd

Step 1 Stationaey mh

ry Sboer Configuiaticen. hte

4 & Results Viea

Labet Casel

= Parameters

4 Update Solution
Label: Parametric Sweep

¥ Study Settings

Bl radis

Thickness
Width
Maximum element size

Sweep type: Parameter switch

"
L] Heat transfer coefficient Switch Cases

Apphed volage
Parameters + All

Case numbers

* |range(1,1,3)
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3 Enter a range of parameter values to sweep the width of the busbar from 5 cm
to 10 cm in 1 cm increments. There are different ways to enter this information:

- Copy and paste or enter range (0.05,0.01,0.1) into the Parameter value list
field.

- Click the Parameter value list ficld and then
click the Range |..| button and enter the = Renge %
values in the Range dialog box. In the Start Entry method:
field, enter 0.05. In the Step ficld, enter Step =
0.01, and in the Stop field, enter 0.1. Click S[:;:
Replace. '
Step:
- In any of the methods, you can also use 0.01
length units to override the default SI unit Stop:
system using meters. Instead of 0.05, you 01
can enter 5[cm]; similarly, 1[cm] instead of Function to apply to all values:
0.01 and 10[cm] instead of 0.1. You can None S
also change the default unit system from the e e Add Cancel

Settings window of the root node in the
model tree.

¥ Study Settings

Sweep type: Specified combinations =
" Parameter name Parameter value list Parameter unit
whb (Width) - |range(0.05,0.01,0.1] m
+ =) beed

Next, define an Average nonlocal coupling that can be used later to calculate the
average temperature in the busbar.
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4 Under Component |, right-click Definitions = and select Nonlocal Couplings >
Average - .

4 & busbar.mph (root)
I () Global Definitions
4 |§ Component1 (comp1)
I = Definitions

b /A Geometry 1 2= Variables

I 5z& Materials .

[ +\_ Electric Currents {ec) Functions g

I |[@ Heat Transfer in Solids (h Selections »

I .y Multiphysics

b A hack 1 Riches '
Jiu  Integration MNonlocal Couplings 3 G
A Average Pairs 3
max - Maximum Coordinate Systems 3
MiN- Minimum Moving Mesh r
" General Extrusion Deformed Geomnetry 3

5 In the Settings window for Average, sclect All domains from the Selection list.

Model Builder s
— = Et
4 & busbar.mph (root)
b () Global Definitions
4 |§ Component1 (comp1) Operator name:  aveopl
4 = Definitions

4 Ty Selections Source Selection
@ Ti bolts Geometric entity level: Domain i

G av Average 1 {aveop) )
[ Boundary System 1 {sys1) Selection: e All domains -

; View 1

WA Geometry 1
2 Materials

+\_ Electric Currents {ec)

Bl Heat Transfer in Solids (ht)

iy Multiphysics
A Mesh 1

4

Label: Average 1 =

B 50 [
& |

This creates an operator called aveop1. This operator is now available to
calculate the average of any quantity defined on the selected domains. Later, we
use this tool to calculate the average temperature, but it can also be used to
calculate average electric potential, current density, and so forth.

6 Sclect File > Save As to save the model with the new name, busbar_III.mph.

7 Right-click Study | - and select Compute = to run the sweep or click Compute
in the Home tab.
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PARAMETRIC SWEEP RESULTS

Click the Temperature (ht) |1 node (the second
temperature plot node) located under Results in the
model tree.

The plot that displays in the Graphics window shows
the temperature in the wider busbar using the last
parameter value, wbb=0.1[m] (10[cm]). Select Zoom
Extents [F] from the Graphics window toolbar so that
you can see the entire plot. The resulting plot is rather
uniform in color, so we need to change the maximum
color range.

wbb(6)=0.1 m Surface: Temperature (K)

4 ([ Results

Data Sets

£ Derived Values

EH Tables

Wi Electric Potential (ec)

VB Temperature (ht)

i Isothermal Contours (ht)
W& Current Density

VB Electric Potential (ec) 1
il Termperature (ht) 1

i Isothermal Contours (ht) 1

317

316

314

I Under the Temperature (ht) | node, click the Surface node ™.

V@ Electric Potential (ec) 1
4 |l Temperature (ht) 1
h
Surface
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2 In the Settings window for Surface, ~ Range
click Range to expand the section. e
Select the Manual color range check Minimurn:  309.03671
box. Enter 309. 5 in the Maximum field Lo e
(replace the default). S .

Maximum: |308.5
3 The Temperature (ht) | plotis e ) 4,0 0008000000000 C
updated in the Graphics window for RN RN NN,
wbb=0.1[m] (10[cm]).

whbb(6)=0.1 m Surface: Temperature (K) a

m 309.27 e

The plot may look a bit different depending on which version you are running.
Compare the wider busbar plot to the temperature for wbb=0.05[m] (5[cm]).
For this purpose, you can reuse one of the previously defined plot groups.

I In the Model Builder, click the first Temperature (ht) node @ .

4 ([ Results
I #: Data Sets
2 Derived Values
EH Tables
I N Electric Potential (ec)
I Nl Temperature (ht)
I N Isothermal Contours (ht)
I N Current Density
I\l Electric Potential (ec) 1
4 @ Temperature (ht) 1
™ Surface
I N Isothermal Contours (ht) 1
Export
55 Reports
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2 In the Settings window for

1
3D Plot Group, sclect
Study I/Parametric Solutions & Plot
I from the Dataset list. This
. Label: Temperature (ht)
dataset contains the results
from the parametric sweep. = [REE
3 In the Parameter value hSt, G Data set: Stuchy 1/Parametric Solutions1 = | | E
select 0.05 (Wthh represents 6 Parameter value (wbb): | 0.05 -

wbb=5 cm). Click the Plot
button @ . Click the Zoom
Extents button [F on the Graphics window toolbar.

The Temperature (ht) plot is updated for wob=0.05[m] (5[cm]). Note that if you
have updated the color range for this plot already, your plot should look similar to
the one below. If not, follow the subsequent steps.

wbb(1)=0.05 m Surface: Temperature (K} o

— 323.25

~o0a

322.4

(The plot may include the max and min points, depending on which version of the
model you started from.) Like the wider busbar, the plot may be quite uniform in
color, so change the maximum color range.

I Under the first Temperature (ht) node, click the Surface node ™.

2 In the Settings window for Surface, click Range to expand the section (if it is not
already expanded). Select the Manual color range check box.

150 |



3 Enter 323.25 in the Maximum field (replace the default).

The Temperature (ht) plot is updated in the Graphics window for wbob=0.05[m]
(5[cm]).

Click the first and second Temperature plot nodes to compare the plots in the
Graphics window. The maximum temperature decreases as the width of the
busbar increases from 5 cm to 10 cm.

ADDING MORE PLOTS

To further analyze these results, you can plot the average temperature for each
width.

I Right-click Results = and add a ID Plot Group ..

4 ([ Results
[ Data{ il 3D Plot Group

8.85 ;.

exi Deriy M 20 Plot Group

B Table <
WS Elect “w 1D Plot Group

il Temp &) Polar Plot Group

#
Ui lsoth| g Smith Plot Group
W Curre
VB Elect @ Evaluation Group

W Temy Fi  Parameters
ik lsoth

Plot All

[# Repa (<) Close All Plat Windows

Show More Options...

"o} Mode Group

2 In the Settings window for ID Plot Group 8, sclect Study 1/Parametric Solutions |
from the Dataset list.

Settings
1D Plat Group
Plot

Label: 1D Plot Group 8

¥ Data
G Data set: Study 1/Parametric Solutions1 |
Parameter selection (wbb): | All -
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3 In the Model Builder, right-click 1D Plot Group 8 and add a Glebal =~ node.

VB Electric Potential (ec) 1
VB Temperature (ht) 1

VB Isothermal Contours (ht) 1
~% 1D Plot Group 8

(& Global 1

Model Builde ~ 4| Settings
o ; ]S Global
4 & busbar_lll.mph {root) Plot
I () Global Definitions
I W Component1 (comp1) Label: Global 1 =
[ ~do Study 1
4 [E Results v Data
[ Datasets =
Dataset: From parent - | |
P &5 Derived Values atas B =
I E Tables .
-Axis Data + - %~
I\l Electric Potential (ec) MR ~
I Nl Temperature (ht) » ) ) o
b il lsothermal Contours (ht) Expression Unit Description
I N Current Density aveopl(T) K Average 1 G
[
[
[
4

4 In the Settings window for Global under y-Axis Data, click the first row in the
Expressions column and enter aveop1(T). This is the operator that we defined
on page 147 for later use. You use a similar syntax to calculate the average of
other quantities.

You can also use auto-completion by using Ctrl+Space after clicking the
first row or after typing a few characters.

¥ y-Axis Data

" .
Expression

|ave
4 Compeonent 1 (compl)
4 Definitions
4 MNonlocal couplings
aveopl(expr) - Average 1

To use a nonlocal coupling operator without solving, you can select the
option Update Solution that is available by right-clicking a Study node.

~ct Study 1

{E Results | = Compute F8
=+ Continue
' Update Solution F5
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5 Click the Plot button = and save the busbar_III.mph model with these
additional plots that use the parametric sweep results.

Glabal: Average 1 (K] o
T T T T r T T T T - :
N
IR | Average 1 | ]
\
mf 1
320 M 1
™,
™,
a9t \ 4
\'-.
.
el . ]
.,
™
o drf " 4
= .
% ™
L &l S 1
= \
g .
g .
= msp e 4
.
nat \‘ 4
.
.
nat e 4
n2} R ]
it e 4
310k e 4
. . . . . . . . . . ™
0.05 0.055 0.06 0.065 007 0.075 0.08 0.085 0.09 0,085 0.1
whl (Width}

In the plot, the average temperature decreases as the width increases.

PARAMETERS IN RESULTS

For greater flexibility, it is possible to define parameters that are only used in the
Results node. Using these parameters does not require resolving the model. The
following example shows how you can animate over a Parameter defined under
Results.

I Right-click the Results node and select Parameters.

4 ([ Results

-

3D Plot Group
2D Plot Group
1D Plot Group
Polar Plot Group
Smith Plot Group

Evaluation Group

Parameters 0

Plot All

SN N W

R

- @

Clear Plot Data
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2 Define a parameter, iso_level, with Expression 309.5[K].

Model Builder

—

s EE

4 % busbar_lll.mph (root)
I () Global Definitions
I @ Component1 {comp1)
[~ Study 1

4 ([ Results

Fi Parameters

3

Datasets

I &2 Derived Values
I E Tables

~ * | Settings

- Parameters

~ Parameters

"
MName Expression Value
iso_level 309.5[K] 309.5 K

- A -

Description

Isosurface level

2

3 For the Isothermal Contours (ht) | plot group, in the Settings window for the
Isosurface plot, change the Entry method to Levels. For the Levels expression

field, type iso_level.

I Nl Temperature (ht) v Levels

4 k& Isothermal Contours (ht)

& Isosurface
1D Plot Group §

Entry method: | Levels
Levels: iso_level
[ Interactive

Shift: 0

4 In the same Settings window, click Plot.

whlslEl=0.1 Inosurface: Tamparaturs (K
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5 Generate an Animation by either selecting the Player option in the Animation
menu of the Isothermal Contours (ht) | tab in the ribbon, or right-click the
Export node and select Animation > Player.

Maodel Builder ~ 4| Settings
- = EtElL £~ Animation
4 & busbar_lll.mph {root) E Show Frame
4 () Global Definitions
[* P; Parameters1 Label: Animation 1 =
4 Default Model Inputs
== Materials ¥ Scene
P \m Component 1 fcomp) Subject: Isothermal Contours (ht) | [
[ ~do Study 1
4
& Results - T

Fi Parameters

Z Datasets Target: | Player = G
B.85

ea: Derived Values

[

[

I E Tables * Animation Editing

I N Electric Potential (ec)

[ i‘.‘f Temperature (ht) Sequence type: Result parameter - G
4 Nl Isothermal Contours (ht) Parameter: iso_level (lsosurface level)

¥ Isosurface
W& Current Density
i'.* Electric Potential (ec) 1 Stop: 310 K
i Ternperature (ht) 1

Start: 309 K

[ —

Unit: K
i Isothermal Contours (ht) 1
1D Plot Group 8  Frames
Export
[ Animation 1 6 Number of frames: 50
,igl Reports Frame number: 50

6 In the Settings window for Animation, change the Sequence type to Result
parameter and sclect the iso_level parameter. Type 309 for Start and 310 for
Stop. Click the Play button in the Graphics toolbar or the Show Frame button in
the Settings window for the Animation. To get a smoother animation, change the
Number of frames to a higher number; for example, 50.

The subject of parametric sweeps raises the question of parallel computing;; it
would be efficient if all parameters were solved simultaneously.

Parallel Computing

COMSOL Multiphysics and COMSOL Server support most forms of parallel
computing, including shared memory parallelism for multicore processors and
high-performance computing (HPC) for clusters and clouds. All COMSOL
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licenses are multicore enabled. For cluster or cloud computing, including
parallelized sweeps, a Floating Network License (FNL) is needed.

You can use clusters or clouds with one of two options: either for Cluster Sweep or
for Cluster Computing. If you have a Floating Network License, these two options
are available by right-clicking the Study node. However, you first need to enable
the Batch and Cluster study options by clicking the Show More Options button =

on the Model Builder toolbar and selecting Batch and Cluster in the Show More

Options dialog box.

3 Show More Options

4 12 Physics

A Equation Sections
[] 5+ Equation View
[]+. Stabilization

Extra Dimensions
Advanced Physics Options

O
4 ~dv Study

[Ty, Sensitivity

1 B8 Multigrid Level

[[1(@) Reduced-Order Modeling

4 @ Results

CLUSTER SWEEP

[[] % Solver and Job Configurations

[] 4y Equation-Based Contributions

The Cluster Sweep option is used for solving several models in parallel where each
model has a different set of parameters. This can be seen as a generalization of
Parametric Sweep. Right-click the Study node to add a Cluster Sweep node.

o
ounaer TR

Mode
- = ETE S~
4 % busbar_lll.mph (root)
4 () Global Definitions
Fi Parameters 1
45 Default Model Inputs
i Materials
I @ Component1 {comp1)
4 o Study 1
7 Cluster Sweep
[= Step 1: Stationary
I [fre Solver Configurations
[ EJ Job Configurations

b {8 Results

156 |

Settings
Cluster Sweep
= Compute ' Update Solution

Label: Cluster Sweep
¥ Study Settings
Specified combinations

Sweep type:

L] .
Parameter name | Parameter value list

whbb (Width) ~

Parameter unit

m



The Study Settings for Cluster Sweep arc similar to that of Parametric Sweep, but
additional settings are required for the cluster or cloud being used. The picture
above shows how the top of the Settings window for Cluster Sweep would look for
the same sweep as defined in “Parametric Sweeps” on page 144. To add and run
a Cluster Sweep in this case, you would first remove the Parametric Sweep node.

CLUSTER COMPUTING

You can also utilize a cluster or cloud to solve a single large model using
distributed memory. For maximum performance, the COMSOL software cluster
implementation can utilize shared-memory multicore processing on each node in
combination with the message passing interface (MPI) based distributed memory
model. This is also known as hybrid parallelism and brings a major performance
boost by making the most out of the computational power available.

Right-click the Study node to add a Cluster Computing node. A Cluster Computing
node cannot be used in combination with a Cluster Sweep. You will be asked if you
want to remove the Cluster Sweep before proceeding. Select Yes.
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The Settings window for Cluster Computing, shown below, helps to manage the
simulation with settings for the cluster or cloud.

Model Builder -1

- = !

4

4 % busbar_lll.mph (root) = Compute ' Update Solution

4 () Global Definitions

Py Parameters 1 Label: Cluster Computing =
45 Default Model Inputs

Materials

¥ Batch Settings

Filename: batchmodel.mph
= Definitions

WA Geometry 1
2 Materials MNumber of nodes: 1

4 |§ Component1 (comp1)
I
I [] Generate solver sequence in external process
I
4

+\_ Electric Currents [ec) [] Use batch license

= Current Conservation 1

o

i i Cluster computing settings
mw Electric Insulation 1

B Initial Values 1 Settings: User controlled -
i Electric Potential 1 Scheduler type: General -
= Ground 1

4 |[@ Heat Transfer in Solids (ht) Host file:
= Solid 1 Bootstrap server:

B Initial Values 1

Directory: “bos-filerl.comsol.corr  Browse...
G Thermal Insulation 1 e Dl')f. )
s Heat Flux 1 Specify server directory path
4 5 Multiphysics Directory: Browse...
x| Electromagnetic Heating 1 (emh1)
b A Mesh 1 Specify external COMSOL batch directory path
4 ~db Study 1 Directory: Browse...

%% Cluster Computing

[= Step 1: Stationary Specify external COMSOL installation directory path

I [fre Solver Configurations Directory: Browse...
[ r;r'l Job Configurations
b {E Results Number of job restarts: 0

Alive time (seconds): 300

The Settings menu under Cluster computing settings has two options: Preferences
or User controlled. The figure above shows the User controlled option. For the
Preferences option the settings are defined in the Preferences dialog box in the File
menu.

You choose the type of cluster job you want to perform from the Scheduler type
list. COMSOL Multiphysics and COMSOL Server support General, Windows®
HPC Server (HPCS) 2008,/2012/2016, Open Grid Scheduler/ Grid Engine
(OGS/GE), SLURM, PBS, or Not distributed. The General option is a
multipurpose option for Linux® clusters. Additional cluster and scheduler
settings, such as Prepend command and Postpend command, are available in the
Preferences window available from the File menu.

To learn more about running in parallel, see the Reference Manual.
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The Cluster Sweep and Cluster Computing options are only visible if you
have a floating network license and have enabled the Batch and Cluster
study options.

COMSOL Multiphysics Client-Server

When using COMSOL Multiphysics with a Floating Network License (FNL), it
is possible to use a client-server mode of operation to access remote computing
resources for solving large models, while still using the graphics card on a local
machine to display graphics. This mode of operation should not be confused with
the use of Windows Remote Desktop, and similar technologies, to connect to a
COMSOL Multiphysics session, or the use of the COMSOL Server product for
use with COMSOL applications.

Using the COMSOL Multiphysics client-server mode can have some significant
advantages, since engineering and scientific computing problems involve working
with large amounts of data — anywhere from megabytes to gigabytes of data are
commonly generated during a simulation. To generate and store this data, you
may want to use computers with fast processors, large amounts of Random Access
Memory (RAM), and a large hard drive. To visualize large datasets, it is important
to have a high-end graphics card on your local computer.

Under ideal conditions, you would always be working on a high-end computer
with more than enough memory and processing power for all of the simulation
steps. But if this is not the case and you need to solve larger models, you may
instead access a shared computing resource across a network.

At any time while using COMSOL Multiphysics, it is possible to connect to a
remote computing resource via the client-server mode of operation. This is a
two-step process. First, log onto the remote system and invoke the COMSOL
Multiphysics server, which will start the COMSOL Multiphysics server process
and open a network connection. Second, on the local machine, simply enter the
network connection information into an open session of COMSOL Multiphysics.
The software then transparently streams the model data and results back and forth
over the network and uses the remote computing resource for all computations.

There are several ways to start a COMSOL Multiphysics server session. In
Windows® 7, you can, for example, start a server session from the start menu
under COMSOL Multiphysics 5.6 > Client-Server. In Windows® 10, you can start a
server session from the COMSOL Launchers option from the Windows start menu.
In Linux®, you can use the comsol mphserver command. The server and client
sessions can be run on different operating systems. For example, the server can run
in Linux® and the client session in Windows®.
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The first time you start a COMSOL Multiphysics server on a computer, you are
asked for a username and password that are associated with the client-server mode
of operation and stored for future connections. The figure below shows the
command window for starting a server session in Windows.

i3 COMSOL Multiphysics Server

llzername: paunl

[Passuwom

[Conf irm password:

Port number 2836 was busy, using 2038 instead

ICOMS0L Multiphysics Server started listening on port 28038
llze the console command ‘close’ to exit the program

The figure below shows how to connect to a server session from the COMSOL
Desktop user interface. To connect, from the File menu, select COMSOL
Multiphysics Server > Connect to Server.

2 D& >

Home  Definitions  Geometry  Materials ~ Physics  Mesh  Study  Results  Develop
™ New Cri+N 2= Variables - W & Import
I 5 mm
&) Run Application fi) Functions - )
meters Build
Open Ctrl+0 7 All v

Recent L

[ Application Libraries

O Save Ctrl+5
Save As

2| Revert to Saved

| Compact History

COMSOL Multiphysics Server » == Connectto Server
Help ’ Disconnect from Server
j‘ Licensed and Used Products Import Application from Server

(=] Pratcidnens Remove Applications from Server

Ed it

You are now prompted for the username and password that you gave the first time
you started a server session.

3 Connect to COMSOL Multiphysics Server X
Server User

Server: | myserver.address.com Username: | paul

Port: Default M Password: | esssss

Remember username and password

oK Cancel
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For more information on running the COMSOL Multiphysics client-server, see
the Reference Manual.
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Appendix A — Building a Geometry

This section details how to create the busbar geometry using the built-in geometry
tools in COMSOL Multiphysics. The step-by-step instructions take you through
the construction of the geometry using the parameters set up in the Global
Definitions scction.

All geometry operations under the geometry node in the model tree are organized
in a parametric sequence of operations called a geometry sequence. Using
parameterized dimensions helps to produce what-if analyses and geometric
parametric sweeps.

As an alternative to building the geometry using the tools available in COMSOL
Multiphysics, you can import a geometry created with CAD software. The
optional CAD Import Module and Design Module support many CAD file
formats. Moreover, several add-on products are available that provide
bidirectional interfaces to common CAD software packages. See “Appendix E —
Connecting with LiveLink™ Add-Ons” on page 206 for a list. Note that the
Design Module, in addition to the features available in the CAD Import Module,
adds 3D functionality for dimensions, constraints, loft, fillet, chamfer, midsurface,
and thicken.

If you have not done so already, start with “Example 2: The Busbar — A
Multiphysics Model” on page 62. Follow the steps in the section “Model Wizard”
on page 36 to add the physics and study and then follow the steps under Global
Definitions to add the parameters. Return to this section to learn about geometry
modeling. The first step in the geometry sequence is to draw the profile of the
busbar.
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I Under Component I, right-click
Geometry | » and sclect Work Plane = .

In the Settings window for Work Plane: Work Plane
2 % Build Selected » [E Build All Objects =1}

- Sclect xz-plane from the Plane list (the
last option in the list).

- Click the Show Work Plane button £

Label: Work Plane 1 =

¥ Plane Definition

on the Settings window for Work Planetyper | Quick -
| ] -pl -
Plane toolbar. G Elars = elang
. .. . . Offset type: Distance -
Continue by editing the axis and grid .
y-coordinates 0 m

settings in Work Plane 1.

2 In the Model Builder, expand the View 2
node v and click Axis 1.

Local Coordinate System
¥ Unite Objects

Unite objects

a A Geometry 1 Repair tolerance: | Automatic v
4 [E] Work Plane1 (wpl)

, Plane Geometry ¥ Selections of Resulting Entities
A | View 2
[%Y Axis 6 ["] Resulting objects selection
* Form Union (fin) Show in physics: | Boundary selection
Color: | Mone &

Selections from plane geometry
[] Show in physics
Cumulative selection

Contribute to: | None = Mew
3 In the Settings window for Axis: -
Settings T
Under Axis: s
- In the x minimum and y minimum ® Update G
fields, enter -0.01. Label:  Auis =

- In the x maximum and y maximum e NG
fields, enter 0.11.

xminimum:  -0.01 i
Under Grid: xmaximum: 0.1 m
- Select the Manual Spacing check box. Y™™ %9 "
y maximum: 0.1 m
- In the x spacing and y spacing fields, P =
enter 5e-3. .
. > Grid
4 Click the Update button & on the _
Manual spacing
toolbar. -
xspacing:  5e-3 m
Note that the values you type will y spacing: 5e-3 m
al}tomatlcally adjust slightly after you . [
click Update to adapt to the screen
Extra y: m k]

aspect ratio.
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You can use interactive drawing to create a geometry using the drawing tools from
the Sketch tab in the ribbon while pointing and clicking in the Graphics window.

2 ODeEE > Y W ON A -
File Home  Work Plane  Sketch  Developer  View 2
P . Snap to Grid | |_,—| Solfd| .___.-—I ( = ._."' 7 Quadratic ’j
" |IZ] Snap to Geometry i - = £/ Cubic =
Sketch : Polygon Circular Interpolation . Rectangle Circle
l—gCUnstraln Arc Curve ~ = Point - -
Sketch Draw Settings Draw

You can also right-click the Plane Geometry node » under Work Plane 1 = to add
geometry objects to the geometry sequence. Note that you can add geometry
objects in the same way from the Work Plane tab in the ribbon. For clarity, this
example will demonstrate the non-interactive way of creating the geometry (not

using the Sketch tab).
In the next few steps, we create a profile of the busbar.

5 In the Model Builder under Work Plane 1, right-click Plane Geometry
Rectangle .

In the Settings window for Rectangle

under Size, enter: Settings

. . lectangle
- L+2*tbb in the Width field. B BuinSeIected ~ [ Build All B
- 0.1 in the Height ficld. Label: Rectangle

Click the Build Selected button & . B —

Type: | Solid

¥ Size and Shape

e Width:  L+2%tbb

Height: 0.1
¥ Position

Base: | Corner
pas 0

yw: 0
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6 Create a second rectangle. Under

Work Plane |, right-click Plane T
Geometry . and sclect Rectangle . ecang e a
d s ¥ Build Selected ~ [E§ Build All 2§
Under Size, enter:
. Label: Rectangle 2 =
- L+tbb in the Width field
. . ¥ Object Type
- 0.1-tbb in the Height field. e e
Type: | Solid -
Under Position, enter: L
. - ~ Size and sh
- tbb in the yw ficld. Sool S
. . G Width: L+tbb m
Click the Build Selected button & .
Height: 0.1-tbb m
Use the Boolean Difference operation ——
to subtract the second rectangle from -
the first one. Bose - e
KWL u m
7 Under Work Plane 1, right-click Plane tbb
W m

Geometry . and sclect Booleans and

Partitions > Difference . In the

Graphics window, click r1 (the larger of the two rectangles) to add it to the
Objects to add list in the Settings window for Difference.

To help select the geometry, you can display geometry labels in the
Graphics window. In the Model Builder under Geometry | > WorkPlane 1,
click the View 2 node. Go to the Settings window for View and select the
Show geometry labels check box.
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8 Click the Difference node. In the
Settings window for Difference, click the
Active selection button to the left of the
Objects to subtract list. Select the
smaller rectangle, r2, by using the Label: Difference 1 =
mouse scroll wheel or arrow keys to
cycle through the overlapping
rectangles to first highlight it and then

1% Build Selected | v | [ Build All &

~ Difference

Objects to add:

. . : il eS|
click on it to select it. e 0= B -
Click Build Selected = . & N
Another way to select r2 in the
Graphics window is to use the Selection
List feature. Go to the Home tab in the Obiects to subtract. !
ribbon and select Windows > Selection i D:_u o B
List. In the Selection List, click to 0 ' B -
highlight r2 (solid). Then, right-click & 5

r2 (solid) in the list and select Add to
Selection to add it to the Objects to
subtract list. Right-click on the
Selection List window title and select
Close.

After building the selected geometry, you should have a backward-facing,
L-shaped profile. Continue by rounding the corners of the L-shaped profile.
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9 Under Work Plane I, right-click Plane Geometry . and select Fillet

Select point 3 (in the inner-right corner) to add it to the Vertices to fillet list.

There are different ways to add points:

- In the Graphics window, click point 3 to add it to the Vertices to fillet list.

- From the Home tab, sclect Windows > Selection List. In the Selection List
window, click 3. The corresponding point is highlighted in the Graphics
window. Click the Add to Selection button -+ in the Settings window for Fillet
or right-click in the Selection List.

Settings -

& Build Selected « [E8 Build All
Label: Fillet1

¥ Points

Wertices to fillet:

e Adif13 N

Active

¥ Radius

@ Radius:  thb m

10 Enter tbb in the Radius field. Click Build Selected & .

This creates a fillet at the inner corner.

| 167



11 For the outer corner, right-click Plane
Geometry  and sclect Fillet |

12 In the Graphics window, click point 6, B Build Selected + [ Build Al
the outer corner, to add it to the tobet [Filct2
Vertices to fillet list.
¥ Points

I3 Enter 2*tbb in the Radius field. Click
Build Selected = .

Wertices to fillet:

@ m 4 fill
3

Active

¥ Radius
G Radius:  2*tbb

The result should match this figure:

In the Design Module you will find tools for interactive drawing and
dimensioning of fillets and general 2D sketches.

Next, extrude the work plane to create the 3D busbar geometry.

168 |



In the Model Builder, right-click Work Plane | = and select Extrude . In the
Settings window for Extrude, enter wbb in the Distances from Plane table (replace
the default) to extrude to the width of the profile.

¥ Distances

Specify: Distances from plane -

wo
Distances (m)

G whb
Y H

The table allows you to enter several values in order to create sandwich
structures with different materials. In this case, only one extruded layer is
needed.

Click Build Selected = and then click the Zoom Extents [&] button on the Graphics

toolbar. Click the Save button 17 and name the model busbar.mph (if you have
not already done so).

Next, create the titanium bolts by extruding two circles drawn in two work
planes.
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3 In the Model Builder, right-click Geometry | » and add a Work Plane = . A Work
Plane 2 node is added. In the Settings window for Work Plane, under Plane
Definition, sclect Face parallel as the Plane type.

Model B

-= 1 | ==t

4 & busbar.mph (root)
4 () Global Definitions

unaer

Pi Parameters 1 Label: Work Plane 2 =
== Materials —
4 T Component 1 (compT) ¥ Plane Definition
| = Definiions Plane type: Face parallel - e
4 A Geometry 1
b 8 WorkPlane 1 (wp 1) Planar face:
[l Bxtrude 1 (ext1)
e 4[] Work Plane 2 (wp2)
A\ Plane Geometry
Lt Views N @

4 In the Graphics window, click face 8, as shown in the figure below, to add it to
the Planar face list in the Settings window for Work Plane.

Face 8 is now highlighted in blue and the work plane is positioned on top of the
face.

5 Click the Show Work Plane button § to star drawing the first circle representing
the position of the first bolt. Click the Zoom Extents button [# on the Graphics
toolbar.
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6 Under Work Plane 2, right-click
Plane Geometry . and sclect Circle

In the Settings window for Circle:

. . ettings s
- Under Size and Shape, in the T
Radius ficld, enter rad_1. ¥ Build Selected ~ 8 Build Al
- Under Position, lcave the default N cle 1

xw and yw coordinates (0, 0).
Click Build Selected & .

¥ Object Type

Type: | Solid -
G ¥ Size and Shape

Radius: rad_1 m

Sectorangles 360 deg
G ¥ Position

Base: Center =

o 0 m

yw: 0 m

Continue creating the bolt by adding
an extrude operation.
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I In the Model Builder, right-click Work Plane 2 « and select Extrude = . In the
Settings window for Extrude, in the first row of the Distances from Plane table,
enter -2*tbb to extrude the circle.

Model Builder
— + = Et
4 & busbar.mph (root)

4 () Global Definitions

Fi Parameters 1

4

2 Materials
4 |§ Component1 (comp1)
[ = Definitions
4 \)\ Geormnetry 1
b+ & WorkPlane 1 fwp1)
L_,.!, Extrude 1 {ext?)
4 5 Work Plane 2 (wp2)
P \)\ Plane Geametry
Circle 1 (c7)
bl View 3
Extrude 2 (ext2)
* Form Unien (fin)
2 Materials
[ +\_ Electric Currents {ec)
I» |[E Heat Transfer in Solids (ht)
3 .{;3. Multiphysics
A5 Mesh 1
[~ Study 1
b {8 Results

At At
[ Build Selected = [E8 Build All Objects 2
Label: Extrude2 =
¥ General
Extrude from: Work plane =
Work plane: Work Plane 2 (wp2) - E

Input chjects:

wpz 5
'T] —

Input cbject handling: Unite with =
~ Distances
Specify: Distances from plane =

L]
Distances (m)

[-2*tbb ] 0

2 Click the Build Selected button m to create the cylindrical part of the titanium
bolt that runs through the busbar.

Draw the two remaining bolts.
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Right-click Geometry | . and select Work Plane = . A Work Plane 3 node is
added. In the Settings window for Work Plane, for Work Plane 3, sclect Face
parallel as the Plane type.

In the Graphics window, click face 4, as shown in the figure, to add it to the
Planar face list in the Settings window for Work Plane.

005 m 6

Click the Show Work Plane button £ on the Settings window for Work Plane and
the Zoom Extents button [# on the Graphics toolbar to get a better view of the
geometry.

To parameterize the position of the two remaining bolts, add the circles that
form the cross sections of the bolts.
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6 Under Work Plane 3, right-click Plane Geometry »» and select Circle .

In the Settings window for Circle:

- Under Size and Shape, enter rad_1
in the Radius field.

- Under Position, enter
-L/2+1.5[cm] in the xw field and
-wbb/4 in the yw field.

Click Build Selected & .

©

Copy the circle that you just created
to generate the third bolt in the
busbar.

7 Under Work Plane 3, right-click Plane c
Geometry . and sclect Transforms >

Copy (&

8 In the Graphics window, click the
circle ¢1 to select and add the circle
to the Input objects list in the
Settings window for Copy.

9 In the Settings window for Copy

under Displacement, enter wbb /2 in
the yw field.

©

W
e yw: whhb/2
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Settings

rcle

Build Selected ~ [E§ Build All 2§

WL

Label: Circle 1
¥ Object Type
Type: | Solid
¥ Size and Shape

Radius: rad_1

Sectorangle: 360
¥ Position

Base: | Center
we -L/2+1.5[em]
yw:  -whb/4

Settings

¥ Build Selected ~ [E§ Build All 2§
Label: Copy1

¥ Input

Input chjects:

= -

Keep input objects
¥ Displacement

Specify: | Displacement vector

0

m L‘:rJ

m L‘:rJ



10 Click Build Selected = and click the Zoom Extents button [#] on the Graphics

toolbar.

Your geometry, as shown in the work plane, should match this figure so far.

Bl e 8@ EE «2@- 0T

-8

al

a5 Tans 0.03 0.0 001 1)

Continue by extruding the circles.

T
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Il In the Model Builder, right-click Work Plane 3 « and select Extrude = . In the
Settings window for Extrude, in the first row of the Distances from Plane table,
enter -2*tbb (replace the default). Click Build All Objects & .

Model Builder ~ *|| Settings v
== = ETE =~ Extrude
4 & busbar.mph (root) [ Build Selected = [E8 Build All Objects 2
4 () Global Definitions
P; Parameters 1 Label: Extrude 3 E
2 Materials
4 |§ Component1 (comp1) v General
’ .E Definitions Extrude from: Waork plane -
4 }7\ Geormnetry 1
[ E Work Plane 1 {wp1) Work plane: Work Plane 3 (wp3] - E

LC_\\‘D Extrude 1 {ext?)
4 5 Work Plane 2 (wp2)
- }7\ Plane Geornetry &=
Circle 1 (c7)
bl View 3
LC_\\‘D Extrude 2 {ext3)
4 2 Work Plane 3 (wp3)
- }7\ Plane Geornetry
(=) Circle 1 {c7)

Input chjects:

= Input cbject handling: Unite with =
Copy 1 (copy?) P J 9
bl View 4 .
m Extrude 3 (ext3) =~ DEENES

* Form Unien (fin)
235 Materials
+\_ Electric Currents {ec) " Distances (m)
\[E Heat Transfer in Solids (ht) 2*tbb
.'&. Multiphysics

Specify: Distances from plane =

- v v

The geometry and geometry sequence should match the figures below. Click
the Save button © and name the model busbar.mph.
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Creating Parts and Using the Part Libraries

After setting up the busbar or other geometry model, it is convenient to be able
to save it for future use, avoiding unnecessary work. In the steps you have just
completed, the geometry was stored directly in the COMSOL model file that will
also be used to set up the complete busbar model. Instead, you can also create a
reusable and parameterized part that can serve as a building block of a more
complex COMSOL model geometry, which is stored in a separate file accessible
through the Part Libraries.

While building the busbar geometry, you were using features from the Geometry
and Workplane tabs. A Parts menu is located in the Other group in these tabs.

7] Chamfer
¥ Fillet
Conversions Parts |Programming
- [ Delete - -
A Create Part

&% Load Part

ot [fifi = Part Libraries b M E

Through the Parts menu, you can choose to create or load a part, or add a part to
the model geometry by selecting one from the Part Libraries. Several Part
Libraries are already provided with the software by default. When new parts are
created, they are added under a part’s parent node in the Global Definitions section
of the model tree.
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The figure below shows an Internal Helical Gear part from the part library of the
Multibody Dynamics Module. The part comes with 18 Input Parameters that
control the dimensions.

For additional information on working with parts and the Part Libraries, see the
Reference Manual.

To continue with the busbar tutorial, return to the section “Materials” on
page 75.
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Appendix B— Keyboard and Mouse Shortcuts

These shortcuts are primarily applicable to the Model Builder and the Graphics
window. For information on shortcuts in the Application Builder, see the
Introduction to Application Builder.

SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

FI (Fn+FI on certain tablets)

Ctrl+F|

F2

F3
F4
F5

Fé

F7

F8

Del

Fl

Command-+Fl

F2

F3
F4
FS

Fé6

F7

F8

Del

Display help for the selected node
or window

Open the COMSOL
Documentation front page in an
external window

Rename the selected node, file, or
folder

Disable selected nodes
Enable selected nodes

Update the Datasets Solutions with
respect to any new Global
Definitions and Definitions without
re-solving the model

Build the preceding node in the
geometry branch or plot the
previous plot for a time-dependent,
eigenfrequency, or eigenvalue
solution.

Build the selected node in the
geometry and mesh branches,
compute the selected study step,
compute the selected node in the
solver sequence, or plot the next
plot for a time-dependent,
eigenfrequency, or eigenvalue
solution.

Build the geometry, build the mesh,
compute the entire solver sequence,
update results data, update the plot,
or run a method call.

Delete selected nodes, objects, or
rows in a table
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Escape (Esc)

Left arrow (Windows); Shift +
Left arrow (Linux)

Right arrow (Windows); Shift
+ Right arrow (Linux)

Up arrow

Down arrow

Alt+left arrow

Alt+Right arrow

Ctr+A

Ctrl+C
Ctrl+D

Ctrl+Shift+D

Ctrl+F
Ctrl+G
Ctrl+Shift+G
Ctrl+K

Ctri+L
Ctrl+N
Ctrl+O
Ctrl+P

Ctrl+S
Ctrl+V
Ctrl+X
Ctrl+Y

Escape (Esc)

Left arrow

Right arrow

Up arrow

Down arrow

Ctri+left arrow

Ctrl+Right arrow

Command+A

Command+C

Command+D

Command+Shift+D

Command-+F
Command+G
Command+Shift+G

Command-+L
Command+N
Command+O

Command+P

Command+S
Command+V
Command+X

Ctri+Shift+Z

Cancel ongoing interactive 2D
drawing and 3D clipping operations.

Collapse a branch in the model tree

Expand a branch in the model tree

Move to the node above in the
model tree

Move to the node below in the
model tree

Move to the previously selected
node in the model tree

Move to the next selected node in
the model tree

Select all domains, boundaries,
edges, or points; Select all cells in a
table

Copy text or objects

Clear the selection of domains,
boundaries, edges, or points

Duplicate the selected node in the
model tree

Find a search string
Group nodes.
Ungroup nodes.

Create shortcut for use in the
Application Builder

Take a quick image snapshot.
New model
Open a model file

Print the contents of the plot
window

Save a model file
Paste copied text or object
Cut copied text or object

Redo the last undone operation
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Ctri+Z

Ctrl+Up arrow

Ctrl+Down arrow

Ctrl+Tab

Ctrl+Shift+Tab

Ctrl+Shift+A
Ctrl+Shift+M
Ctrl+Alt+Left arrow

Ctri+Alt+Right arrow

Ctri+Alt+Up arrow

Ctri+Alt+Down arrow

Ctri+F4

Shift+F10 or
(Windows only) Menu key

Ctrl+Space or Ctrl+/

Left-click and hold down the
mouse button while dragging
the mouse.

Right-click and hold down the
mouse button while dragging
the mouse.

Command+Z

Command+Up arrow

Command+Down
arrow

Ctrl+Tab

Ctrl+Shift+Tab

Not available
Not available

Command+Alt+Left
arrow

Command+Alt+Right
arrow

Command+Alt+Up
arrow

Command+Alt+Dow
n arrow

Command+W

Ctrl+FI0

Ctrl+Space

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Undo the last operation

Move a definitions node, geometry
node, physics node (except default
nodes), material node, mesh node,

study step node, or results node up
one step

Move a definitions node, geometry
node, physics node (except default
nodes), material node, mesh node,
study step node, or results node
down one step

Switch focus to the next window on
the desktop

Switch focus to the previous
window on the desktop

Go to Application Builder
Go to Model Builder

Switch focus to the Model Builder
window

Switch focus to the Settings window.

Switch focus to the previous section
in the Settings window.

Switch focus to the next section in
the Settings window.

Close the active window in
COMSOL Desktop, if it is closable.

Open the context menu.

Open list of predefined quantities
for insertion in Expression fields.

Rotate the scene around the axes
parallel to the screen’s x- and y-axes
with the origin at the scene rotation
point.

Move the visible frame on the image
plane in any direction (pan).
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

Middle-click outside model and
hold down the mouse button
while dragging the mouse.
Press Ctrl and left-click. While
holding down the key and
button, drag the mouse.

Press Ctrl and right-click. While
holding down the key and
button, drag the mouse.

Press Ctrl and middle-click.
While holding down the key
and button, drag the mouse.

Press Ctrl and middle-click.

Press Ctrl+Alt and left-click.
While holding down the keys
and button, drag the mouse.
Press Alt and left-click. While
holding down the key and
button, drag the mouse.

Press Alt and right-click. While
holding down the key and
button, drag the mouse.

Press Alt and middle-click.
While holding down the key
and button, drag the mouse.

Middle-click on model.

Press X, Y, or Z and left-click.
While holding down the key
and button, drag the mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

Same as for Windows;
only available for
two-button mouse.

The scene is zoomed in/out around
the mouse position where the
action started.

Tilt and pan the camera by rotating
about the x- and y-axes in the image
plane.

Move the camera in the plane
parallel to the image plane.

Move the camera into and away
from the object (dolly in/out).

Zoom to the area around the point
on the model determined by the
mouse position.

Rotate the objects in the scene
about the camera look-at direction

Rotate the objects in the scene
about the axis that intersects the
camera origin and the scene’s
rotation center (roll direction)

Move the scene in the plane
orthogonal to the axis between the
camera and the scene rotation
point.

Move the camera along the axis
between the camera and the scene
rotation point.

Set the center of rotation.

Rotate around the X, Y, or Z-axis,
respectively.
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SHORTCUT (WINDOWS, LINUX)

SHORTCUT (MACOS)

ACTION

R

+ or - keyboard button alt.

Up arrow or Down arrow
button

R

+ or - keyboard
button alt.

Up arrow or Down
arrow button

Toggle between manual and
automatic rotation center.

Cycle between geometric entities
(domains, boundaries, edges, points)
for selection. When focus is in the
graphics window.
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Appendix C — Language Elements and Reserved Names

Building a model tree in COMSOL Multiphysics is equivalent to graphically
programming a sequence of operations. Using the Record Code functionality in
the Application Builder or saving as a model file for MATLAB® or Java® outputs
the sequence of operations as a list of traditional programming statements. In this
section, we will give an overview of the following element categories as defined by
the underlying COMSOL language:

e Constants
e Variables

e Functions
¢ Operators

» Expressions

These language elements are built-in or user-defined. Operators cannot be
user-defined. Expressions are always user-defined.

ABOUT RESERVED NAMES

Built-in elements have reserved names, names that cannot be redefined by the
user. If you try to use a reserved name for a user-defined variable, parameter, or
function, the text where you enter the name will turn orange and you will get a
tooltip error message if you select the text string. Reserved function names are
reserved only for function names, which means that such names can be used for
variable and parameter names and vice versa. In the following pages, we list the
most commonly used built-in elements and hence those reserved names. A more
exhaustive list of built-in elements can be found in the Programming Reference
Manual and the Application Programming Guide.

VARIABLES USED IN APPLICATIONS

Model parameters and variables can be used in applications. For example, you can
let the user of an application change the value of'a parameter. In addition, variables
to be used in applications can be defined in the Application Builder under the
Declarations node. Such variables are available globally in form objects and
methods but cannot be used in the Model Builder.
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Constants and Parameters

There are three different types of constants accessible from the Model Builder:
built-in mathematical and numerical constants, built-in physical constants, and
parameters. Parameters are user-defined constants, which can vary over parameter
sweeps. Constants are scalar valued. The tables below list the built-in
mathematical and numerical constants as well as built-in physical constants.
Constants and parameters can have units.

BUILT-IN MATHEMATICAL AND NUMERICAL CONSTANTS

DESCRIPTION NAME VALUE

Floating point relative accuracy for double eps 22 (~2.2204-1 0! 6)
floating point numbers, also known as
machine epsilon

The imaginary unit i, ] i,sqrt(-1)

Infinity, oo inf, Inf A value larger than what
can be handled with
floating point
representation

Not-a-number NaN, nan An undefined or
unrepresentable value,
such as the result of 0/0
orinf/inf

T pi 3.141592653589793
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BUILT-IN PHYSICAL CONSTANTS

DESCRIPTION NAME VALUE

Acceleration of gravity g_const 9.80665[m/s"2]

Avogadro constant N_A const 6.02214076e€23[1/mol]
Boltzmann constant k_B_const 1.380649¢e-23[J /K]
Characteristic impedance  Z0_const 376.73031346177066[ ohm]
of vacuum (impedance of

free space)

Electron mass me_const 9.10938291e-31[kg]
Elementary charge e_const 1.602176634e-19[C]
Faraday constant F_const 96485.3365[C/mol]

Fine-structure constant
Gravitational constant

Molar volume of ideal gas
(at 273.15 Kand | atm)

Neutron mass

Permeability of vacuum
(magnetic constant)

Permittivity of vacuum
(electric constant)

Planck’s constant

Planck’s constant over 2 pi
Proton mass

Speed of light in vacuum

Stefan-Boltzmann
constant

Universal gas constant

Wien displacement law
constant

alpha_const
G_const

V_m_const

mn_const

mu0_const

epsilon0_const

h_const
hbar_const
mp_const
c_const

sigma_const

R_const

b_const

7.2973525698e-3
6.67384e-11[m"3/ (kg*s~2)1]
2.2413968e-2[m"3/mol]

1.674927351e-27[kg]

2*alpha_const*h_const/c_const/
e_const/e_const

1/mu0_const/c_const/c_const

6.62607015e-34[J*s]
1.05457172533629¢e-34[J*s]
1.672621777e-27[kg]
299792458[m/s]
5.670373e-8[W/ (M 2*K"4)]

8.3144621[J/ (mo1*K) ]
2.8977721e-3[m*K]

PARAMETERS

Parameters are user-defined constant scalars in the Global Definitions branch in the
model tree. Example uses are:

o Parameterizing geometric dimensions

+ Parameterizing mesh element sizes
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* Defining parameters to be used in parametric sweeps

A parameter can be defined as an expression in terms of numbers, parameters,
built-in constants, and built-in functions of parameters and built-in constants.
Parameters should be assigned a unit, using [ ], unless they are dimensionless.

Variables

There are two types of variables used in the Model Builder: built-in and
user-defined. Variables can be scalars or fields. Variables can have units.

Note: Spatial coordinate variables and dependent variables are user-defined
variables of special interest. These variables have default names based on the space
dimension of the geometry and the physics interface, respectively. As a result of
the names chosen for these variables, a list of built-in variables will be created by
COMSOL Multiphysics: the first- and second-order derivatives with respect to
space and time.

| 187



BUILT-IN VARIABLES

NAME
curv

curvi,curv2

dom

dvol

freq

geomapproxdist

hinscribed
lambda

linearizedelem

numberofdofs

meshelement
meshelementall

meshtype

meshvol
nx,ny,nz

phase

qual, qualcondition,
qualcurvedskewness,
qualgrowth,
qualmaxangle,
qualskewness,
qualvollength

DESCRIPTION
The curvature of a boundary in 2D

The principal curvature components of a
boundary in 3D

The domain number for a domain, boundary,
edge, or point

Volume scale factor variable; This is the
determinant of the Jacobian matrix for the
mapping from local (element) coordinates to
global coordinates.

Frequency

For each element, this variable indicates how far a
node point in each element was moved from the
geometry.

Mesh element size (length of the longest edge of
the element)

Element inscribed diameter

Eigenvalue

Elements forced to be linear

Number of degrees of freedom

Mesh element number, per type
Mesh element number

Mesh type index for the mesh element; This is the
number of edges in the element.

Volume of the (linearized) element
Normal component for boundaries

Phase angle

Mesh quality measures

Field
Field

Field

Field

Global
variable

Field

Field

Field

Global
variable

Field

Global
variable

Field
Field
Field

Field
Field

Global
variable

Field
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realdetjac The determinant of the Jacobian matrix for the Field
mapping from a straight mesh element to the
possibly curved element used when solving. Use
this variable to measure the difference in shape
between a curved element and the
corresponding straight element.

realdetjacmin A scalar field variable for each element defined as  Field
the minimum value of the reldetjac variable
for the corresponding element.

A reldetjacmin value less than zero for an
element means that the element is wrapped
inside-out; that is, the element is an inverted
mesh element.

s,s1,s2 Curve and surface parameterization variables Field

t Time Global
variable

tcurvx, tcurvy,tcurvix, Tangential directions for the corresponding Field

curvly,tcurviz,tcurv2x, curvature variables
tcurv2y,tcurv2z

tx,ty,tix,tly,t1z, Tangent vector components corresponding to the  Field
t2x,t2y,t2z curve and surface parameterizations
qual A mesh quality measure between O (poor quality)  Field

and | (perfect quality)

USER-DEFINED VARIABLES THAT GENERATE BUILT-IN VARIABLES

DEFAULT NAME DESCRIPTION TYPE
X, Y, Z Spatial coordinates (Cartesian) Field
r, phi, z Spatial coordinates (Cylindrical) Field
u, T, etc. Dependent variables (Solution) Field

Example: T is the name for the temperature in a 2D, time-dependent heat transfer
model; x and y are the spatial coordinate names. In this case, the following built-in
variables will be generated: T, Tx, Ty, Txx, Txy, Tyx, Tyy, Tt, Txt, Tyt, Txxt, Txyt,
Tyxt, Tyyt, Ttt, Txtt, Tytt, Txxtt, Txytt, Tyxtt, and Tyytt. Here, Tx
corresponds to the partial derivative of the temperature T with respect to x and Ttt
corresponds to the second-order time derivative of T, and so on. If the spatial
coordinate variables have other names — for example, psi and chi — then Txy
would be Tpsichi, and Txt would be Tpsit. (The time variable t is built-in; the
user cannot change its name.)
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Functions

In the Model Builder, there are two types of functions: built-in and user-defined.
Functions can be scalar valued or field valued depending on the input
argument(s). Some functions can have units for both input and output arguments.

BUILT-IN MATHEMATICAL FUNCTIONS

These functions do not have units for their input or output arguments.

NAME DESCRIPTION SYNTAX EXAMPLE
abs Absolute value abs(x)

acos Inverse cosine (in radians) acos(x)
acosh Inverse hyperbolic cosine acosh(x)
acot Inverse cotangent (in radians) acot(x)
acoth Inverse hyperbolic cotangent acoth(x)
acsc Inverse cosecant (in radians) acsc(x)
acsch Inverse hyperbolic cosecant acsch(x)

arg Phase angle (in radians) arg(x)

asec Inverse secant (in radians) asec(x)
asech Inverse hyperbolic secant asech(x)
asin Inverse sine (in radians) asin(x)
asinh Inverse hyperbolic sine asinh(x)
atan Inverse tangent (in radians) atan(x)
atan2 Four-quadrant inverse tangent (in radians) ~ atan2(y,x)
atanh Inverse hyperbolic tangent atanh(x)
besselj Bessel function of the first kind besselj(a,x)
bessely Bessel function of the second kind bessely(a,x)
besseli Modified Bessel function of the first kind besseli(a,x)
besselk Modified Bessel function of the second kind besselk(a,x)
binomial Binomial coefficients binomial(n,k)
ceil Nearest following integer ceil(x)

conj Complex conjugate conj(x)

cos Cosine cos(x)

cosh Hyperbolic cosine cosh(x)

cot Cotangent cot(x)
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NAME

DESCRIPTION

SYNTAX EXAMPLE

coth

csc

csch

erf
erfinv
exp
factorial
floor
gamma
imag
legendre
legendre
log
log10
log2

max

min

mod

psi
random
randomnormal
range
real
round
sec

sech
sign

sin

sinh
sqrt
sphericaly

sphericalyr

Hyperbolic cotangent
Cosecant

Hyperbolic cosecant

Error function
Inverse error function
Exponentia
Factorial of nonnegative integer
Nearest previous integer
Gamma function

Imaginary part

Legendre polynomials
Associated Legendre functions
Natural logarithm

Base-10 logarithm

Base-2 logarithm

Maximum of two arguments
Minimum of two arguments
Modulo operator

Psi function and its derivatives
Random function, uniform distribution
Random function, normal distribution
Create a range of numbers
Real part

Round to closest integer
Secant

Hyperbolic secant

Signum function

Sine

Hyperbolic sine

Square root

Spherical harmonic function

Real spherical harmonic function

coth(x)

cSsC(X)

csch(x)

erf(x)
erfinv(x)
exp(x)
factorial(n)
floor(x)
gamma(x)
imag(u)
legendre(1,x),
legendre(l,m,x)

log(x)

random(X,y,...)

randomnormal (X,y, ...

range(a,step,b)

real(u)

round(x), round(x,p)

sec(x)
sech(x)
sign(u)
sin(x)
sinh(x)

sqrt(x)

sphericaly(1l,m,theta,phi)
sphericalyr(1l,m,theta,phi)




NAME DESCRIPTION SYNTAX EXAMPLE

tan Tangent tan(x)
tanh Hyperbolic tangent tanh (x)
zernike Zernike polynomials zernike(n,m,r,phi)

BUILT-IN OPERATOR FUNCTIONS

These built-in functions behave differently than the built-in mathematical
functions. They may not belong in an introductory text but are listed to complete
the list of reserved names. For more information, see the Reference Manual.

NAME NAME NAME NAME
adj depends linsol sphint
at dest lintotal stddev
atlocal dflux lintotalavg subst
atonly diskavg lintotalpeak sum

ato diskint lintotalrms test
ati down linzero timeavg
at2 dtang mean timeint
at3 elemavg nif timemax
atentO elemgpmax nojac timemin
atent1 elemgpmin noenv treatasconst
atent2 elemint novar try_catch
atent3 emetric noxd uflux
attimemax env pd up
attimemin error ppr var
atxd fsens pprint with
atxdo fsensimag prev withsol
atxdi gpeval reacf

atxd2 if realdot

atxd3 integrate residual

ballavg isdefined scope.atenti

ballint isinf scope.ati

bdf islinear sens

bndenv isnan setconst

centroid jacdepends setind
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NAME NAME NAME NAME
circavg laginterp setval

circint lindev shapeorder
circumcenter linper side

d linpoint sphavg

USER-DEFINED FUNCTIONS

A user-defined function can be defined in the model tree under the Global
Definitions node or, for each Component, under the Definitions node. Select a
template from the Functions menu and enter settings to define the name and

detailed shape of the function.

TEMPLATE NAME ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Analytic The function name is its identifier;
for example, ant.

The function is a mathematical
expression of its arguments.

Example: Given the arguments x
and vy, its definition is
sin(x)*cos(y).

The function has an arbitrary
number of arguments.

Elevation The function name is its identifier;
for example, elev1.

Used to import geospatial elevation
data from digital elevation models
and map the elevation data to a
function of x and y. A DEM file
contains elevation data for a portion
of the earth’s surface. The resulting
function behaves essentially like a
grid-based interpolation function.

The name of the function with
comma-separated arguments within
parentheses. For example:

ant(x,y)

The name of the function with
comma-separated arguments within
parentheses. For example:

elevi(x,y)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Gaussian Pulse

Image

Interpolation

The function name is its identifier;
for example, gp1.
The Gaussian pulse function defines
a bell-shaped curve according to the
expression
- xg)”
1 20°
e
oA2T

y(x)=

It is defined by the mean parameter,
Xq, and the standard deviation, ©.

The function has one argument.

The function name is its identifier;
for example, im1.

Used to import an image (in BMP,
JPEG, PNG, or GIF format) and map
the image's RGB data to a scalar
(single channel) function output
value. By default the function’s
output uses the mapping
(R+G+B)/3.

The function name is its identifier;
for example, int1.

An interpolation function is defined
by a table or file containing the
values of the function in discrete
points.

The file formats are the following:
spreadsheet, grid, or sectionwise.
The function has one to three
arguments.

The name of the function with a
single argument within parentheses.
For example:

gp1(x)

The name of the function with
comma-separated arguments within
parentheses. For example:

im1(x,y)

The name of the function with
comma-separated arguments within
parentheses. For example:

int1(x,y,z)
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TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Piecewise

Ramp

Random

Rectangle

Step

The function name is its identifier;
for example, pw1.

A piecewise function is created by
splicing together several functions,
each defined on one interval. Define
the argument, extrapolation and
smoothing methods, and the
functions and their intervals.

This function has one argument with
different definitions on different
intervals, which must not overlap or
have any holes between them.

The function name is its identifier;
for example, rm1.

A ramp function is a linear increase
with a user-defined slope that begins
at some specified time.

The function has one argument. It
can also be smoothed.

The function name is its identifier;
for example, rn1.

A random function generates white
noise with uniform or normal
distribution and has one or more
arguments to simulate white noise.
The function has arbitrary number
of arguments.

The function name is its identifier;
for example, rect1.

A rectangle function is 1 in an
interval and O everywhere else.

The function has one argument.

The function name is its identifier:
for example, step1.

A step function is a sharp transition
from 0 to some other value
(amplitude) at some location.

The function has one argument. It
can also be smoothed.

The name of the function with a
single argument within parentheses.
For example:

pw1 (x)

The name of the function with a
single argument within parentheses.
For example:

rmi (x)

The name of the function with
comma-separated arguments within
parentheses. For example:
rn1(x,y)

The arguments x and y are used as
random seeds for the random
function.

The name of the function with a
single argument within parentheses.
For example:

rect1(x)

The name of the function with a
single argument within parentheses.
For example:

step1(x)

| 195



TEMPLATE NAME

ARGUMENTS AND DEFINITION

SYNTAX EXAMPLE

Switch

Triangle

Waveform

The function name is its identifier:
for example, swi.

A switch is used to switch between
global functions during a solver
sweep. You add the functions as
subnodes under the Switch node.
The switch for functions acts
essentially as a switch statement in a
programming language; that is, it
dynamically chooses one of its
underlying branches depending on a
parameter that can be controlled
from the solvers using a Function
Sweep study. You can also add a
Switch node under Materials and
then use a Material Sweep to sweep
over a discrete set of materials.

The function name is its identifier:
for example, trit.

A triangle function is a linear
increase and linear decline within an
interval and 0 everywhere else.
The function has one argument. It
can also be smoothed.

The function name is its identifier;
for example, wv1.

A waveform function is a periodic
function with one of several
characteristic shapes: sawtooth, sine,
square, or triangle.

The function has one argument. It
can also be smoothed.

Switch is a container node for
functions.

The name of the function with a
single argument within parentheses.
For example:

tri1(x)

The name of the function with a
single argument within parentheses.
For example:

wv1(X)
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TEMPLATE NAME ARGUMENTS AND DEFINITION SYNTAX EXAMPLE

External (Global ~ An external function defines an The name of the function and the

Definitions only)  interface to one or more functions  appropriate number of arguments
written in the C language (which within parentheses. For example:
can be a wrapper function myextfunc(a,b)

interfacing source code written in,
for example, Fortran). Such an
external function can be used, for
example, to interface a user-created
shared library. Note that the
extension of a shared library file
depends on the platform: .dll
(Windows), .so (Linux), or .dylib

(macOs).
MATLAB® A MATLAB® function interfaces  The name of the function and the
(Global one or more functions written in appropriate number of arguments
Definitions only)  the MATLAB® language. Such within parentheses. For example:

functions can be used as any other  mymatlabfunc(a,b)
function defined in COMSOL

Multiphysics provided LivelLink™ for

MATLAB® and MATLAB® are

installed. (MATLAB® functions are

evaluated by MATLAB® at runtime.)

Unary and Binary Operators

In the Model Builder, the following table contains the unary and binary operators
that can be used in expressions.

PRECEDENCE LEVEL SYMBOL DESCRIPTION

| O {3} . Grouping, Lists, Scope

2 ~ Power

3 I -+ Unary: Logical NOT, Minus, Plus

4 [] Unit

5 * |/ Multiplication, Division

6 + - Binary: Addition, Subtraction

7 < <= > >= Comparisons: Less-Than, Less-Than or

Equal, More-Than, More-Than or Equal
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PRECEDENCE LEVEL SYMBOL DESCRIPTION

8 == l= Comparisons: Equal, Not Equal
9 && Logical AND
10 || Logical OR

Il , Element Separator in Lists

Expressions

PARAMETERS

A parameter expression can contain: numbers, parameters, built-in constants,
built-in functions of parameter expressions, and unary and binary operators.
Parameters can have units.

VARIABLES

A variable expression can contain: numbers, parameters, constants, variables,
functions of variable expressions, and unary and binary operators. Variables can
have units.

FUNCTIONS

A function definition can contain: input arguments, numbers, parameters,
constants, functions of parameter expressions, including input arguments, unary
and binary operators.
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Appendix D — File Formats

COMSOL File Formats

The COMSOL Model MPH file type, with the extension .mph, is the default file
type containing the entire model tree and application tree from the Model Builder
and Application Builder, respectively. The file contains both binary and text data.
The mesh and solution data is stored as binary data, while all other information is
stored as plain text.

The COMSOL binary and text file types, with the extension .mphbin and
.mphtxt, respectively, contain either geometry objects or mesh objects that can be
imported directly to the Geometry or Mesh nodes in the model tree. Note that if
one of the products CAD Import Module, Design Module, or one of the
LiveLink™ add-on products for CAD was used to create a geometry model then
the same product may be required to open the corresponding file. The reason is
that the geometry model may require features that are only available in one of the
add-on products.

The Physics Builder file type, with the extension .mphphb, contains one or more
user-defined physics interfaces that you can access from the Model Builder. See the
Physics Builder Manual for more information.

See Supported External File Formats for more information about all the other
formats supported by COMSOL Multiphysics.

FILE TYPE EXTENSION READ WRITE
COMSOL Model and Application .mph Yes Yes
Binary Data .mphbin Yes Yes
Physics Builder .mphphb Yes Yes
Text Data .mphtxt Yes Yes

Supported External File Formats

CAD

The CAD Import Module and Design Module allow for import of a range of
industry-standard CAD file types. Additional file types are available through the
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bidirectional functionality of the LiveLink products for CAD as well as with the

File Import for CATIA® V5 add-on.

The DXF (2D), VRML (3D), STL (3D), PLY (3D), and 3MF (3D) file types are
available for import with COMSOL Multiphysics and do not require any add-on
products. Unless noted otherwise in the table below, import of the listed file types

is available on all supported versions of Linux®

, macOS, and Windows® operating

systems.

FILE TYPE EXTENSION READ  WRITE
AutoCAD® 23 .dwg Yes Yes’
|r1ventor®| 2.3 .ipt,.iam Yes Yes9
Nx®! 4 .prt Yes  No
PTC® Creo® Parametric™ |3 prt,.asm Yes Yes’
PTC® Pro/ENGINEER® 3 .prt, .asm Yes  Yes
Revit® Architecture> .rvt Yes”  Yes’
Solid Edge®>® .par, .asm Yes”  Yes’
SOLIDWORKS®! 23 .sldprt, .sldasm Yes  Yes’
DXF 3D and 2D) .dxf Yes  Yes!O
Parasolid®I x_t,.xmt_txt,.x_b,.xmt_bin Yes Yes
ACIS®! .sat,.sab, .asat,.asab Yes Yes
STEPI .step, .stp Yes Yes
IGES! .iges, .igs Yes  Yes
CATIA® v527 .CATPart, .CATProduct Yes  No
VRML, v|8 .vrml, .wrl Yes No
STL .stl Yes Yes
3MF .3mf Yes No
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FILE TYPE EXTENSION READ WRITE

PLY .ply Yes No

|Requires one of the LiveLink™ products for AutoCAD®, Revit®, PTC® Creo® Parametric™,
Inventor®, PTC® Pro/ENGINEER®, Solid Edge®, SOLIDWORKS®, CAD Import Module, or
Design Module

2Impor“t supported on Windows® operating systems only

3Synchronization of files between COMSOL Multiphysics and a linked CAD program supported
on Windows® 7, 8, 8.1 and 10 operating systems only

4Impor“t supported on Windows® and Linux operating systems only

5Requires LiveLink™ for Revit®

6Requires LiveLink™ for Solid Edge®

7Requires the CAD Import Module (or the Design Module or one of the LiveLink™ products
for AutoCAD®, PTC® Creo® Parametric™, Inventor®, PTC Pro/ENGINEER®, Solid Edge®, or
SOLIDWORKS®) and the File Import for CATIA® V5

8 imited to a single geometric domain

IFrom/To file using linked CAD package, provided the original CAD geometry is created in the
CAD package

IO\/\/riting to file is supported for 2D geometry only

ECAD

The ECAD Import Module allows for import of 2D layout files with automatic
conversion to 3D CAD models. The Touchstone file type is used for exporting
S-parameters, impedance, and admittance values from simultaneous port and
frequency sweeps. The SPICE Circuit Netlist file type is converted at import to a
series of lumped circuit element nodes under an Electrical Circuit node.

FILE TYPE EXTENSION READ  WRITE
IPC-2581 .cvg, .xml Yes  No
ODB++ .zip,.tar,.tgz,.tar.gz Yes No
GDS! .gds Yes No
Touchstone? .s2p, .s3p,.s4p, ... No Yes
SPICE Circuit Netlist® .cir Yes  Yes

|Requires the ECAD Import Module
2Requires one of the AC/DC Module, RF Module, MEMS Module, or Wave Optics Module

3Requires one of the AC/DC Module, RF Module, MEMS Module, Plasma Module, or
Semiconductor Module
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MATERIAL DATABASES

The Chemical Reaction Engineering Module and the Plasma Module can read
CHEMEKIN® files to simulate complex chemical reactions in the gas phase. The
Plasma Module can read LXCAT files for sets of electron impact collision cross
sections.

FILE TYPE EXTENSION READ WRITE
CHEMKIN®! .dat, .txt,.inp’ Yes  No
CAPE-OPEN! (direct connection) n/a n/a n/a
LXCAT file .1xcat, .txt Yes  No

|Requires the Chemical Reaction Engineering Module or the Plasma Module. The Plasma
Module only supports thermodynamic and transport data.

2Requires the Plasma Module
3Any extension is allowed; These are the most common extensions

MESH

The NASTRAN® Bulk Data file types are used to import a volumetric mesh. The
VRML, STL, PLY, and 3MEF file types are used to import a triangular surface mesh
that can serve as a starting point for creating a volumetric mesh.

FILE TYPE EXTENSION READ  WRITE
3MF .3mf Yes Yes
NASTRAN® Bulk Data .nas, .bdf,.nastran,.dat  Yes  Yes
PLY -ply Yes Yes
Sectionwise (COMSOL) .txt,.csv,.dat Yes Yes
STL .stl Yes Yes
VRML, v .vrml, .wrl Yes No
VTK .vtu No Yes

IMAGES AND MOVIES

Results visualization can be exported to a number of common image file types; See
the table below. Images can also be read and used as interpolation functions for
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physics modeling. Animations can be exported to one of the Animated GIF,
Adobe® Flash®, and AVI file types.

FILE TYPE EXTENSION READ WRITE
Adobe® Flash® .swf No Yes
Animated GIF .gif No Yes
AVl .avi No  Yes
BMP .bmp Yes Yes
EPS (1D graphs only) .eps No Yes
GIF .gif Yes Yes
gITF™ .glb No Yes
JPEG -JPg, - jpeg Yes  Yes
MP4? .mp4 Yes  No
OGV? .ogv Yes  No
PNG .png Yes Yes
TIFF Ltif, Ltiff No Yes
WEBM .webm Yes No

! Available for Windows® only

2Available in the Application Builder, for Windows® only, in the video form object

PROGRAMMING LANGUAGES AND SPREADSHEET

Model files for Java® are editable files with the extension . java that contain
sequences of COMSOL commands as Java® code. Edit the files in a text editor to
add additional commands. You can compile these Java® files into Java® Class files
with the extension .class and run them as separate applications. Program code
used in model files for Java® is essentially identical to that of the Method editor in
the Application Builder. However, the Method editor comes with an integrated
Java® compiler.

Model files for MATLAB® are editable script files (M files), similar to the model
files for ]ava®, for use with MATLAB®. These model files, which have the
extension .m, contain a sequence of COMSOL commands as a MATLAB® M file.
You can run the model files in MATLAB® like any other M file scripts. It is also
possible to edit the files in a text editor to include additional COMSOL
commands or general MATLAB® commands. Running model files in the M file
format requires LiveLink™ for MATLAB®.

With a license for LiveLink™ for Excel®, you can save models on the Visual Basic
for Applications (VBA) format for use with Excel®.
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Compiled C-code can be linked with a model or application in several ways
including the External Material and External Function interfaces in the Model
Builder and as the External Library interface in the Application Builder.

FILE TYPE EXTENSION READ WRITE
MATLAB®: Model file for MATLAB® .m No Yes
MATLAB®: Function' .m Yes No
Java®: Archive file . jar‘(’ Yes No
Java®: Compiled model file forJava® .class Yes No
Java®: Model file forJava® .java No Yes
C: Function .d113, .304, .dylib5 Yes No
For‘tran7: Function .d113, .so4 Yes No
E><ce|®2 .x1sx, .vba Yes Yes

|Requires LiveLink™ for MATLAB®

2Requires LiveLink™ for Excel®, available for Windows®

only

3Available for Windows® only

“Available for Linux® only

>Available for macOS only

éCan be linked to a method in an application using the Application Builder

7Requires a C-wrapper to the Fortran code and to include the C-code DLL as an External C
Library in the Application Builder. Alternatively, you can include a Fortran DLL directly as an
External C Library in the Application Builder. Note: You need to consider the naming
convention for exported Fortran function names. For example, in Windows®, it is typically
required that Fortran function names are in uppercase.

NUMERICAL AND INTERPOLATION DATA FORMATS

The grid, sectionwise, and spreadsheet file types can be read for defining
interpolation functions. The sectionwise and spreadsheet file types can
furthermore be read and used for defining interpolation curves and written for
exporting results. In addition, tables can be copy-pasted on spreadsheet format.

Parameters and variables can be imported and exported to the plain text,
comma-separated values, or data file types.

The continuous and discrete color table text file types are used for user-defined
color tables for results visualization.
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Digital elevation model (DEM) files can be read and used as a parametric surface

for defining a geometry.

FILE TYPE EXTENSION READ WRITE
Copy and paste spreadsheet format n/a Yes Yes
Excel® spreadsheetl .x1sx Yes Yes
Table .txt, .csv,.dat Yes Yes
Grid Ltxt Yes Yes
Sectionwise .txt,.csv,.dat Yes Yes
Spreadsheet .txt,.csv,.dat Yes Yes
Parameters .txt,.csv,.dat Yes Yes
Variables .txt,.csv,.dat Yes Yes
Continuous and Discrete color table Ltxt Yes No
Point data for Cut Point datasets Ltxt Yes No
DEM .dem Yes No
VTK .vtu No Yes

! Requires LiveLink™ for Excel®, available for Windows® only
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Appendix E— Connecting with LiveLink™ Add-Ons

The following table shows the options to start COMSOL and the different linked
partner software using the LiveLink™ add-on products.

COMSOL® Can Start COMSOL Can Start Partner Software Can Connect
Software from Partner Software  from COMSOL Running Sessions
LiveLink™ Yes! Yes? No
for Excel®

LiveLink™ Yes® Yes® Yes®
for MATLAB®

LiveLink™ No Yes® No
for Simulink®

LiveLink™ No No Yes
for AutoCad®

LiveLink™ No No Yes
for Revit®

LiveLink™ No No Yes
for PTC®Creo®

Parametric™

LiveLink™

for Inventor®

- Bidirectional No No Yes
Mode

- One Window Yes No No
Mode

LiveLink™ No No Yes
for PTC®

Pro/ENGINEER®

LiveLink™ No No Yes
for Solid Edge®

LiveLink™

for SOLIDWORKS®

- Bidirectional No No Yes
Mode

- One Window Yes No No
Mode

'"When you open a model from E><ce|®, a model window starts and a link is established
automatically. The model window is an output window that displays geometry, mesh, and results.
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2A model that includes a table reference to an Excel® spreadsheet automatically starts an Excel®
process in the background when the model is run in the COMSOL Desktop environment.

3You can start a COMSOL Multiphysics server from a MATLAB® session using the system
command and then connect to it using mphstart in the MATLAB® command prompt.

*The “"coOMsOL Multlphy3|cs with MATLAB®” desktop shortcut starts a COMSOL Multiphysics
server and MATLAB® , then connects them automatically. When you run a COMSOL Multiphysics
model in the COMSOL Desktop interface that includes a MATLAB® function (Global Definitions
> Functions), a MATLAB® engine and connection is started automatically.

>You can connect a MATLAB® seSS|on to a running COMSOL Multiphysics server using the
command mphstart in the MATLAB® command prompt.

The COMSOL Mul‘uphysms with Simulink® desktop shortcut starts a COMSOL Multiphysics
server and MATLAB® , then connects them automatically. You can then start Simulink® and add a
COMSOL Cosimulation block where you load a cosimulation file to run a cosimulation.
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Index

A AC/DC Module 63, 86 examples 30

accuracy file types 31
convergence analysis 54 MPH files 10, 30

Add Material window window 32
busbar model 75 Application Library update 32
opening 41, 75 autocompletion

Add Multiphysics parameter and variable names /52
button 87 parameters and variables 68
window 87 average temperature [47

add-in 109

B blank model, creating 14, 17
add-on modules

AC/DC Module 63, 84, 86
Application Libraries 30
CAD Import Module 162, 199

boundaries 83
adding to selection 85
variables scope 26

boundary condition 80
Chemical Reaction Engineering Mod-

ule 202
Design Module 162, 168, 199
ECAD Import Module 201
MEMS Module 122
physics list 37, 65
physics list, and 65
Plasma Module 202
Structural Mechanics Module 35, 46

automatically defined 46
boundary load 45
busbar, setting 80
electric current 80, 84
fixed constraint 44

free 43

ground, electrical 86
heat transfer 80

insulating 83

study types 66 material interface 46

d d topics |13 .
advanced topics settings window 8

all combinations boundary load 45

parametric sweep |45 boundary section

analysis
4 context menu 82

54 .
convergence boundary selection, busbar model 83

example, parametric sweep 58

Build All button
animation 21/, 155
o geometry 72
application /2, 98 meshes 49, 89
Application Builder 6, 8, I'1, 12, 25, 99, .
built-in

184
Application Gallery 32

constants, functions, and variables 30

materials 41/, 75
Application Libraries
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variables 93

button object 103

CAD Import Module 162, 199
Cancel button 10, 29
case
parameter 24, 145
chamfer 162
Chemical Reaction Engineering Module
202
clip plane 48
cloud computing 155
Cluster Computing node 156, 159
cluster job 158
Cluster Sweep node 156, 159
color theme /4
coloring
materials 78
selections 78
command sequence 07
Compact MPH files 31
compiler 12
component coupling 147
Component node, adding materials 75
computing studies 58
COMSOL Client 12
COMSOL Compiler 12
COMSOL Desktop environment
customizing 27
on Linux /9
on macOS 19
overview 6
COMSOL Multiphysics |/
native CAD format 39
opening 36
COMSOL Server 12
constants
mathematical and physical types 30
constraints 162

context menu

domain and boundary sections 82

contextual tab 18
contributing node 130
convergence analysis 54, 60
Convergence plot 9, 90
cooling

air stream 62

natural convection 67
coupling operator 47
Create Selection 26
Create Selection button 125
custom Settings window 09

customized desktop 27

dark theme 14
datasets, defined 2/
default feature 81
degrees of freedom 55, 60
derivatives 30
Derived Values 60, 97
defined 21
Global Evaluation 59
Volume Maximum 55, 59, 97
Design Module 162, 168, 199
dimensions 162
DirectX 13
discretize 48
documentation, models 10, 30
domain level 82
domain section
context menu 82
domains
materials 77
remove from selection 77
variables scope 26

dynamic help 10, 29

ECAD Import Module 201
edges

variables scope 26



Editor Templates window 106
eigenfrequency analysis 2/
Electric Currents interface
defining boundary conditions 82
multiphysics 66, 86
overview 8/
electric potential 63
physics node 84
voltage drop, parameter 67
electrical heating 62
empty
selection 45
environment reflections 78
equation
built-in 81
user-defined 52
evaluating
volume maximum 55, 95, 97
von Mises stress 56
Evaluation Group 60, 97
automatic re-evaluation 60
example
advanced, electrical heating 62
basic, structural mechanics 35
Excel® 203, 206
exclusive node 129
executable /2
Export node 21
exporting images 98
expressions
Boolean 53
manual entry 56, 67
replacing 53, 93, 95
units, specifying 55
user-defined 52

External Process window 9

fillet 162
fillets 168
find

parameters and variables 69

finite element

mesh 48

preconditioning 58

tetrahedra 48
Fixed Constraint node 44
Floating Network License 156
Form editor 11, 104

form objects 99

form union, geometry 72

Form wizard 99
frequency response 22
frequency-domain study 2/
functions
advanced topics /13
built-in 30
mathematical 30
scope 67

Functions node 67

geometric dimensions
parameters, and 10, 23, 177
parametric sweep 67
geometry
building 67
CAD format 38
importing 38
in Application Libraries 70
loading from file 67, 70
operations 62
parameterized 10, 23, 67,71, 177
sequence |62
settings window 8
Geometry node 33
Global Definitions node 20, 24
functions 67
parameters 67
scope 25, 67
variables 25

global parameters 24, 42, 57, 67
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expression 23 Heat Transfer in Solids interface 82

glTF-file format 98 Solid Mechanics interface 43
graphics input fields 101

rendering and hardware |3 Input Parameters
Graphics menus 19 for part 178
graphics object 103, 104 Insert Object menu 106
Graphics toolbar Isosurface plot 90, 154

default view button 44, 52, 86, 94 iterative solver

image snapshot button 98 preconditioning 58

zoom extents button 73, 92
Graphics window 7, 9, 19, 29

geometry, and 39

plot 50

) Javafile 34, 203
Joule heating
equations 8/

multiphysics coupling 86

rotate geometry 44, 91, 92 multiphysics interface 65

selecting boundary 44, 45, 86
L Laminar Flow interface /34

toolbar 7
using 40, 73 Linux
zoom box 45 clusters 158
Ground, boundary condition 85 version 19
grouping LiveLink™ add-ons 206
nodes 25 loft 162

Log window 9, 50
H Heat Transfer in Solids interface
M Mfile 34, 203

macOS version 9

defining boundary conditions 82

multiphysics 66, 86
Material Browser

defined 10

material contents section 4/, 76

overview 8/
Help window 10
opening 20
high performance computing 155 material color and texture 78

Home tab 18

HPC 155

material interface
mechanical contact 46
hybrid parallelism 157 material rendering 78
materials

I Image Snapshot button 98 copper 62

images, creating thumbnails 98 domains, assigning 77

importing geometry 38 model tree 33

information windows 7, 9, 29 settings window 8

initial conditions 8 steel 4/, 52

Initial Values node titanium alloy 62

Electric Currents interface 82 Materials node 41, 75
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mathematical constants and functions
30
MATLAB® 203
Max/Min Volume plot 56
Maximum and minimum values table 96
MEMS Module
thermal expansion, and /22
mesh
convergence analysis, and 55
density 57
finite element 48
model tree, and 33
parameterizing 57, 88
physics-controlled, default 88
refining 57
settings 48
unstructured tetrahedral 88
user-controlled 57, 88
mesh element size
parameters, defining 23, 88
settings 49
message passing interface (MPI) 157
Messages window 9, 50
method |10
model 25
Method Call 110
Method editor I/, 110
midsurface 162
modal tab 18
Model Builder 6, 99
defined /|
example 33
expanding sections 8/
geometry import 38
node sequence example 43
the ribbon, and 18
toolbar 6
window 28

model history 34

model method 25

model tree 6, 28
building 20
defined 67
example 33

geometry 33

Global Definitions node 20, 42, 67

Materials node 33, 4/
Model Builder /|
nodes 20
Results node 21
ribbon 18
root node 20
Study node 21, 33
Model Wizard
adding physics 21, 37, 65
Component node, and 2/
creating a new model /4
custom studies 37
opening 36, 64
preset studies 37, 66
space dimension 36, 64
study 21, 65
models
defining | |
discretization 48
documentation /0, 30
saving 74
structural mechanics 35
symmetry 92
workflow 33
MPH file 199
full and compact 3/
saving 74, 98
MPHBIN file 199
MPHPHB file 199
MPHTXT file 199
MPI 157

multicore processors /55
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multiphysics interface 66
multiphysics models 62
Multiphysics node 81, 82, 87, 124
multiphysics phenomena 62
Multislice plot 90

no solutions stored, message 32
node groups 25
nodes 20

default feature 43

reordering 34

OpenGL 13,79
Override and Contribution 43, 130

parallel computing 155
parameter

case 24, 145
parameter switch

parametric sweep |45
parameters 23, 102

defining 57, 67

editing 72

expression 23, 57

global 24

meshes, and 57

name 57

range of values 58

results 24, 153

scope 67

using, referencing 84
Parameters node 67, |13
parametric geometry model 162
parametric study 67
parametric sweep 23

all combinations 145

example 57

meshes, and 57

parameter switch 45

range, defining 58

specified combinations 45

part 10, 177
Input Parameters /78
Part Libraries 177
physics
adding 65
boundary conditions 80
electromagnetic heating 65
heat transfer 65
Joule heating 62, 81
laminar flow 34
model tree 33
physics interface 15, 66
Electric Currents 66
Heat Transfer in Solids 66
Joule Heating 65
Laminar Flow 134
Solid Mechanics 37
Plasma Module 202
player 155
plot
regenerate after solving 6/
plot group 21/
3D, adding 53
Plot window 29
plots
expression, user-defined 52
max/min volume 56
model tree 33
regenerating 56
surface 51, 53
windows 9
points, variables scope 26
Poisson'’s ratio 77
polynomial functions 48
preconditioning 58
preferences 3
preset studies 66
Preview MPH files 32
principal stress /29



program code
model file for Java 34
model M-file 34
progress bar 10, 29

Progress window 9, 50

Quick Access Toolbar 6, 8, 19, 28

Record Code /11
renaming plot groups 54
rendering options 3
reports, defined 2/

reserved name 30

resolution of curvature, mesh 88

results
color table range 91, 93
derived values 55, 59, 97
displaying 51
parameters 24, 153
surface settings, modify 91
units, changing 5/
Results node
3D plot group 56, 93, 127
busbar defaults 90
subnodes 2/
surface node, adding 93, 127
ribbon ¢, 28
Add Material 41, 80, 133
Build All 72
Build Mesh 89
Compute 58, 127, 143
defined 8, 18
example 6
importing geometry 38
Model Builder 18
Physics tab 44, 124
Windows 10, 51, 166
Work Plane 64
root node
default units 146

defined 20
model thumbnails 98
Model Wizard 36

running simulations 90

saving files 74, 98
scheduler
Grid Engine 158
Open Grid Scheduler 158
PBS 158
SLURM 158
Windows HPC Server 58
scope
global definitions 67
parameters and variables 25
parameters and variables, defined 23
variable name 26
search
parameters and variables 69
Select Study window 7
selecting
boundaries 46
multiple boundaries /25
using the graphics window context
menus 46
selecting internal surfaces 46
Selection 26, 46, 78
empty 45
selection 125
Selection List window [0, 166
selection of geometry objects, domains,
boundaries, edges, and points 46
Settings Form 10
Settings Forms |10
Settings window 6, 8, 20, 28
customized 109
shared memory parallelism 155
Show Material Color and Texture 78
Show Selection Colors 78

simulation, running 90
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skybox image 79
software rendering 13
Solid Mechanics interface 37
add-on modules 122
Solved MPH files 31
solvers
configurations 58
iterative 57, 58
stationary 50, 58
using 50
space dimension 5
specified combinations
parametric sweep |45
Stationary study 37, 50
steady-state study 2/
structural analysis 35
structural displacement field 48
structural mechanics
design 54
plastic deformation 52
stresses and strains 62, 77
von Mises stress 5/
Structural Mechanics Module
application library 35
mechanical contact 46
thermal expansion /22
studies
computing solutions 58, 90
defining 50
example, multigrid iterative 58
example, stationary 50
model tree 33
preset 66
types 2/
Study node 2/
solution sequence 90
Suppress Selection Highlight 78
Surface plot

busbar results 90

T

color table range 93
deformation 5/

electrical current density 92
replace expression 93
settings 53

updating 92, 93

table

Maximum and minimum 96
Table window ¢

graph plot 59

wrench results 56
Tables node 21
tables, evaluating 59
temperature 90, 143
temperature, average 147
Test Application 105
tetrahedron, polynomial functions 48
thermal expansion 62, 77
thicken 162
thumbnail image 98
time-dependent study 2/
torque, applied 35

unit, changing 51, 128
update COMSOL Application Libraries
32
Update Solution 152
user interface
COMSOL Desktop 6
overview 6

user-controlled mesh 57

variables
advanced topics /13
built-in 30
example, built-in 59
expression 25
scope 67
scope, limit 26
Variables node 25, 67



visualization 9
color table 91, 93
Volume Maximum, evaluating 55, 95, 97

von Mises stress 51, 129

Windows list 51, 166
wizard
Form 99

workflow 30

yield stress 35, 52

Young's modulus 77

zoom |44

Zoom Extents command /08
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